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CHAPTER (1): WELCOME TO BEAMTOOL 6 

 
The original BeamTool was created to provide a quick and easy way to do simple ray tracing by allowing the user to 
specify a piece with a weld and add wedge(s) and transducer(s) to display a beam path. 

  

BeamTool is now in its sixth generation, and offers users many features: 

  

• CAD Layers: used to control a group of graphics. Layer visibility can be turned on or off. Control graphics 
by locking and unlocking layers so they are not accidentally modified. 

• CAD Tools: interactive rotate and move tools, rotate geometries commands (90 and 180 degrees), new 
rotate geometry construction aid, remove duplicate geometries command. 

• Piece and Annotative Geometries: circle geometry, rotatable rectangle geometry, rotatable bitmap 
geometry. 

• Restructured CAD Toolbar: display settings and snap settings pop-ups, new add geometry popup. 
• Contact and immersion support for conventional and phased array probes. 
• TOFD probe elevation offsetting. This allows the use of a pair of TOFD probes on a piece with different 

thicknesses. 
• ID/OD pinning for TOFD probes 
• Improved near field calculations based on equations by Udo Schlengermann and KFactor Polynomials 
• Material properties for polygons can now be configured via the geometry context menu. 
• Beam refraction through geometries with dissimilar materials. 
• Single beam beamset. This new beamset is useful when developing zonal techniques. 
• Improved probe visualization: wedge damping visualization to phased array wedges, transducer orientation 

visualization on phased array, transducer visualization on top view, beamset element usage visualization on 
reports. 

• Equipment management for instrument configuration and validation. 
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1.1 NEW IN VERSION 6: 

• Calibration Block Designer - Design custom calibration blocks and generate reports that include all aspects 
of a calibration block to support machining. Built to comply with ASME code stipulations using target 
measuring tools 

 
• Wedge Drawings - new auto wedge drawing generation features makes it easy to automatically generate 

fully dimensioned wedge drawings with all of the important dimensions clearly labeled.  Everything you 
need to have a custom wedge manufactured to properties entered into an instrument or application is 
presented in black and white.  

• Backing Bar - a backing bar can now be added and configured in a plate piece configuration. 
• Show Snell's Law - Displays a visualization of Snell's Law where the beam refracts into the piece. This 

option is available for Single Beamsets, Reference Beamsets, and UT Probe Configuration. 
• Recents - As you use BeamTool, the software will remember which transducers, wedges and equipment 

you commonly use.  The recently used probes and wedges will be available for quick access from a drop-
down menu, without having to import from a file or our extensive catalog.   

• Crop Mode - beams can now be cropped in distance and time as well as the traditional skips. 
• Side Probe Bar - provides the full readout of the probe menu but is pinned to the left hand side of 

BeamTool. 
• Probe Identifier -  allows the user to quickly identify the configuration options for the selected probe in a 

multi-probe workspace. 
• Geometry Navigator - allows you to visualize, highlight and select all of the geometries in a drawing. 
• Materials - users can now define create a custom library of materials that they commonly use.  Seamless 

integration makes it easy to implement any material you need. 
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• Drawings - a powerful set of tools that allow users to create and manage additional drawings within a 
single BeamTool workspace.  Drawings can be used for wedge drawings, HighTemp Management, 
additional piece drawings or any other kind of drawing that helps support a technique. 

• Info Tips - provides additional information in a flash.  Just hover over the light bulb icon on a probe box 
and the Info Tips pops up with relevant information about the probe, its beams, transducer properties, 
etc.  This information would normally be available in a BeamTool report, but now you can get a live update 
to aid in your technique design. 

• Application Tips - mini lessons designed to help you  get the most out of BeamTool.   Application Tips can 
be displayed automatically when BeamTool starts and are available anytime from the Help menu.  

• Geometry Alignment - aligns objects horizontally or vertically relative to each other.  Objects are 
positioned relative to the first object selected. 

• Full Matrix Capture Beamset - a specific data-acquisition processing using ultrasonic phased-array probes. 
For an array of N elements, each element is successively used as a transmitter, while all other elements are 
used to receive. 

• Zoom Selected - zooms to fit the selected geometry. 
• Trim Tool - the new interactive trim tool allows users to easily trim intersecting lines to precise lengths. 
• Improved InspectionBank Integration 

  



CHAPTER (2): GETTING STARTED 

BeamTool gives the user the ability to quickly define typical inspection parameters to rapidly and clearly present 
technique development.  Its intuitive user interface allows a user to be productive immediately after installation 
without spending a lot of time learning how to use it.  

  

Hovering the mouse over a button or menu option will pop up a "Super Tooltip".  Super Tooltips provide readily 
available explanations for all buttons and visual picklists allow for a preview before the command is executed. 

2.1 CREATING A TYPICAL TECHNIQUE 

Creating a typical technique can be quickly and easily achieved: 

1. Start with the default Simple Plate or select an ID/OD Piece or use Piece Geometries to define your 
own. 

2. Configure your   Piece and Weld (using a Plate, Axial,  Circumferential or Custom 
Piece). 

3. Add and Configure Probes. 
4. Add and Configure Beams. 
5. Add Geometries. 
6. Create Reports. 

  

In addition, custom reports can be created and graphics can be easily exported to other applications. 



CHAPTER (3): MENUS, TOOLBARS & LAYOUT 

3.1 LAYOUT 

The BeamTool layout is divided into seven major sections: 

  

1. The Main Menu - Access to workspace management and other tools 
2. The Main Toolbar - Quick and easy access to workspace management and other tools 
3. The Probe Groups - Access to Probe configuration 
4. The CAD Surface - Visualization and manipulation of piece, probes, and geometries 
5. The Command Prompt - The Command Prompt is a precision drawing tool used to quickly draw and edit 

geometries with specific dimensions   
6. The CAD Toolbar - Access to CAD configuration and manipulation tools 
7. The Status Bar - Provides status updates on CAD tool usage, surface navigation, workspace management, 

etc. 
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3.2 MAIN MENU 

BeamTool's Main Menu provides access to workspace management and other various tools.  The three sub-menus 
accessible from the main menu are: 

  

• File - Access to workspace and document management options and tools 
• Edit - Access to various editing tools. 
• Drawings - Access to tools for creating and managing drawing sets. 
• Tools - Access to various information and operational tools.  The BeamTool Options dialog is also 

accessed from the Tools menu. 
• Help - Access to documentation and BeamTool product options. 



Menus, Toolbars & Layout 

 
11 

 

3.2.1 FILE MENU 
There are a number of options located under the File menu. 

  

New Workspace 

Creates a new workspace displaying default values for piece and probe. 

  

Open Workspace 

Allows the user to open a previously saved workspace.  A workspace preview pane is available in the Open 
Workspace window providing a thumbnail view of the workspace currently selected. 

  

Recent Files 

Displays a list of the most recently opened workspaces.  A workspace can be opened by selecting from this list. 

  

Save Workspace 

Allows the user to save the current workspace.  If the workspace has not been previously saved the Save Workspace 
dialog will appear allowing the user to specify the workspace filename.  If the workspace has been previously saved 
the workspace will be re-saved (overwrite) to the existing workspace filename. 

  

Save Workspace As 

Allows the user to save the current workspace.  Displays the Save Workspace dialog every time, allowing the user to 
specify a new workspace filename or overwrite the existing workspace filename. 

  

Page Setup 

Allows the user to setup the page properties when printing a workspace. 

  

Print 

Allows the user to print the available drawing sets in the workspace.  See Print Drawings for more information. 

  

Import 

Allows the user to import graphics from an external file. Click here for help on using Import. 

  

Export 

Allows the user to export the graphics displayed in the drawing.  Click here for help on using Export. 

  

Report 

Allows the user to create reports from the data specified.  Click here for help on using the Report option. 
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Document Info 

Can be used to store notes related to a workspace.  This information can also be added to report templates. 

  

Exit 

Exits BeamTool. 



Menus, Toolbars & Layout 

 
13 

 

3.2.2 DRAWINGS  
Drawings is a powerful set of tools that allow users to create and manage additional drawings within a single 
BeamTool workspace.  Drawings can be used for calibration blocks, wedges, HighTemp Management, additional 
piece drawings or any other kind of custom drawing that helps support a technique.  You can quickly print all of the 
drawing sets or customize the print job to specific drawings and specific views (see Printing for more information). 

 
 

3.2.2.1 DRAWING MENU OPTIONS 

  

Add Drawing - Opens the Drawing Properties dialog box where you can name and describe the drawing you 
want to add.  After the drawing properties have been defined, the CAD Surface area will change from the "Subject" 
drawing to a blank CAD Surface where you can create the new drawing.  The new drawing will be available from 
the Active Drawing drop-down menu found on the Main Toolbar.  

  

Remove Drawing - Removes the active drawing from the CAD surface and the Subject/Drawing/CalBlock drop-
down menu found on the Main Toolbar. 

  

Properties - Opens the Drawing Properties dialog box the name and description of  the drawing are defined. 
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3.2.2.2 ADD DRAWINGSET LOCATIONS 

BeamTool has the ability to automatically generate drawing sets for specific items.  The Add Drawingset button 
can found in the Phased Array Probe Configuration dialog box (in the Wedge options drop-down menu) , the 
HighTemp Wedge dialog box, the CalBlock Designer dialog box, the ZonalCalBlock Designer dialog box, and the 
Indication Table dialog box. 
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3.2.4 TOOLS MENU 
These are the tools that can be found under the Tools menu. 

  

Geometry Inspector 

The Geometry Inspector allows advanced users to manipulate Piece and Annotation geometries at a lower level than 
that of the CAD Tools. 

  

Command Prompt 

The Command Prompt is a precision drawing tool used to quickly draw and edit geometries with specific 
dimensions.   

  

Convert Simple Piece to Custom 

Converts the Simple Piece plate into individual custom geometries allowing you to manipulate the piece geometries. 

NOTE - When using this tool proceed with caution.  Please remember that any existing geometries and annotations 
that have been added to the workspace will be erased. 

  

Delete Duplicate Geometries 

Scans the geometries that have been added to the workspace and removes any extras that have the exact same 
attributes. 

  

Construct Top View 

This tool analyzes the side view of a custom piece and automatically draws a top view. 

  

Simplify Poly-Geometry 

This tool analyzes the poly-geometries in a workspace and eliminates redundant poly-geometries to reduce file size. 

  

 Add-on Manager 

Allows the user to view and activate available Add-on Modules.  

  

Options 

Allows the user to specify options.  Click here for help on specifying Options. 
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3.2.4.1 OPTIONS 

There are a number of options available to customize the way BeamTool presents data. 

 

3.2.4.1.1 GENERAL TAB OPTIONS 
Below are options that can be accessed by selecting Tools  Options  General. 

 

Automatically open last workspace on 
startup 

If checked, displays the last saved workspace when BeamTool is 
invoked. 

Automatically open new Beamset parameter 
forms 

If checked, the Beam Configuration dialog is automatically 
displayed when a beamset is added.  If not checked, the user 
must select the Beam Configuration button that appears when a 
beamset is added. 

Prompt before deleting probes or beamsets If checked, a prompt is displayed when the Delete Probe or 
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Delete Beamset  button is selected confirming the deletion 
request.  If not checked, a prompt is not displayed and the probe 
or beamset is deleted without confirmation. 

Retain Tool If checked, a tool stays running after it has completed.  If 
unchecked, the active tool switches back to the arrow tool after 
completion. 

Automatically check for update every # days If checked, an automatic update is performed every number of 
specified days.  If not checked, an automatic update is not 
performed. 

Preferred Units Indicates the units of measurement to be used. 
Dimensions- Millimeters/Inches Specify the unit(s) to be displayed for all dimension 

measurements.  This does not affect the unit(s) of measurement 
displayed in configuration dialogs. 

Locale Indicates the language in which BeamTool will be 
displayed.  Specifying a new locale requires a restart of the 
system.  Please refer to XMLocalize for more information 
regarding language options. 

3.2.4.1.2 COLORS TAB OPTIONS 
Below are options that can be accessed by selecting Tools  Options Colors. 

Dimensions - Text Color Specify the color to display dimension labels. 
Dimensions - Line Color Specify the color to display dimension lines. 
Labels - Text Color Specify the color to display all other labels. 
Beam Spread - Fill Color Specify the color of the beam spread beams. 
Near Field - Fill Color Specify the color of the near field indicators. 
Focal Point - Fill Color Specify the color of the focal point indicators. 
Gates - Fill Color Specify the color of the gate indicator. 
TOFD Resolution Specify the color of the TOFD resolution indicator lines. 
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3.2.4.1.2.1 BEAM SKIP COLORING 
Beam Skip Coloring is used to easily identify the colors to be used for each 1/2 beam skip displayed for Phased 
Array beamsets.  Color markers can be dragged and dropped at any location on the color palette.  Additional color 
markers can be added by double clicking on the color palette and markers can be removed by selecting Delete on the 
keyboard. 

 
When configuring Phased Array beamsets Color List can be selected from the Beam Type picklist and the colors 
specified for Beam Skip Coloring are applied to the beam.  If the number of 1/2 beam skips displayed exceeds the 
number of colors specified for the Beam Skip Coloring the color order is repeated. 
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3.2.4.1.3 REPORT TAB OPTIONS 
Below are options that can be accessed by selecting Tools  Options Report. 
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3.2.4.1.3.1 DEFAULT LOGO 
For use in Reports and the Report Template Editor, a Default Logo can be loaded into the Options. The logo will 
always default to the Eclipse Scientific logo. 
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3.2.4.1.4 MATERIALS TAB OPTIONS 
BeamTool has a huge catalog of materials to choose from, allowing users to define material parameters on the 
fly.  Starting in BeamTool 6, users can create a custom library of materials that they commonly use.  Seamless 
integration makes it easy to implement any material you need. 

Below are options that can be accessed by selecting Tools  Options Materials. 

 

3.2.4.1.4.1 MATERIALS TAB TOOLBAR OPTIONS 

User Materials  Displays the list of Materials added by the user. 

System Materials Displays the list of Materials that are standard with BeamTool. 

Add Material Adds a new material to the User Materials list. 

Delete Material Removes the selected material from the User Materials list. 
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3.2.5 HELP MENU 
There are a number of options located under the Help menu. 

 

Contents 

Displays the BeamTool Help file. 

  

Application Tips 

Application Tips are mini lessons that are designed to help you get the most out of BeamTool.  Clicking on 
Application Tips from the Help Menu will open the Application Tips dialog box.  You can cycle through the 
available Application Tips, and toggle on and off the option to show Application Tips when you start BeamTool. 

  

Check For Update 

Checks for updates available for BeamTool. 

  

Support 

Opens our website to the BeamTool Support page.  Inquiries are sent to Eclipse Scientific's dedicated BeamTool 
support team who will provide prompt assistance. 

  

Deactivate License 

An BeamTool license can be activated on one machine only.  If you would like to move your license to another 
machine you can select Deactivate License to release the license from the current machine to allow for activation 
on another.  When you deactivate the license it will disable BeamTool on the current machine.  This option is not 
available for the HardLock version. 

  

Localization 

Displays the XMLocalize editor which can be used to correct translation inaccuracies.  Modifications to this file can 
be submitted to the BeamTool support team for inclusion in a future release of BeamTool.  Click here for more 
information. 

  

Admin 

The Admin drop-down menu allows you to set the default size of screen shots. 

  

About 

Displays information about BeamTool. 
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3.3 MAIN TOOLBAR 

The Main Toolbar provides quick and easy access to some common workspace management tools, various 
information tools and dialogs, and CAD Surface tools. 

 

New Workspace 

Creates a new workspace displaying default values for piece and probe. 

  

Open Workspace 

Opens a previously saved workspace. 

  

Save Workspace 

Saves the current workspace. If the workspace has not been previously saved the Save Workspace dialog will appear 
allowing the user to specify the workspace filename.  If the workspace has been previously saved the workspace will 
be overwritten. 

  

Undo 

Reverts the workspace to its state before the most recent editing action was performed.  Also provides a list of all the 
most recent editing actions performed, allowing the ability to revert the workspace back a number of editing steps. 

  

Redo 

Reverts the workspace to its state before the most recent undo was performed.  Also provides a list of all the most 
recent undos performed, allowing the ability to revert the workspace forward a number of editing steps. 

  

Active Drawing  

This drop down menu allows you to quickly change your workspace from Subject Piece to Calibration Block to 
Wedge Drawings to Custom Drawings. 

  

Piece Geometry/Piece Configuration 

The drop down menu is used to select the general Piece Geometry from Plate, Axial, Circumferential and Custom 
types.  After the piece geometry is selected from the drop down menu, clicking on the Piece graphic displays the 
Piece Configuration dialog which can be used to specify the data values for the piece. 

  

Weld Configuration 

Displays the Weld Configuration dialog which can be used to specify the data values for the weld. 

  

Instrument Info 

Instrument Info is a database of additional fields that can be manually populated by the user or imported from a 
catalog and included on reports. 
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Add Probe 

Pops up a drop-down list of available Probe types.  Allows probes to be added to the workspace. 

  

Document Info 

Document Info is a database of additional fields that can be populated by the user and included on reports. 

  

Report 

Generate Reports documenting the technique scan plan or complete technique document.  Use Instrument Info and 
Document Info to populate additional technique properties. 

  

Indication Table 

Displays the Indication Table dialog used to manage indications. 

  

Copy to Clipboard 

Copies the contents of the workspace to the clipboard making it available for use in another application such as 
Microsoft Word or PowerPoint.  By default, clicking the button will copy a bitmap image of the visible CAD surface 
to the clipboard.  Using the button's drop-down, both bitmap image and metafile images are available.  Metafile 
images can be used in applications like AutoCAD, Corel, etc. 

  

Compact Probe Bar /  Full Probe Bar /   Side Probe Bar 

Toggles between Compact Probe Bar (provides a minimal readout and a popover edit panel), Full Probe Bar 
(provides the full readout of the probe menu) and Side Probe Bar (provides the full readout of the probe menu but is 
pinned to the left hand side of BeamTool. 

  

Display Side View 

Displays the drawing as a side view. 

  

Display Top View 

Displays the drawing as a top view. 

  

Display 3D View 

Displays the drawing as a 3D View. 

  

Pan Drawing 

Puts the cursor in panning mode allowing the user to pan around the drawing.  You can also pan by holding down 
the scroll wheel and dragging and dropping using the mouse. 
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Zoom Fit 

Fits and centers the drawing in the current displayable drawing area (workspace). (Ctrl+F) 

  

Zoom Window 

Specify an area in the drawing to be zoomed into by holding down the left mouse button and dragging the mouse to 
select the area. 

  

Zoom Selection 

Zooms to fit the selected geometry. 

  

Zoom In 

Zooms into the drawing. The user can also scroll up using their mouse wheel to zoom in. (Page Up) 

  

Zoom Out 

Zooms out of the drawing. The user can also scroll down using their mouse wheel to zoom out. (Page Down) 



CHAPTER (4): PIECE 

By default, a simple Plate piece with a simple weld is displayed in the drawing pane.  Alternatively an Axial, 
Circumferential or Custom piece can be selected using the Piece Geometry drop-down menu located on the Main 
Toolbar.  

   
When Axial is selected the default Plate piece graphics are removed and replaced with Axial piece graphics.  

  

When Circumferential is selected the default Plate piece graphics are removed and replaced with Circumferential 
piece graphics.  

  

If Custom is selected the default Plate piece graphics are removed.  Also, the Weld Configuration and Display 
option buttons are disabled, as custom pieces do not have a weld, or allow for automated dimensioning. 

  

All piece types can be customized using the Piece Configuration and Weld Configuration dialogs.  Both of these 
menus are found on the Main Toolbar.   
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4.1 PLATE PIECE CONFIGURATION 

A Plate piece and weld can be configured by pressing the Piece Configuration button located on the Main 
Toolbar.  This will display the Piece Configuration dialog, which can be used to specify the data values to be used to 
generate the piece geometry. 

 
4.1.1 PIECE CONFIGURATION 
Below are the values that can be set for a piece and weld.  To specify a value you can a) move the slider right or left, 
b) click the right or left value spinner or c) click on the value displayed in the value spinner and type a value.  The 
preview and drawing panes will update on the fly as the values are modified. 

  

Select a Material Velocity 

The Piece Velocity can be set by selecting a material from the Material picklist: 

1. Press the Material button located on the Piece Configuration dialog.  A list of available materials will be 
displayed. 

2. Select a material from the list.  The Material Velocity values will be set with the assigned material 
velocities. 
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Open an Existing Piece and Weld Configuration 

Once the Piece Configuration dialog has been displayed, existing piece and weld configurations (*.ebp) can be 
opened: 

1. Press the Open button and navigate to the BeamTool directory (default location) containing the 
configuration file (*.ebp) to be opened. 

2. Select the file and press Open.  The configuration data will now be displayed in the dialog and the drawing 
pane will update to display the selected piece and weld. 

  

Save a Piece and Weld Configuration 

Once a piece and weld configuration is complete it can be saved (*.ebp): 

1. Press the Save button and navigate to the BeamTool directory (default location).  
2. Enter a name for the file in the File name field and press Save. 

Display Piece Dimensions 

Displays the thickness of the piece on the drawing. 

  

Display Piece Index Offset Dimension 

Displays the distance of the offset point (if set using Piece Configuration will display as vertical gold bar) from the 
center point of the weld on the drawing. 

  

Plate 

Thickness The thickness of the piece of material containing the weld. 
Width The width of the piece of material containing the weld. 
Length The length of the piece of material containing the weld. 
Index Offset Offset location on the piece to be used instead of center of weld. 
  

Backing Bar 

Thickness The thickness of the backing bar. 
Width The width of the backing bar. 
  

Slopes 

Slope Offset Specifies the distance from the weld center line where the slope starts. 

Slope Width Specifies the width of the slope along the piece surface. 

Slope Height Specifies the height or elevation of the slope past the piece surface. 

NOTE:  Use the   Link Horizontal and  Link Vertical buttons to mirror adjustments made to slopes. 
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Material 

Compression Same plane directional velocity of the piece. 
Shear Right angle directional velocity of the piece. 
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4.2 AXIAL PIECE CONFIGURATION 

An Axial piece and weld can be configured by pressing the Piece Configuration button located on the Piece 
group.  This will display the Piece Configuration dialog which can be used to specify the data values to be used. 

4.2.1 PIECE CONFIGURATION 
Below are the values that can be set for an Axial geometry piece and weld.  To specify a value you can a) move the 
slider right or left, b)  click the right or left value spinner or c) click on the value displayed in the value spinner and 
type a value.  The preview and drawing panes will update on the fly as the values are modified. 

  

Material 

Compression Same plane directional velocity of the piece. 
Shear Right angle directional velocity of the piece. 
  

Axial 

Thickness The thickness of the piece of material. 
OD The diameter measurement taken from the outside edge of the piece. 
ID The diameter measurement taken from the inside of the piece. 
Sweep The curve of the diameter in degrees. 
Length The length of the piece of material. 
Index Offset The offset point from the center point of the weld on the drawing. 

4.2.2 OTHER TOOLS AVAILABLE 
In addition to the options available above the following tools are available during piece and weld configuration: 

  

Open an Existing Piece and Weld Configuration 

Once the Piece Configuration dialog has been displayed, existing piece and weld configurations (*.ebp) can be 
opened: 

1. Press the Open button and navigate to the BeamTool directory (default location) containing the 
configuration file (*.ebp) to be opened. 

2. Select the file and press Open.  The configuration data will now be displayed in the dialog and the drawing 
pane will update to display the selected piece and weld. 

  

Save a Piece and Weld Configuration 

Once a piece and weld configuration is complete it can be saved (*.ebp): 

1. Press the Save button and navigate to the BeamTool directory (default location).  
2. Enter a name for the file in the File name field and press Save. 
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Select a Material Velocity 

The Piece Velocity can be set by selecting a material from the Material picklist: 

1. Press the Material button located on the Piece Configuration dialog.  A list of available materials will be 
displayed. 

2. Select a material from the list.  The Material Velocity values will be set with the assigned material 
velocities. 

  

Display Piece Dimensions 

Displays the thickness of the piece on the drawing. 

  

Display Piece Index Offset Dimension 

Displays the distance of the offset point (if set using Piece Configuration will display as vertical gold bar) from the 
center point of the weld on the drawing. 
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4.3 CIRCUMFERENTIAL PIECE CONFIGURATION 

A Circumferential piece and weld can be configured by pressing the Piece Configuration button located on the 
Piece group.  This will display the Piece Configuration dialog which can be used to specify the data values to be 
used. 

4.3.1 PIECE CONFIGURATION 
Below are the values that can be set for a Circumferential geometry piece and weld.  To specify a value you can a) 
move the slider right or left, b)  click the right or left value spinner or c) click on the value displayed in the value 
spinner and type a value.  The preview and drawing panes will update on the fly as the values are modified. 

  

Material 

Compression Same plane directional velocity of the piece. 
Shear Right angle directional velocity of the piece. 
  

Axial 

Thickness The thickness of the piece of material. 
OD The diameter measurement taken from the outside edge of the piece. 
ID The diameter measurement taken from the inside of the piece. 
Width The width of the piece of material containing the weld. 
Index Offset The offset point from the center point of the weld on the drawing. 

4.3.2 OTHER TOOLS AVAILABLE 
In addition to the options available above the following tools are available during piece and weld configuration: 

  

Open an Existing Piece and Weld Configuration 

Once the Piece Configuration dialog has been displayed, existing piece and weld configurations (*.ebp) can be 
opened: 

1. Press the Open button and navigate to the BeamTool directory (default location) containing the 
configuration file (*.ebp) to be opened. 

2. Select the file and press Open.  The configuration data will now be displayed in the dialog and the drawing 
pane will update to display the selected piece and weld. 

  

Save a Piece and Weld Configuration 

Once a piece and weld configuration is complete it can be saved (*.ebp): 

1. Press the Save button and navigate to the BeamTool directory (default location).  
2. Enter a name for the file in the File name field and press Save. 
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Select a Material Velocity 

The Piece Velocity can be set by selecting a material from the Material picklist: 

1. Press the Material button located on the Piece Configuration dialog.  A list of available materials will be 
displayed. 

2. Select a material from the list.  The Material Velocity values will be set with the assigned material 
velocities. 

  

Display Piece Dimensions 

Displays the thickness of the piece on the drawing. 

  

Display Piece Index Offset Dimension 

Displays the distance of the offset point (if set using Piece Configuration will display as vertical gold bar) from the 
center point of the weld on the drawing. 
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4.4 CUSTOM PIECE CONFIGURATION 

A Custom piece can be configured by pressing the Piece Configuration button located on the Main Toolbar.  This 
will display the Piece Configuration dialog which can be used to specify the data values to be used. 

 
4.4.1 PIECE CONFIGURATION 
Below are the values that can be set for a custom piece.  To specify a value you can a) move the slider right or left, 
b) click the right or left value spinner or c) click on the value displayed in the value spinner and type a value. 

  

Select a Material 

The Piece Velocity can be set by selecting a material from the Material picklist: 

1. Press the Material button located on the Piece Configuration dialog.  A list of available materials will be 
displayed. 

2. Select a material from the list.  The Material Velocity values will be set with the assigned material 
velocities. 

  

Display Piece Dimensions 

Displays the thickness of the piece on the drawing. 

  

Display Piece Index Offset Dimension 

Displays the distance of the offset point (if set using Piece Configuration will display as vertical gold bar) from the 
center point of the weld on the drawing. 
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Material Velocity 

Compression Same plane directional velocity of the piece. 
Shear Right angle directional velocity of the piece. 
  

Custom Piece 

Length The length of the piece of material. 
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CHAPTER (5):  WELD CONFIGURATION 

The weld can be configured by pressing the  Weld Configuration button located on the Main Toolbar.  This will 
display the Weld Configuration dialog which can be used to specify the parameters and geometries of the weld 
bevel.  The Weld Configuration dialog is also used to configure weld Zones. 

  

*Please note that portions of the Weld Configuration dialog are limited to users of the BeamTool ZONAL Add-On. 

  

The intent of the Weld Configuration dialog is to provide the ability to define a weld bevel by defining the specific 
Regions within the bevel. The regions are predefined from categories: Fills, Hot Pass, Roots, etc.  Once a bevel is 
defined, its regions can be divided into Zones* that can be used in conjunction with a Zonal Beamset* and Beam 
Solver. 

  

Opening the Advanced Weld Editor provides access to 

• Pre-defined weld bevels 
• Bevel region gallery 
• Bevel region configuration 
• Zone generation* 

  

 
To modify the bevel configuration, pre-defined weld bevels can be selected from the Weld Type drop-down, 
specific bevel regions can be added to the weld via the Add Bevel Region drop-down, and regions can be 
configured via the Regions panel. 
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5.1 WELD CONFIGURATION TOOLBAR 

In addition to the attribution available above the following tools are available using the Weld Configuration dialog: 

  

Show 

Toggles on and off the display of the weld in the drawing. 

  

Open an Existing Piece and Weld Configuration 

Once the Weld Configuration dialog has been displayed, existing piece and weld configurations (*.ebp) can be 
opened: 

1. Press the Open button and navigate to the BeamTool directory (default location) containing the 
configuration file (*.ebp) to be opened. 

2. Select the file and press Open.  The configuration data will now be displayed in the dialog and the preview 
and drawing panes will update to display the selected piece and weld. 

  

Save a Piece and Weld Configuration 

Once a Piece and Weld Configuration is complete it can be saved (*.ebp): 

1. Press the Save button and navigate to the BeamTool directory (default location).  
2. Enter a name for the file in the File name field and press Save. 

  

Snapshot 

Copy image, metafile or detail layers to the Windows Clipboard. 

  

Weld Type 

The Weld Type drop-down button provides access to pre-defined weld types: 
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These pre-defined weld types have been constructed with regions that have been customized to particular real-world 
weld bevel types.  Once a pre-defined weld has been selected, its regions are displayed in the Regions Panel. 

  

Add Bevel Region 

Click on the  Add Bevel Region icon for a drop-down list of bevel regions.  A Weld must be constructed from one 
or more Regions. Regions define the shape, size, and structure of the weld bevel.  More on Weld Regions  here. 

If a pre-defined weld does not conform exactly to the needed specifications, one can be modified as 
necessary.  Additional regions can be added, or regions not  required can be removed.  Regions can be re-ordered 
(vertically). And individual region parameters can be modified to suit.  More on Weld Region editing here. 

  

Top Cap 

When selected, the graphics for the Top Cap are displayed in both the preview and drawing. 

  

Bottom Cap 

When selected, the graphics for the Bottom Cap are displayed in both the preview and drawing. 

  

Project Beams into Caps 

When selected, beams present in the workspace will be projected into the weld caps instead of being reflected at the 
piece boundary.  

  

Display Weld Dimensions 

When selected the weld dimensions are displayed in the drawing. 
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Show Zones* 

If using the BeamTool ZONAL Add-On, the Show Zones button provides access to the Zones generation 
panel. Zones can be used in conjunction with a Zonal Beamset*.   More on Zones here. 

5.1.1.1 GENERAL PARAMETERS 

Below are the values that can be set for a piece and weld.  To specify a value you can a) move the slider right or left, 
b) click the right or left value spinner or c) click on the value displayed in the value spinner and type a value.  The 
preview and drawing panes will update on the fly as the values are modified. 

HAZ The Heat Affected Zone.  The portion of the base metal whose structure or properties have 
been changed by the heat of welding or cutting. 
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5.1.2 WELD REGIONS 
Weld Regions are the building blocks of a weld bevel.  From the Weld Configuration dialog, Weld Regions can be 
added, edited, and modified to create a weld bevel to suit (most) real-world situations. 

  

Once a pre-defined Weld Type has been selected (or simply starting with the default weld type), the Add Bevel 
Region drop-down button can be used to add new (or replace existing) regions: 
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Weld regions can be used together in almost any combination, but the following points should be considered when 
constructing a custom weld bevel from individual regions: 

  

• A weld bevel must always have a single Upper Fill region 
• A weld bevel can only have a single Hot Pass and a single Root region 
• A weld bevel can have multiple Fill and/or Root Fill regions 
• Region types always appear in the same vertical position within the weld bevel  

o The Upper Fill region is always at the top of the bevel 
o The Fill regions are always below the Upper Fill region and above the Hot Pass, Root, and Root 

Fill regions (if they exist in the weld) 
o The Hot Pass region is always below the Upper Fill and Fill regions and always above the Root 

region and Root Fill regions (if they exist in the weld) 
o The Root region is always below the Upper Fill and Fill and Hot Pass regions and always above 

the Root Fill regions (if they exist in the weld) 
o Root Fill regions are always at the bottom of the bevel  

Once a region is added to the weld, it appears (with the rest of the weld's regions) in the Regions panel: 
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5.1.3 REGION EDITING 
The Regions panel is used to modify the order and existence of regions within the weld, as well as to modify the 
specific attributes of each region. 

  

The utility buttons on the left side of each region section can be used to: 

 Delete - Remove the selected region from the weld 

 Move Up - Reorder the selected region above the previous region OF THE SAME TYPE 

 Move Down - Reorder the selected region below the next region OF THE SAME TYPE 

  

5.1.4 REGION ATTRIBUTES 
The attributes of each region can then be customized to any particular need.  The available attributes depend on the 
particular region. 

  

Top Cap - The region above the Upper Fill.   The height can be adjusted with or without the option to Auto-Width 
based on height.  If the Auto-Width is de-selected, the overlap can be adjusted separate from the height. 

Upper Fill – The top-most region of the weld.  Has no specific height, only an angle with which to extend to the top 
of the piece.  This region is mandatory when defining a bevel. 

• Angle 
  

Fill – The region above the hot pass containing 1 or more sets of angle & height 

• Angle(s) 
• Height(s) 

  

  

Hot Pass – A variable region that can be J-type (radius) or V-type (angle).  J-type is specified by a radius and an 
optional height configuration – ‘Auto-Height’ or ‘Manual’.  Automatic height calculates to the point where the fill 
region’s angle makes a tangent on the radius.  J-type also allows an optional “Landing” width.  V-type allows a 
simple angle and height. 

  

J-Type 

• Radius 
• Height  

• Auto  -  Determines the appropriate height so that the face of the above fill region will intersect a 
the radius at an exact tangent 
OR 

• Manual 
• Landing width  -  The horizontal width before the radius begins its sweep 

  

V-Type 

• Angle 
• Height 



Weld Configuration 

 
43 

 

Root – A vertical region directly below the hot pass.   Can have an optional gap width. 

• Height 
• Gap width  -  The distance between the left and right faces of the weld bevel 

  

Root Fill – The region below the hot pass containing 1 or more sets of angle & height 

• Angle(s) 
• Height(s) 

  

Bottom Cap - The region below the Root Fill.   The height can be adjusted with or without the option to Auto-
Width based on height.  If the Auto-Width is de-selected, the overlap can be adjusted separate from the height. 
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5.2 WELD ZONES 

Weld Zones are used in conjunction with a Zonal Beamset to provide targeted steering of individual beams into 
individual locations along the face of a weld bevel. 

  

NOTE:  Weld Zones are only available to users of the BeamTool Zonal Add-On. 

  

As a weld bevel is being defined in the Weld Configuration dialog, the Weld Zone panel(s) can be displayed by 
clicking the Show Zones toggle button:

  
Once the Show Zones option has been activated, the Zone Generation and Zones panels are displayed, and zone 
annotations are added to the preview and drawing surfaces. 
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5.2.1 ZONE GENERATION PANEL TOOLBAR 

Auto 

When in Auto Zone Generation mode, the zones table is automatically regenerated from the defined weld regions 
and zone generation input parameters whenever the regions or parameters are modified.  In this mode, zones are 
always kept in sync with their defining inputs.  

Modifications to generated zones in the zones table are not permitted, as any updates would be lost during the next 
automatic regeneration.  The exception to this is any manual zones that have been added to the zones table through 
the Add Manual Zone dialog. 

  

Manual  

When in Manual Zone Generation mode, the zones table is not regenerated when modifications are made to weld 
regions or zone generation input parameters.  Instead, the zones table can be manually regenerated by using the 
Generate button. 

Generated zones can be modified through the zones table, because regeneration will not occur automatically and will 
not overwrite any edits. 

  

Generate 

Will trigger zone table regeneration when in Manual mode, using current weld regions and zone generation input 
parameter values.  Any zones that were previously generated by an auto or manual regeneration will be 
replaced.  Any manually added zones will remain.  
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5.2.2 ZONE GENERATION PANEL TABS 
The Zone Generation Panel has two tabs for configuring zones. 

 

5.2.2.1 BY ZONE LENGTH TAB PARAMETERS 

Upper Fill Length – The maximum length of the uppermost zone, generated from the upper fill region 

Fill Max. Length – The maximum length of zones generated from root, root fill, v-type hot pass, fill, and upper fill 
regions 

Hot Pass Max. Length – The maximum length of zones generated from v-type hot pass regions 

Root Length – The maximum length of the root zone, generated from the bottommost root region 

Vol. Max. Length – The maximum length of a volumetric zone.  Volumetric zones are targeted along the center of 
the vertical axis of the weld. 

Upper Fill Overlap – Allows the fill zones in the upper fill region to ignore the length of upper fill zone.  The upper 
fill zone is still generated, but will be overlapped by a fill zone. 

Root Overlap – Allows the fill zones in the bottommost root region to ignore the length of root zone.  The root zone 
is still generated, but will be overlapped by a fill zone. 

 

5.2.2.2 BY ZONE COUNT TAB PARAMETERS 

Cap Zone Depth - The vertical depth from top of the piece to the bottom of the cap zone.  

Num. Fill Zones - The number of equally sized zones between the bottom to the cap zone, and the top of the hot 
pass zone including the hot pass overlap value. 

Hot Pass Overlap - The distance into the hot pass zone to where the bottom of the first fill zone is positioned. 

Hot Pass Angle - Only used in bevels with j-type hot pass regions.  The angle of the hot pass zone face.  Also 
determines the zone target position by where along the radius a tangent equals the zone face angle. 

Root Zone Depth - The vertical depth from bottom of the piece to the top of the root zone.  

Num. Vol. Zones - The number of equally sized zones between the defined top and bottom vol. zone depths. 

Top Vol. Depth - The vertical depth from the top of the piece to the top of the upper-most volumetric zone. 

Bottom Vol. Depth - The vertical depth from the bottom of the piece to the bottom of the bottom-most volumetric 
zone. 

  

A zone is essentially a line that has a position, length and orientation.  This gives a zone a starting and ending point, 
and an angle.  Zones also have a specific Target that is its main focus point.  Typically the zone's target is directly 
in the middle of its length.  The zone angle and target play an important role when using the Zonal Beamset Zonal 
Solver. 
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Two types of zones are created: 

Fusion - zones that follow the fusion face of the weld bevel 

Volumetric - zones that follow the vertical center of the weld bevel 

  

Zones are generated (from the bottom of the weld bevel up) using the following steps: 

1. Determine the root zone (R1), using the Root Max. parameter. 
-  R1 is always located in the bottom-most root region. 

2. Divide the remainder of the bottom-most root region into zones (R2 – Rx) of equal size, using the Fill 
Max. parameter. 
-  if the UF Overlap option is activated, the entire bottom-most root region is divided, resulting in 
overlapping zones in the root 

3. Divide any existing root regions into zones (Rx – Ry) of equal size, using the Fill Max. parameter. 
4. Determine the hot pass zone(s).  V-Type hot pass regions are divided into zones (HP1 – HPx) or equal size, 

using the HP Max. parameter. 
-  J-Type hot pass regions are not divided and will only ever generate a single zone (HP). 

5. Divide any existing fill regions into zones (F1 – Fx) of equal size, using the Fill Max. parameter. 
6. Determine the upper fill zone (Fx), using the UF Max. parameter. 

-  the upper fill zone is always located in the upper fill region. 
-  if the UF Overlap option is activated, the entire top-most root region is divided, resulting in overlapping 
zones in the upper fill 

7. Divide the remainder of the upper fill region into zones (Fx – Fy) of equal size, using the Fill Max. 
parameter. 

8. Divide the area below the bottom of the hot pass region into volumetric root zones (VR1 – VRx) or equal 
size, using the Volumetric Max. parameter. 

9. Divide the area above the bottom of the hot pass region into volumetric root zones (V1 – Vx) or equal size, 
using the Volumetric Max. parameter. 

  

NOTE: 

• It is important to note that the zones are generated with their length in mind, unlike regions which are defined by their 
height.  The length of a zone will always be greater or equal to its height. 

• Adjacent regions with equal fill angles are treated as a single region, and are divided into equal zones spanning the 
joined regions 

• Zone names are not indexed (IE. R1, R2, etc.) if a zone prefix is only used once.  For example, if there is only a single 
Hot Pass zone, it will be named "HP", not "HP1". 

  

Zones By Count Algorithm 

Zones are generated using the following steps: 

  

1. Determine the root zone (R), using the Root Zone Depth parameter 
-  R is always located in the bottom-most root region. 

2. Determine the cap zone (C), using the Zap Zone Depth parameter 
- C is always located in the upper fill region 

3. Determine the hot pass zone (HP) 
a) if using a v-type hot pass region, HP is the entire region face 
b) if using a j-type hot pass region, HP is constructed using the Hot Pass Angle parameter.  The zone target 
will be positioned along the region face where the tangent angle is equal to the defined angle parameter 
value.  The zone length will be the height of the HP region 



Weld Configuration 

 
48 

 

4. Determine the fill zones (F1 – Fx) 
- First determine the bottom point of the fill area by applying the Hot Pass Overlap parameter value as a 
negative offset from the top of the hot pass zone. 
- Using the determined bottom point of the fill and the top point of the fill area as the bottom of the C zone, 
divide the remaining bevel face into a total of Num. Fill Zones zones of equal length. 

5. Determine the volumetric zone (V1 – Vx) 
- Using the Top Vol. Depth and Bottom Vol. Depth parameter values as positions on the center of the 
bevel, divide the distance between into a total of Num.Vol. Zones zones of equal length. 

  

NOTE: 

Weld bevels that include additional fill angles or root fills cannot be used with the Zones By Count zone generation 
method. 

  



CHAPTER (6): CALIBRATION BLOCK 

Easily generate an ASME compliant calibration block with the click of a button. Targets are added based on your 
piece thickness, while meeting the requirements of ASME Section 5, article 4, Figure 434.2.1. You can also design 
custom calibration blocks and generate reports that include all aspects of a calibration block to support machining. 
This allows the technician to spend more time on developing a technique.    

  

 

6.1 CALIBRATION BLOCK DESIGNER TOOLBAR AND OPTIONS 

 
  

Import 

Import a previously saved CalBlock file.  CalBlock files are saved with a *.btcb file extension. 

  

Export 

Export your CalBlock to file in order to use it again.  CalBlock files are saved with a *.btcb file extension. 
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Auto Cal Block 

Automatically creates an ASME compliant CalBlock based on the thickness of the subject.  Once created, the 
CalBlock can be modified to meet specific requirements. 

  

Add Target 

Provides a drop-down menu of available targets to add to the calibration block.  Available targets are Side-Drilled 
Hole and Notch.  As targets are added their configuration panels will appear below the CalBlock parameters. 

 
  

View Dimensions 

Toggles on and off the view of the target dimensions in the workspace. 

  

View Dimension Factors 

When distances are based on a factor of T or D, display the factor on the dimension as an annotation. 

  

Add Drawing Set 

Brings up the Drawing Properties dialog box where you can name and describe a drawing you want to add.  After 
the drawing properties have been defined, the selected drawing will be available from the Active Drawing drop-
down menu found on the Main Toolbar.  See Drawings for more information on working with Drawings. 

  

Dimension Options 

Throughout the Calibration Block Designer dimensions can be set using one of three dimension options:  
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Choose the factoring applied by using the drop down menus: 

 
Absolute Distance - exact measurement from reference to position.  

Factor of Thickness - measurement based on a factor of the thickness.  

Factor of D - measurement based on a factor of D (minimum distance set by user).  The value of D defaults to the 
ASME standard of 1/2" (13mm). 

  

CalBlock Parameters 

A serial number or identification number can be added to the drawing.  Double-click on the "CalBlock" text to enter 
a custom value. 

Thickness 
Adjusts the overall thickness of the calibration block on the Y axis. The Thickness is Locked  to 
the thickness of the subject.  Click the Lock icon to 

Unlock   and adjust to any thickness. 
Width Adjusts the overall width of the calibration block on the X axis. 
Depth Adjusts the overall depth of the calibration block on the Z axis. 
D Adjusts the minimal distance value.  This value defaults to the ASME standard of 1/2" (13mm). 
Left Radius Adds a radius to the bottom left hand corner of the CalBlock. 
Right 
Radius Adds a radius to the bottom right hand corner of the CalBlock. 

  

SDH Target Panel Options 

 

/  Collapse Panel  

Collapses and expands the SDH Panel. 

  

/  Target Visibility 

Toggles the visibility of the SDH target in the drawing. 
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/  Change Order 

Controls the order of the Target Panels in the Calibration Block Designer window. 

  

Options Drop-Down 

Provides options for   Deleting,   Cloning and   Renaming the SDH target. 

  

SDH Target Corner Anchor  

Selects the corner anchor point for the SDH Target.  Options include, Top Left, Top Right, Bottom Left and Bottom 
Right. 

  

SDH Target Face Anchor 

Selects the face anchor point for the SDH Target.  Options include, Front and Back. 

  

Side Drilled Hole Parameters 

X Defines the position of the SDH target of the X axis. 
Y Defines the position of the SDH target of the Y axis. 
Depth Defines the position for the depth of the SDH target. 
Diameter Defines the position for the diameter of the SDH target. 
  

Notch Target Panel Options 

 

/  Collapse Panel  

Collapses and expands the Notch Panel. 

  

/  Target Visibility 

Toggles the visibility of the Notch target in the drawing. 

  

/  Change Order 

Controls the order of the Target Panels in the Calibration Block Designer window. 
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Options Drop-Down 

Provides options for   Deleting,   Cloning and   Renaming the Notch target. 

  

Notch Target Corner Anchor  

Selects the corner anchor point for the Notch Target.  Options include, Top Left, Top Right, Bottom Left and 
Bottom Right. 

  

Notch Target Face Anchor 

Selects the face anchor point for the Notch Target.  Options include, Front, Centered and Back. 

  

Notch Parameters 

X Defines the measurement for the location of the notch target of the X axis. 
Y Defines the measurement for the location of the notch target of the Y axis. 
Length Defines the measurement for the length of the notch target. 
Depth Defines the measurement for the depth of the notch target. 
Width Defines the measurement for the  width of the notch target. 

  



CHAPTER (7): PROBES 

A probe is made up of a transducer and an optional wedge.  A probe can be added to a workspace by using the Add 
a Probe menu option.  Once added, a probe can be customized using the corresponding Probe group.  The Probe 
group provides access to the Probe Configuration which is used to specify the data values to be used for both the 
transducer and wedge.  The Probe group also provides the ability to control what information is displayed on the 
drawing. 

  

BeamTool supports the placement of Phased Array, Time Of Flight Diffraction and Conventional UT probes. 
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7.1 ADDING PROBES 

A probe is made up of a transducer and an optional wedge.  BeamTool supports the placement of Phased Array, 
Time of Flight Diffraction and Conventional UT probes. 

ADD A PROBE 

Multiple probes can be displayed in a workspace.  By default, when BeamTool is opened there are no probes 
displayed on the drawing.  To add a probe: 

1. Press the Add Probe button located on the main toolbar. 
2. From the picklist select the type of probe to be placed: 

 

 
 
A Probe group is added to the main toolbar and the new probe is displayed in the drawing. 

  

3. Press the button again to add another probe. 
  

Once placed,  probes can be configured by pressing the Probe Configuration button available on the Probe 
group.  Beamsets can also be added for Phased Array probes by pressing the   Add Beamset button on the Probe 
group.  Beams for Time of Flight Diffraction and Conventional UT probes are automatically generated during probe 
placement. 
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7.2 PROBE GROUPS 

Each probe added to the workspace will have a corresponding probe menu added to the toolbar.  You can change the 
view of the probe menu between Compact Probe Bar (provides a minimal readout and a popover edit panel) and Full 
Probe Bar (provides the full readout of the Probe menu) by clicking on the corresponding icons found on the Main 
Toolbar.  Phased Array, TOFD and Conventional UT probe groups are colored uniquely and have differing options. 

  

Phased Array: 

 
  

TOFD: 

 
  

Conventional UT: 
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7.2.1 PROBE GROUPS TOOLBAR 

 Probe Configuration 

The transducer and wedge attributes of a probe can be modified via Probe Configuration button. 

Probe Tools 

Each Probe Group has a Probe Tools drop-down menu that provides various actions that can be performed on a 
probe: 

  

Clone a Probe 

A probe can be created based on attribution specified for an existing probe.  To clone an existing probe to 
create a new one: 

1. Press the Probe Tools button located on the Probe group for the appropriate probe 
2. Press the Clone Probe button.  A new probe will be added using the identical attributes as the 

cloned probe. 
  

Delete a Probe 

Probes that have been added to the workspace using the Add Probe button can be removed.  To remove a 
probe: 

1. Press the Probe Tools button located on the Probe group for the appropriate probe 
2. Press the Delete Probe button.  The Probe group and corresponding graphics in the drawing are 

removed. 
  

Rename a Probe 

By default, probes are given a name that is used to distinguish it on the main toolbar and on the workspace 
and in reports via a label. This default name can be changed by double-clicking the probe name display on 
the top of the probe group (press "Enter" to save changes) or  via the Probe Tools button: 

1. Press the Probe Tools button located on the Probe group for the appropriate probe 
2. Press the Rename button.  The Probe group and corresponding graphics in the drawing are 

removed. 
  

Re-Order Left 

When multiple probes exist in the workspace, you can use this tool to re-order the active Probe Group menu 
one position to the left. 

  

Re-Order Right 

When multiple probes exist in the workspace, you can use this tool to re-order the active Probe Group menu 
one position to the right. 
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Import an Existing Probe 

A probe added to the workspace can be configured manually through the various configuration options, or 
can be imported from an existing probe configuration (*.btps): 

1. Press the Probe Tools button located on the Probe group for the appropriate probe 
2. Press the Import... button and navigate to the BeamTool directory (default location) containing 

the configuration file (*.btps) to be opened. 
3. Select the file and press Open. The configuration data will now be displayed in the dialog and the 

preview and drawing panes will update to display the selected wedge and transducer. 
  

Export or Save a Probe Configuration 

Once a Probe Configuration is complete it can be saved as a PA probe configuration (*.btps) or 
TOFD/Conventional probe set configuration (includes beam): 

1. Press the Probe Tools button located on the Probe group for the appropriate probe 
2. Press the Export... button and navigate to the BeamTool directory (default location). 
3. Enter a name for the file in the File name field and press Save. 

  

Additional Options 

Additional probe group options are described in Probe Options 



Probes 

 
59 

 

7.3 PROBE CONFIGURATION 

A probe can be configured by pressing the Probe Configuration button located on the Probe group. 

Select a probe type below to see a detailed description of the available attributes that can be set for that type of 
probe.* 

  

*NOTE:   The refracted angle may vary slightly from the manufacturer's specified angle as the Piece velocity 
specified in BeamTool may be different than the velocity used by the manufacturer.  Please adjust the Piece 
velocity or the Probe refracted angle as necessary. 

  

Phased Array Probe Configuration   

Time-of-Flight Diffraction Probe Configuration   

Conventional UT Probe Configuration   

 

7.3.1.1 OTHER TOOLS AVAILABLE 

In addition to the options available above, the following buttons are available during Probe configuration: 

  

Expand Menu 

All items in the corresponding menu are displayed. 

  

Collapse Menu 

Hides menu items in the corresponding menu. 

  

Open an Existing Probe 

Once the Probe Configuration dialog has been displayed, existing probe configurations (*.ebwt) can be opened: 

1. Press the Open Probe button and navigate to the BeamTool directory (default location) containing the 
configuration file (*.ebwt) to be opened. 

2. Select the file and press Open. The configuration data will now be displayed in the dialog and the preview 
and drawing panes will update to display the selected wedge and transducer. 

  

Save a Probe Configuration 

Once a Probe Configuration is complete it can be saved as a PA probe configuration (*.ebwt) or 
TOFD/Conventional probe set configuration (includes beam): 

1. Press the Save Probe button and navigate to the BeamTool directory (default location). 
2. Enter a name for the file in the File name field and press Save. 

  

Add Drawing Set 

Brings up the Drawing Properties dialog box where you can name and describe a drawing you want to add.  After 
the drawing properties have been defined, the selected drawing will be available from the Active Drawing drop-
down menu found on the Main Toolbar.  See Drawings for more information on working with Drawings. 
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7.3.1.2  TRANSDUCER OPTIONS 

The options below are available by selecting from the Transducer picklist: 

Import a Previously Saved Transducer 

Previously saved transducer configurations (*.ebt) can be opened: 

1. Press the Open Transducer button and navigate to the BeamTool directory (default location) containing 
the configuration file (*.ebt) to be importeded. 

2. Select the file and press Open. The configuration data will now be displayed in the dialog and the preview 
and drawing panes will update to display the selected transducer. 

Save a Transducer 

Once a transducer configuration is complete it can be saved (*.ebt): 

1. Press the Save Transducer button and navigate to the BeamTool directory (default location). 
2. Enter a name for the file in the File name field and press Save. 

Import a Transducer from Catalog 

Transducer data can be imported into BeamTool from an available catalog.  To import from catalog: 

1. Press the Import from catalog button to display a list of available transducer configurations. 
2. Select the transducer record to be used and press Import.  The transducer data is now displayed in the 

Probe Configuration dialog. 
3.  

7.3.1.3 WEDGE OPTIONS 

The options below are available by selecting from the Wedge picklist: 

Import a Previously Saved Wedge 

Previously saved wedge configurations (*.ebw) can be imported: 

1. Press the Open Wedge button and navigate to the BeamTool directory (default location) containing the 
configuration file (*.ebw) to be opened. 

2. Select the file and press Open. The configuration data will now be displayed in the dialog and the preview 
and drawing panes will update  to display the selected wedge. 

Save a Wedge 

Once a wedge configuration is complete it can be saved (*.ebw): 

1. Press the Save Wedge button and navigate to the BeamTool directory (default location). 
2. Enter a name for the file in the File name field and press b>Save. 

Import a Wedge from Catalog 

Wedge data can be imported into BeamTool from an available catalog.  To import from catalog: 

1. Press the Import from Catalog button to display a list of available wedge configurations. 
2. Select the wedge record to be used and press Import.  The wedge data is now displayed in the Probe 

Configuration dialog. 
Select a Wedge Material 

The Wedge Velocity can be set by selecting a material from the Velocity picklist: 

1. Press the Material button located on the Probe Configuration dialog.  A list of available materials will be 
displayed. 

2. Select a material from the list.  The Velocity value will be set with the assigned material (compression) 
velocity. 

3. The Material picklist can also be displayed by right clicking on the Velocity field. 
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High Temperature 

When the High Temperature add-on is activated, this button can be used to import a High Temp Wedge from 
catalog, or visualize HighTemp for the selected wedge.  To import: 

1. Press the Import High Temp Wedge button to display a list of available HighTemp wedge configurations. 
2. Select the HighTemp wedge record to be used and press Import.  The wedge data is now displayed in the 

Probe Configuration dialog. 
  

Color Properties 

 
The line and fill colors of transducers, wedges and beams can be adjusted with the color properties tool. 
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7.3.2 PHASED ARRAY PROBE CONFIGURATION 
General probe configuration options are described in Probe Configuration. Options specific to phased array probes 
are described below.  To specify a value you can a) move the slider right or left, b) click the right or left value 
spinner or c) click on the value displayed in the value spinner and type a value.  The drawing pane will update on the 
fly as the values are modified. 

 

7.3.2.1 TRANSDUCER OPTIONS 

  

Normal Mount 

The transducer is mounted onto the wedge so that the FIRST element is at the point described by the wedge's Xt and 
Z parameters. 

  

Reversed Mount 

The transducer is mounted onto the wedge so that the LAST element is at the point described by the wedge's Xt and 
Z parameters. 

  

Parameters 

Part Number The part number of the transducer (entered by user or populated from import) 
Frequency The number of complete cycles per unit of time. 
Total Elements The total number of elements on the transducer that are available to convert the 

electrical energy into acoustical energy. 
Element Pitch The distance between the centers of two adjacent elements. 
Element Width The width of a single piezocomposite element. 
Passive Width The length of a single piezocomposite element. 
Start Channel The channel on the PA instrument that the transducer is connected to. 
Element Gap The gap between adjacent elements. 
Total Aperture The Total Elements multiplied by the Element Pitch.  (read only) 
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7.3.2.2 WEDGE OPTIONS 

  

Wedge Mode 

The probe's wedge mode can be modified by clicking the Wedge Mode button.  This will pop-up a drop-down list 
with Block Wedge, Contact, and Immersion options.  Selecting the block wedge mode will display the full list of 
the following parameters. Selecting contact or immersion modes will hide all the wedge parameters aside from 
Velocity. When using contact or immersion modes, the velocity value is applied to the couplant or immersion 
medium.  

   
Changing the wedge mode will remove the wedge display from the drawing pane and will automatically set a new 
default value for the probe's elevation offset. 

  

Parameters 

Part Number The part number of the wedge (entered by user or populated from import). 
Velocity The material (compression) velocity of the wedge, couplant or immersion 

medium.  Right click on the field to select a velocity for a specified 
material.  Velocity value can also be set by selecting from the Material picklist. 

X The length of the wedge in contact with the piece between the start location of the 
transducer and the front face. 

Xt The length of the wedge in contact with the piece between the back face of the 
wedge and start location of the transducer. 

Z The height of the first transducer element from the piece. 
Height The height of the wedge. 
Width The width of the wedge.  (Changes visible in Top View) 
Angle The angle of the wedge on which the transducer sits. 
Inset / Outset This is the distance the transducer is recessed into the wedge or out from the 

wedge.  Positive values are into the wedge and negative values are out from the 
wedge.  This is sometimes referred to as the Pocket Depth. 

Outset Buffer The space between the outset on the wedge and the edges. 
Front Slope The angle of the slope at the front of the wedge 
Damping Depth The distance the damping groove extends into the wedge from the wedge face. The 

damping groove runs parallel to a line extending from the bottom of the wedge face 
to the top of the wedge slope. 

Radius   
Wedge Length The total length of the wedge in contact with the piece.  (read only) 
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7.3.3 TIME-OF-FLIGHT DIFFRACTION PROBE CONFIGURATION 
General probe configuration options are described in Probe Configuration. Options specific to TOFD probes are 
described below.  To specify a value you can a) move the slider right or left, b) click the right or left value spinner 
or c) click on the value displayed in the value spinner and type a value.  The drawing pane will update on the fly as 
the values are modified. 
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7.3.3.1 BEAM OPTIONS 

  

Display Beam Coverage 

Displays the estimated coverage area based on beam spread and refraction. 

  

Parameters 

Resolution Depth The precision in which you can size the depth of a flaw. 
Locus Curve Depth The precision in which you can define the depth of the Locus Curve.  Locus curves 

indicate the maximum detection range of a TOFD configuration. They can be used to 
identify whether additional techniques are required to cover areas beyond range. With a 
standard TOFD configuration, an indication may be detected somewhere between the two 
probes within the locus curve. However, the actual location of the indication might not be 
directly between the two probes symmetrically. A third probe (tandem probe) can be 
added to remove the ambiguity. The location of the indication can be more accurately 
determined by the intersection of the two locus curves. 

Spatial Resolution The distinguishing distance between two flaws. 
dB Drop Specifies the amplitude drop method to be used. 
Beam Spread The increase in beam diameter with distance from the aperture from which the beam 

emerges. 
Near Field A section of the radiated beam that is within a (small) number of wavelengths of the 

beam source. 
  

7.3.3.2 TRANSDUCER OPTIONS 

  

Parameters 

Part Number The part number of the transducer (entered by user or populated from import). 
Frequency The number of complete cycles per unit of time. 
Shape Toggle on Round or Square to specify the shape of the transducer. 
Height The height of the transducer. 
Diameter The diameter of the transducer.  (Round transducers only) 
Width The width of the transducer.  (Square transducers only) 
Length The length of the transducer.  (Square transducers only) 
Channel The channel on the PA instrument that the first transducer is connected to. 
2nd Channel The channel on the PA instrument that the second transducer is connected to. 
Total Aperture Usually a single element.  (read only) 
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7.3.3.3 WEDGE OPTIONS 

  

Parameters 

Part Number The part number of the wedge (entered by user or populated from import). 
Velocity The material velocity of the wedge.  Right click on the field to select a velocity for a 

specified material. 
Length The total length of the wedge in contact with the piece. 
Exit Point The distance between the front face of the wedge and the point at which the beam 

exits the wedge. 
Inset The depth of the inset into the wedge in which the transducer sits. 
Width The width of the wedge.  (Changes visible in Top View) 
Front Height The height of the front face of the wedge. 
Back Height The height of the back face of the wedge. 
Wedge Angle The angle of the wedge on which the transducer sits. 
Refracted Angle The angle of the beam through the wedge based on the velocity. 

7.3.3.4  
TANDEM PROBE OPTIONS 

TOFD probes can be configured in Tandem mode, where a third probe is configured to work in conjunction with the 
existing left or right probe. 

  

Parameters 

Tandem None Removes any tandem probes from the piece. 

Tandem Left Places a tandem probe on the left hand side of the piece. 

Tandem Right Places a tandem probe on the right hand side of the piece. 
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7.3.4 CONVENTIONAL UT PROBE CONFIGURATION 
General probe configuration options are described in Probe Configuration. Options specific to conventional UT 
probes are described below.  To specify a value you can a) move the slider right or left, b)  click the right or left 
value spinner or c) click on the value displayed in the value spinner and type a value.  The drawing pane will update 
on the fly as the values are modified. 
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7.3.4.1 BEAM OPTIONS 

  

Display A-Scan 

Displays an A-Scan visualization for the probe.  Additional detail on configuring A-Scans can be found here. 

  

Number of Beam Skips 

Select the number of beam 1/2 skips to be displayed in the drawing. 

  

Use Piece Shear Velocity 

Selects the Shear velocity of the piece to be used when calculating the beam path through the piece. 

  

Use Piece Compression Velocity 

Selects the Compression velocity of the piece to be used when calculating the beam path through the piece. 

  

Display Beam Spread 

Displays how the beam spreads out as it propagates through the material. 

  

Show Snell's Law 

Displays a visualization of Snell's Law where the beam refracts into the piece. 

  

Display Beam Near Field 

Displays the area in the sound beam immediately in front of the transducer and is calculated using the frequency and 
cross-sectional area of the transducer surface. 

  

Display Surface Distance Dimension 

Displays the distance along the entry surface between the initial entry point into the specimen and its reflected exit 
point. 

  

Display V Path Distance Dimension 

Displays the total distance the beam travels through the specimen from the initial entry point to the exit point. 

  

Display Pitch Catch 

Displays the path a reflected beam would take back into a wedge and the elements that could best be used to receive 
this signal 
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Parameters 

dB Drop Specifies the amplitude drop method to be used. 
Beam Spread The increase in beam diameter with distance from the aperture from which the beam 

emerges. 
Near Field A section of the radiated beam that is within a (small) number of wavelengths of the 

beam source. 

7.3.4.2 TRANSDUCER OPTIONS 

  

Parameters 

Part Number The part number of the transducer (entered by user or populated from import) 
Frequency The number of waves that pass a given point in a specified unit of time. 
Shape Toggle on Round or Square to specify the shape of the transducer. 
Height The height of the transducer. 
Diameter The diameter of the transducer.  (Round transducers only) 
Width The width of the transducer.  (Square transducers only) 
Length The length of the transducer.  (Square transducers only) 
Channel The channel on the PA instrument that the transducer is connected to. 
Total Aperture Usually a single element.  (read only) 

7.3.4.3 WEDGE OPTIONS 

  

Wedge Mode 

The probe's wedge mode can be modified by clicking the Wedge Mode button.  This will pop-up a drop-down list 
with Block Wedge, Contact, and Immersion options.  Selecting the block wedge mode will display the full list of 
the following parameters. Selecting contact or immersion modes will hide all the wedge parameters aside from 
Velocity. When using contact or immersion modes, the velocity value is applied to the couplant or immersion 
medium. 

  

   
Changing the wedge mode will remove the wedge display from the drawing pane and will automatically set a new 
default value for the probe's elevation offset. 
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Parameters 

Part Number The part number of the wedge (entered by user or populated from import). 
Velocity The material velocity of the wedge.  Right click on the field to select a velocity for a 

specified material. 
Length The total length of the wedge in contact with the piece. 
Exit Point The distance between the front face of the wedge and the point at which the beam 

exits the wedge. 
Inset The depth of the inset into the wedge in which the transducer sits. 
Width The width of the wedge.  (Changes visible in Top View) 
Front Height The height of the front face of the wedge. 
Back Height The height of the back face of the wedge. 
Wedge Angle The angle of the wedge on which the transducer sits. 
Refracted Angle The angle of the beam through the wedge based on the velocity. 
   

Acquisition 

The Acquisition parameters are not directly utilized in BeamTool rendering, but can in downstream applications 
through export or import.  Eclipse’s TrueView girth weld scanning system, for example. 
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7.4 PROBE POSITIONING  

Probes can be positioned interactively through the workspace surface. 

 
  

Click and hold to drag and drop Phased Array and Conventional probes to place them anywhere on your 
workspace.    

Handles are provided for positioning and rotating probes on both side and top views.  

The handle on the front of the probe is used for positioning. 
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The Handle on the back of the probe is used for rotating 

 
Snapping and Construction Aids can also be used to help accurately position your probes. 
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7.5 PROBE IDENTIFIER 

When a probe is selected in the workspace, BeamTool will automatically highlight the probes corresponding 
configuration box.  This allows the user to quickly identify the configuration options for the selected probe in a 
multi-probe workspace.  Multiple probe selection is also supported. 
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7.6 PROBE OPTIONS 

In addition to configuring some simple probe attributes, the Probe Group also provides the ability to do the 
following: 

7.6.1 ALL PROBE GROUPS 

Probe 
Configuration 

Displays the Probe Configuration dialog which can be used to specify detailed probe 
attributes. 

Probe Tools Provides access to the Clone, Delete, Rename, Import and Export probe commands. 

Clone Probe Creates a probe based on attribution set for existing probe. 

Delete Probe 
Removes the probe.  The Probe group and corresponding graphics in the drawing are 
removed. 

Rename Probe When selected, the Probe name is editable.  

Re-Order Left 
When multiple probes exist in the workspace, you can use this tool to re-order the active 
Probe Group menu one position to the left. 

Re-Order Right 
When multiple probes exist in the workspace, you can use this tool to re-order the active 
Probe Group menu one position to the right. 

Import Probe When selected, imports the beam configurations for a previously saved probe set (*.ebps). 

Export Probe When selected, exports the probe set (*.ebps). 

 

Display Probe 
When selected, displays the probe and associated graphics (labels and 
beams) on the drawing. 

Display Probe Name When selected, displays the name of the probe on the drawing. 

Display Wedge Part Number When selected, displays the wedge part number on the drawing. 

Display Transducer Part Number When selected, displays the transducer part number on the drawing. 

Display Wedge Dimensions 
When selected, displays the X, Xt, Z and Height values for the wedge 
on the drawing. 

Display Wedge Position Dimension 
When selected, displays the distance of the wedge from the centre 
point on the weld on the drawing. 

  

7.6.2 PHASED ARRAY GROUP ONLY 

Flip Probe Flips the probe horizontally. 

Pin Controls how the probe is pinned to an ID/OD piece (available on ID/OD pieces only). 

 

Add Beamset Adds a Beamset to a Phased Array probe. 

 

Probe Position (Side View - Horizontal) Adjusts the probe distance from the center of the weld. 

Probe Position (Side View - Vertical) Adjusts the probe distance from the top face of the piece 

Probe Position (Top View) 
Adjusts the probe position along the width of the top face of the 
piece (available in Top View only). 

Rotate Probe Rotates the Probe +/- 90 degrees 
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7.6.3 TOFD GROUP ONLY 

Display Crossover Dimensions 
When selected, displays the percentage and distance into the piece that the 
transmitter beam travels to the point it meets the receiver beam. 

Display Dead Zones 
When selected, displays the near surface discontinuity areas for the top and 
bottom walls of the piece. 

Spatial Resolution 
When selected, displays the height of the smallest resolvable flaw at a given 
depth. 

Display Locus Curve 
When selected, displays a locus curve indicating the maximum detection 
range of the TOFD configuration. 

Pin 
Controls how the probe is pinned to an ID/OD piece (available on ID/OD 
pieces only). 

 

Index Offset 
The distance the probes are offset horizontally.  This is based on the horizontal 
center of the beam crossover. 

Elevation Offset 
The distance probe A and probe B are vertically offset from one another.  Positive 
numbers elevate probe B and negative numbers offset probe A. 

Probe Position (Top View) 
Adjusts the probe position along the width of the top face of the piece (available 
in Top View only). 

Crossover Depth This is the depth within the piece that the beam crossover should occur. 

  

7.6.4 CONVENTIONAL UT GROUP ONLY 

Flip Probe Flips the probe horizontally. 

Pin Controls how the probe is pinned to an ID/OD piece (available on ID/OD pieces only). 

 

Probe Position (Side View - Horizontal) Adjusts the probe distance from the center of the weld. 

Probe Position (Side View - Vertical) Adjusts the probe distance from the top face of the piece. 

Probe Position (Top View) 
Adjusts the probe position along the width of the top face of the 
piece (available in Top View only). 

Rotate Probe Rotates the Probe +/- 90 degrees. 
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7.6.5 OTHER TOOLS AVAILABLE 
In addition to the buttons available above the following information is available using the Piece group. 

  

Recents 

As you use BeamTool, the software will remember which transducers, wedges and equipment you commonly 
use.  The recently used probes and wedges will be available for quick access from a drop-down menu, without 
having to import from a file or our extensive catalog.   

  

Probe Info Tips 

Probe Info can be selected to display a quick summary of the key Probe values specified. 
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7.7 PHASED ARRAY (PA) 

Phased Array testing is a specialized type of ultrasonic testing that uses sophisticated multi-element array 
transducers and powerful software to steer high frequency sound beams through the test piece and map returning 
echoes, producing detailed images of internal structures similar to medical ultrasound images.  It is used for 
inspection of critical structural metals, pipeline welds, aerospace components and similar applications where the 
additional information supplied by phased array inspection is valuable. 

The phased array probe is comprised of many small ultrasonic elements each of which can be pulsed 
individually.  By varying the timing, for instance by pulsing the elements one by one in sequence along a row, a 
pattern of interference is set up that results in a beam at a set angle.  In other words, the beam can be steered 
electronically.  The beam is swept like a search light through the piece being examined and the data from multiple 
beams are put together to make a visual image showing a slice through the piece. 
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7.7.1 PHASED ARRAY BEAMSETS  
Phased Array probes support seven types of beamsets: 

 
  

Beamsets can be added to a phased array probe by clicking the   Add Beamset, or one of the seven beamset icons 
on the appropriate probe group. 

  

Single Beam Beamset 

Linear Beamset 

Sectorial Beamset 

Linear Spread Beamset 

Zonal Beamset 

Full Matrix Capture Beamset 
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Reference Beamset 

  

More than one beamset can be added to a single PA probe. 

  

Once added, a beamset can be modified and configured by clicking on the Beamset Tab that gets added to the Probe 
group 
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7.7.2 ADDING BEAMSETS TO A PHASED ARRAY (PA) PROBE 
Phased Array probes support six types of beamsets: 
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Add a Beamset 

A Phased Array probe can display one or more beamsets.  There are two methods to add a beamset to a probe: 

1. Press the   Add Beamset button located on the Probe group for the selected probe.  A drop down list containing the 
available beamsets is displayed.  Select the appropriate beamset from the list.  The beamset is displayed on the drawing 
for the selected probe.  A Single Beam, Linear, Sectorial, Linear Spread, Zonal, Full Matrix Capture or Reference 
Beamset tab is added to the Probe group. 

2. You can also add a beamset by clicking on one of the seven corresponding icons found on the Probe Group. 
  

Single Beam Beamset 

Linear Beamset 

Sectorial Beamset 

Linear Spread Beamset 

Zonal Beamset 

Full Matrix Capture Beamset 

Reference Beamset 

  

A Beamset Tab will be added to the probe group (above the  Add Beamset icon) for each beamset added to the 
probe.   

 
A beamset can be configured on the beamset tab menu, or by clicking the beamset tab. 
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7.7.3 PHASED ARRAY BEAMSET TABS 

 
A beamset tab is added to the probe group (above the Add Beamset button) for each beamset added to the probe. 
The beamset tab displays the following information/options: 

• Color bar indicating the current beamset line color 
• Type of beamset (single beam, linear, sectorial, linear spread, zonal or reference) 
• Beamset visibility (on or off) 
• Up and down arrows for re-ordering beamsets when multiple beamsets are present 
• The ability to delete the beamset 

  

Configure Beamset 

A beamset tab is also a button that can be used to access additional beamset functions.  Double-clicking the beamset 
tab will open the Beamset Configuration.  Right-clicking on the beamset tab pops up a drop-down list with the 
following options. 

 

Configure Beamset 

The specific parameters of the beamset can be set through the Configure Beamset button. A description of the 
available beamset parameters can be found in Beamset Configuration. 

  

Beamset Visibility 

To avoid workspace clutter the visibility of beamset graphics in the drawing can be turned on or off.  By default, 
beamset graphics are displayed.  To turn the visibility off: 

1. Select Beamset Visible from the menu.  The beamset graphics are removed from the drawing but the 
beamset button remains available on the probe toolgroup.  The Beamset button on the probe toolgroup no 
longer displays the Visibility (closed eye) indicator. 

2. Select Beamset Visible again to display the graphics in the drawing.  The Beamset button on the probe 
toolgroup displays the Visibility (eye) indicator. 
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Additionally, the visibility of the beamset can be specified using the Toggle Beamset Visibility button located on 
the Beamset Configuration dialog. 

  

Clone a Beamset 

Beamsets that have been added to the workspace using the Add Beamset button can be cloned, creating a beamset 
with duplicate attribution.  To clone a beamset: 

1. In the probe toolgroup click on the beamset to be cloned and select Clone Beamset from the menu.  A new 
beamset toolgroup and corresponding graphics are added to the Probe toolgroup. 

  

Delete a Beamset 

Beamsets that have been added to the workspace using the Add Beamset button can be removed.  To remove a 
beamset: 

1. In the probe toolgroup click on the beamset to be removed and select Delete Beamset from the menu.  The 
beamset toolgroup and corresponding graphics in the drawing are removed. 

  

Rename a Beamset 

Beamsets that have been added to the workspace using the Add Beamset button can be renamed from the system 
generated name.  To rename a beamset: 

1. In the probe toolgroup right click on the beamset to be renamed and select Rename from the menu.  Type 
the new name and select press Enter on the keyboard. 

  

Re-Order Up 

When multiple beamsets exist, you can use this tool to re-order the selected beamset tab one position up. 

  

Re-Order Down 

When multiple beamsets exist, you can use this tool to re-order the selected beamset tab one position down. 
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7.7.4 CONFIGURATION OF PHASED ARRAY (PA) BEAMSETS 
Once a beamset has been added to a Phased Array probe it can be configured by double-clicking on the Beamset tab 
added to the Probe group or by selecting Configure Beamset from the right-click  Beamset Tab menu.  This will 
display the Beam Configuration dialog which can be used to specify the data values to be used.   

  

Some configuration options and parameters are available to all types of beamsets, but other options and parameters 
are only available to certain beamset types. 

7.7.4.1 COMMON BEAMSET OPTIONS 

Below are the options that can be set for most Phased Array beamsets.  

  

Toggle Beamset Visibility 

To avoid workspace clutter the visibility of beamset graphics in the drawing can be turned on or off.  By default, 
beamset graphics are displayed.  Deselect the Toggle Beamset Visibility button to hide the beamset graphics. 

  

Crop Mode 

Identify any type point on a beam path based on   Distance,   Time or   Skips. 

  

• Distance: Beams are cropped at a specific distance along the beam path. 
• Time: Beams are cropped at a specific time along the beam path based on the velocity of the materials. 
• Skips:  Beams are cropped by setting the umber of skips (reflections). 

  

Use Piece Shear Velocity 

Selects the Shear velocity of the piece to be used when calculating the beam path through the piece. 

  

Use Piece Compression Velocity 

Selects the Compression velocity of the piece to be used when calculating the beam path through the piece. 

  

Display Beam Focus 

Defines the point at which a sound beam converges to minimum diameter and maximum sound pressure and beyond 
which the beam diverges. 

A Focus Type can be specified and used to display the beam's focus into the piece. 

1. Select the Focus Type button.  A list of Focus Types are displayed. 
2. Select the appropriate Focus Type: 
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True Depth - True depth is the specified distance into the piece parallel to the bottom of the wedge. 
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Projection - Projection is the specified distance in the piece parallel to the front of the wedge. 
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Half Path - Half Path is the distance along each beam from the point where the beam enters the piece. 

 

None - Do not perform focusing. 
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Display Gate 

The Gate describes an electronic means to monitor a specific segment of distance. 
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Display Beam Near Field 

Displays the area in the sound beam immediately in front of the transducer and is calculated using the frequency and 
cross-sectional area of the transducer surface.  
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Display Beam Spread 

Displays how the beam spreads out as it propagates through the material. 
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Display Pitch Catch 

Displays the path a reflected beam would take back into a wedge and the elements that could best be used to receive 
this signal. 

 

 

 

 Display Pitch Catch turned on and 
 Reflect Off Weld turned on 

 Display Pitch Catch Turned off  Reflect Off Weld turned off 

  

Reflect Off Weld 

Beams will reflect off the weld instead of passing through. 
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Show Elements 

Displays the elements and element usage information on the transducer. 

 
  

  

Element Utilization 

 
The Beamset Configuration dialog summarizes the element usage by displaying graphically the number of elements 
available for the selected transducer and the usage based on the aperture settings specified. 
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Beam Type 

 
A pick-list of available beam types: 

• Solid Beams - displays all of the beams in the same color. 

 
  



Probes 

 
94 

 

• Color List - displays each beam skip in the color defined in File  Options. 

 

Line Color 

Color(s) to be used to display the beams for both the preview and drawing panes. 

  

Beam Buffer Visibility 

Visibility of the beam buffer lines that indicate the bounds of the elemental area(s). 

  

Parameters 

To specify a value you can a) move the slider right or left, b)  click the right or left value spinner or c) click on the 
value displayed in the value spinner and type a value.  The preview and drawing panes will update on the fly as the 
values are modified. 

 Start Element The number of the first element in the aperture. 

Focus Length The distance from the bottom of the wedge to the focus point.  Calculated based on Display 
Beam Focus selected (see Other Tools Available below). 

Gate Start The distance from the exit point on the bottom of the wedge to the start point of the gate. 

Gate Length The length of the gate segment. 
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In addition to the tools and parameters described above, specific beamsets have their own unique tools and 
parameters.  Click on the links below for more details. 

  

Single Beam Beamset 

Linear Beamset 

Sectorial Beamset 

Linear Spread Beamset 

Zonal Beamset 

Full Matrix Capture Beamset 

Reference Beamset 
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7.7.4.2 SINGLE BEAM BEAMSET 

Single Beam Beamsets render a single beam from a defined set of elements at a specified refracted angle.  Useful for 
developing zonal techniques. 
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7.7.4.2.1 SINGLE BEAM BEAMSET CONFIGURATION OPTIONS 
  

Toggle Beamset Visibility 

To avoid workspace clutter the visibility of beamset graphics in the drawing can be turned on or off.  By default, 
beamset graphics are displayed.  Deselect the Toggle Beamset Visibility button to hide the beamset graphics. 

  

Display A-Scan 

Displays an A-Scan visualization for the beamset.  Additional detail on configuring A-Scans can be found here. 

  

Use Piece Shear Velocity 

Selects the Shear velocity of the piece to be used when calculating the beam path through the piece. 

  

Use Piece Compression Velocity 

Selects the Compression velocity of the piece to be used when calculating the beam path through the piece. 

  

Crop Mode 

Identify any type point on a beam path based on   Distance,   Time or   Skips. 

  

Display Beam Focus 

Defines the point at which a sound beam converges to minimum diameter and maximum sound pressure and beyond 
which the beam diverges. 

A Focus Type can be specified and used to display the beam's focus into the piece. 

1. Select the Focus Type button.  A list of Focus Types are displayed. 
2. Select the appropriate Focus Type: 

  

True Depth - True depth is the specified distance into the piece parallel to the bottom of the wedge. 

Projection - Projection is the specified distance in the piece parallel to the front of the wedge. 

Half Path - Half Path is the distance along each beam from the point where the beam enters the piece. 

None - Do not perform focusing. 

  

Display Gate 

The Gate describes an electronic means to monitor a specific segment of distance. 

  

Display Beam Near Field 

Displays the area in the sound beam immediately in front of the transducer and is calculated using the frequency and 
cross-sectional area of the transducer surface.  
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Display Beam Spread 

Displays how the beam spreads out as it propagates through the material. 

  

Display Beam Angle 

Displays the angle of the beam relative to the weld angle. 

  

Display Pitch Catch 

Displays the path a reflected beam would take back into a wedge and the elements that could best be used to receive 
this signal. 

  

Reflect Off Weld 

Beams will reflect off the weld instead of passing through. 

  

Show Elements 

Displays the elements and element usage information on the transducer. 

  

Show Snell's Law 

Displays a visualization of Snell's Law where the beam refracts into the piece. 

  

Parameters 

Start Element The number of the first element in the aperture. 

Aperture Elements The number of contiguous elements in the aperture. 

Refracted Angle The angle of the beam within the piece or part. 

Focus Length The distance from the bottom of the wedge to the focus point.  Calculated based on Display 
Beam Focus selected. 

Gate Start The distance from the exit point on the bottom of the wedge to the start point of the gate. 

Gate Length The length of the gate segment. 

dB Drop Specifies the amplitude drop method to be used. 

Near Field The estimated distance in front of the transducer in which the beam exhibits a change in 
wave front .  (read only) 

Used Aperture The Elements Used multiplied by the Element Pitch.  (read only) 

Beam Sweep The difference between the exit point of the first beam to the last beam.  (read only) 

Beam Spread The divergence of the sound beam as it travels through the piece.  (read only) 
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Alpha Angle The incident angle of the beam within the wedge.  (read only) 

Rx Start Element The first element in a group of elements assigned to receive in pitch catch 
configuration.  This is automatically configured based on the parameters of the transmitting 
beam. 

Rx Elements The number of elements configured to receive in a pitch catch configuration.  

Rx Angle The maximum angle at which a beam can be received. 

  

Acquisition 

The Acquisition parameters are not directly utilized in BeamTool rendering, but can in downstream applications 
through export or import.  Eclipse’s TrueView girth weld scanning system, for example. 

  

Element Utilization 

 
The Beamset Configuration dialog summarizes the element usage by displaying graphically the number of elements 
available for the selected transducer and the usage based on the aperture settings specified. 

  

Beam Type 

 
A pick-list of available beam types: 

• Solid Beams - displays all of the beams in the same color. 
• Color List - displays each beam skip in the color defined in File  Options. 

  

Line Color 

 
Color(s) to be used to display the beams for both the preview and drawing panes. 

  

Beam Buffer Visibility 

 
Visibility of the beam buffer lines that indicate the bounds of the elemental area(s). 
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7.7.4.3 LINEAR BEAMSET 

Linear Beamsets allow a number of focal laws to be drawn from different elements with a common refracted angle. 

 

7.7.4.3.1.1 LINEAR BEAMSET CONFIGURATION OPTIONS 
  

Toggle Beamset Visibility 

To avoid workspace clutter the visibility of beamset graphics in the drawing can be turned on or off.  By default, 
beamset graphics are displayed.  Deselect the Toggle Beamset Visibility button to hide the beamset graphics. 

  

Use Piece Shear Velocity 

Selects the Shear velocity of the piece to be used when calculating the beam path through the piece. 

  

Use Piece Compression Velocity 

Selects the Compression velocity of the piece to be used when calculating the beam path through the piece. 

  

Crop Mode 

Identify any type point on a beam path based on   Distance,   Time or   Skips. 

  



Probes 

 
101 

 

Display Beam Focus 

Defines the point at which a sound beam converges to minimum diameter and maximum sound pressure and beyond 
which the beam diverges. 

A Focus Type can be specified and used to display the beam's focus into the piece. 

1. Select the Focus Type button.  A list of Focus Types are displayed. 
2. Select the appropriate Focus Type: 

  

True Depth - True depth is the specified distance into the piece parallel to the bottom of the wedge. 

Projection - Projection is the specified distance in the piece parallel to the front of the wedge. 

Half Path - Half Path is the distance along each beam from the point where the beam enters the piece. 

None - Do not perform focusing. 

  

Display Gate 

The Gate describes an electronic means to monitor a specific segment of distance. 

  

Display Beam Near Field 

Displays the area in the sound beam immediately in front of the transducer and is calculated using the frequency and 
cross-sectional area of the transducer surface.  

  

Display Beam Spread 

Displays how the beam spreads out as it propagates through the material. 

  

Display Pitch Catch 

Displays the path a reflected beam would take back into a wedge and the elements that could best be used to receive 
this signal. 

  

Reflect Off Weld 

Beams will reflect off the weld instead of passing through. 

  

Show Elements 

Displays the elements and element usage information on the transducer. 
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Parameters 

Start Element The number of the first element in the aperture. 

Aperture Elements The number of contiguous elements in the aperture. 

Num Beams The number of beams used. 

Element Step The number of offset elements for each beam being fired. 

Refracted Angle The angle of the beam within the piece or part. 

Focus Length The distance from the bottom of the wedge to the focus point.  Calculated based on 
Display Beam Focus selected. 

Gate Start The distance from the exit point on the bottom of the wedge to the start point of the gate. 

Gate Length The length of the gate segment. 

dB Drop Specifies the amplitude drop method to be used. 

Min Near Field The estimated minimum distance in front of the transducer in which the beam exhibits a 
change in wave front .  (read only) 

Max Near Field The estimated maximum distance in front of the transducer in which the beam exhibits a 
change in wave front.  (read only) 

Used Aperture The Elements Used multiplied by the Element Pitch.  (read only) 

Beam Sweep The difference between the exit point of the first beam to the last beam.  (read only) 

Beam Spread The divergence of the sound beam as it travels through the piece.  (read only) 

Alpha Angle The incident angle of the beam within the wedge.  (read only) 

Rx Start Element The first element in a group of elements assigned to receive in pitch catch 
configuration.  This is automatically configured based on the parameters of the 
transmitting beam. 

Rx Elements The number of elements configured to receive in a pitch catch configuration.  

  

Element Utilization 

 
The Beamset Configuration dialog summarizes the element usage by displaying graphically the number of elements 
available for the selected transducer and the usage based on the aperture settings specified. 
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Beam Type 

 
A pick-list of available beam types: 

• Solid Beams - displays all of the beams in the same color. 
• Color List - displays each beam skip in the color defined in File  Options. 

  

Line Color 

 
Color(s) to be used to display the beams for both the preview and drawing panes. 

  

Beam Buffer Visibility 

 
Visibility of the beam buffer lines that indicate the bounds of the elemental area(s). 
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7.7.4.3.2 SECTORIAL BEAMSET 
Sectorial Beamsets allow a number of focal laws to be drawn from different elements with a range of refracted 
angles. 

 
  

7.7.4.3.2.1 SECTORIAL BEAMSET CONFIGURATION OPTIONS 
  

Toggle Beamset Visibility 

To avoid workspace clutter the visibility of beamset graphics in the drawing can be turned on or off.  By default, 
beamset graphics are displayed.  Deselect the Toggle Beamset Visibility button to hide the beamset graphics. 

  

Display A-Scan 

Displays an A-Scan visualization for the beamset.  Additional detail on configuring A-Scans can be found here. 

  

Use Piece Shear Velocity 

Selects the Shear velocity of the piece to be used when calculating the beam path through the piece. 
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Use Piece Compression Velocity 

Selects the Compression velocity of the piece to be used when calculating the beam path through the piece. 

  

Crop Mode 

Identify any type point on a beam path based on   Distance,   Time or   Skips. 

  

Display Beam Focus 

Defines the point at which a sound beam converges to minimum diameter and maximum sound pressure and beyond 
which the beam diverges. 

A Focus Type can be specified and used to display the beam's focus into the piece. 

1. Select the Focus Type button.  A list of Focus Types are displayed. 
2. Select the appropriate Focus Type: 

  

True Depth - True depth is the specified distance into the piece parallel to the bottom of the wedge. 

Projection - Projection is the specified distance in the piece parallel to the front of the wedge. 

Half Path - Half Path is the distance along each beam from the point where the beam enters the piece. 

None - Do not perform focusing. 

  

Display Gate 

The Gate describes an electronic means to monitor a specific segment of distance. 

  

Display Beam Near Field 

Displays the area in the sound beam immediately in front of the transducer and is calculated using the frequency and 
cross-sectional area of the transducer surface.  

  

Display Beam Spread 

Displays how the beam spreads out as it propagates through the material. 

  

Reflect Off Weld 

Beams will reflect off the weld instead of passing through. 

  

Show Elements 

Displays the elements and element usage information on the transducer. 
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Parameters 

Start Element The number of the first element in the aperture. 

Aperture Elements The number of contiguous elements in the aperture. 

Min Angle The refracted angle of the first beam. 

Max Angle The refracted angle of the last beam. 

Num Beams The number of beams used. 

Beam Deviation The angle between beam steps.  (read only) 

Focus Length The distance from the bottom of the wedge to the focus point.  Calculated based on 
Display Beam Focus selected. 

Gate Start The distance from the exit point on the bottom of the wedge to the start point of the gate. 

Gate Length The length of the gate segment. 

dB Drop Specifies the amplitude drop method to be used. 

Min Near Field The estimated minimum distance in front of the transducer in which the beam exhibits a 
change in wave front .  (read only) 

Max Near Field The estimated maximum distance in front of the transducer in which the beam exhibits a 
change in wave front.  (read only) 

Min Spread The estimated minimum beam spread.  (read only) 

Max Spread The estimated maximum beam spread.  (read only) 

Used Aperture The Elements Used multiplied by the Element Pitch.  (read only) 

  

Element Utilization 

 
The Beamset Configuration dialog summarizes the element usage by displaying graphically the number of elements 
available for the selected transducer and the usage based on the aperture settings specified. 
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Beam Type 

 
A pick-list of available beam types: 

• Solid Beams - displays all of the beams in the same color. 
• Color List - displays each beam skip in the color defined in File  Options. 

  

Line Color 

 
Color(s) to be used to display the beams for both the preview and drawing panes. 

  

Beam Buffer Visibility 

 
Visibility of the beam buffer lines that indicate the bounds of the elemental area(s). 
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7.7.4.4 LINEAR SPREAD BEAMSET 

Linear Spread Beamsets allow a number of focal laws to be drawn from different elements with a range of refracted 
angles. 

 

7.7.4.4.1 LINEAR SPREAD BEAMSET CONFIGURATION OPTIONS 
  

Toggle Beamset Visibility 

To avoid workspace clutter the visibility of beamset graphics in the drawing can be turned on or off.  By default, 
beamset graphics are displayed.  Deselect the Toggle Beamset Visibility button to hide the beamset graphics. 

  

Use Piece Shear Velocity 

Selects the Shear velocity of the piece to be used when calculating the beam path through the piece. 

  

Use Piece Compression Velocity 

Selects the Compression velocity of the piece to be used when calculating the beam path through the piece. 

  

Crop Mode 

Identify any type point on a beam path based on   Distance,   Time or   Skips. 



Probes 

 
109 

 

 Display Beam Focus 

Defines the point at which a sound beam converges to minimum diameter and maximum sound pressure and beyond 
which the beam diverges. 

A Focus Type can be specified and used to display the beam's focus into the piece. 

1. Select the Focus Type button.  A list of Focus Types are displayed. 
2. Select the appropriate Focus Type: 

  

True Depth - True depth is the specified distance into the piece parallel to the bottom of the wedge. 

Projection - Projection is the specified distance in the piece parallel to the front of the wedge. 

Half Path - Half Path is the distance along each beam from the point where the beam enters the piece. 

None - Do not perform focusing. 

  

Display Gate 

The Gate describes an electronic means to monitor a specific segment of distance. 

  

Display Beam Near Field 

Displays the area in the sound beam immediately in front of the transducer and is calculated using the frequency and 
cross-sectional area of the transducer surface.  

  

Display Beam Spread 

Displays how the beam spreads out as it propagates through the material. 

  

Reflect Off Weld 

Beams will reflect off the weld instead of passing through. 

  

Show Elements 

Displays the elements and element usage information on the transducer. 
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Parameters 

Start Element The number of the first element in the aperture. 

Aperture Elements The number of contiguous elements in the aperture. 

Num Beams The number of beams used. 

Element Step The number of offset elements for each beam being fired. 

Min Angle The minimum beam angle. 

Max Angle The maximum beam angle. 

Focus Length The distance from the bottom of the wedge to the focus point.  Calculated based on Display 
Beam Focus selected. 

Gate Start The distance from the exit point on the bottom of the wedge to the start point of the gate. 

Gate Length The length of the gate segment. 

Min Near Field The estimated minimum distance in front of the transducer in which the beam exhibits a 
change in wave front .  (read only) 

Max Near Field The estimated maximum distance in front of the transducer in which the beam exhibits a 
change in wave front.  (read only) 

Beam Deviation The angle between beam steps.  (read only) 

dB Drop Specifies the amplitude drop method to be used. 

Min Spread The estimated minimum beam spread.  (read only) 

Max Spread The estimated maximum beam spread.  (read only) 

Used Aperture The Elements Used multiplied by the Element Pitch.  (read only) 

  

Element Utilization 

 
The Beamset Configuration dialog summarizes the element usage by displaying graphically the number of elements 
available for the selected transducer and the usage based on the aperture settings specified. 
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Beam Type 

 
A pick-list of available beam types: 

• Solid Beams - displays all of the beams in the same color. 
• Color List - displays each beam skip in the color defined in File  Options. 

  

Line Color 

 
Color(s) to be used to display the beams for both the preview and drawing panes. 

  

Beam Buffer Visibility 

 
Visibility of the beam buffer lines that indicate the bounds of the elemental area(s). 
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7.7.5.1 FULL MATRIX CAPTURE BEAMSET 

Full Matrix Capture (FMC) is a specific data-acquisition process using ultrasonic phased-array probes.  For an array 
of N elements, each element is successively used as a transmitter, while all other elements are used to receive.  

 

7.7.5.1.1.1 FULL MATRIX CAPTURE BEAMSET CONFIGURATION OPTIONS 
  

Toggle Beamset Visibility 

To avoid workspace clutter the visibility of beamset graphics in the drawing can be turned on or off.  By default, 
beamset graphics are displayed.  Deselect the Toggle Beamset Visibility button to hide the beamset graphics. 

  

Use Piece Shear Velocity 

Selects the Shear velocity of the piece to be used when calculating the beam path through the piece. 

  

Use Piece Compression Velocity 

Selects the Compression velocity of the piece to be used when calculating the beam path through the piece. 

  

Crop Mode 

Identify any type point on a beam path based on   Distance,   Time or   Skips. 

  

Reflect Off Weld 

Beams will reflect off the weld instead of passing through. 

  

Show Elements 

Displays the elements and element usage information on the transducer. 
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Show Center Beams 

Toggles the display of the reference beams that describes the center of the spread for each element. 

  

Parameters 

Tx Start Element The number of the first element in the aperture. 

Tx Aperture Size The number of contiguous elements in the aperture. 

Tx Element Step The number of offset elements for each beam being fired. 

Spread Factor A value that is applied to, and controls, the beam spread angle. 

  

Element Utilization 

 
The Beamset Configuration dialog summarizes the element usage by displaying graphically the number of elements 
available for the selected transducer and the usage based on the aperture settings specified. 

  

Beam Type 

 
A pick-list of available beam types: 

• Solid Beams - displays all of the beams in the same color. 
• Color List - displays each beam skip in the color defined in File  Options. 

  

Line Color 

 
Color(s) to be used to display the beams for both the preview and drawing panes. 

  

Beam Buffer Visibility 

 
Visibility of the beam buffer lines that indicate the bounds of the elemental area(s). 
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7.7.5.1.2 REFERENCE BEAMSET 
Reference Beamsets provide additional drawing annotaions. 

 

7.7.5.1.2.1 REFERENCE BEAMSET CONFIGURATION OPTIONS 
  

Toggle Beamset Visibility 

To avoid workspace clutter the visibility of beamset graphics in the drawing can be turned on or off.  By default, 
beamset graphics are displayed.  Deselect the Toggle Beamset Visibility button to hide the beamset graphics. 

  

Use Piece Shear Velocity 

Selects the Shear velocity of the piece to be used when calculating the beam path through the piece. 

  

Use Piece Compression Velocity 

Selects the Compression velocity of the piece to be used when calculating the beam path through the piece. 

  

Crop Mode 

Identify any type point on a beam path based on   Distance,   Time or   Skips. 

  

Display Beam Focus 

Defines the point at which a sound beam converges to minimum diameter and maximum sound pressure and beyond 
which the beam diverges. 

A Focus Type can be specified and used to display the beam's focus into the piece. 

1. Select the Focus Type button.  A list of Focus Types are displayed. 
2. Select the appropriate Focus Type: 
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True Depth - True depth is the specified distance into the piece parallel to the bottom of the wedge. 

Projection - Projection is the specified distance in the piece parallel to the front of the wedge. 

Half Path - Half Path is the distance along each beam from the point where the beam enters the piece. 

None - Do not perform focusing. 

  

Display Gate 

The Gate describes an electronic means to monitor a specific segment of distance. 

  

Display Surface Distance Dimension 

Displays the distance between the initial entry point of the first element and the exit point out of the piece from the 
refracted angle. 

  

Display V Path Distance Dimension 

Displays the total distance the beam travels through the piece from the initial entry point of the first element to the 
exit point out of the piece from the refracted angle. 

  

Display Beam Exit to Front Face 

Displays the distance from the front of the wedge to where the beam exits the wedge. 

  

Display Beam Exit to Weld 

Displays the distance from the point where the beam exits the wedge to the center of the weld. 

  

Display Pitch Catch 

Displays the path a reflected beam would take back into a wedge and the elements that could best be used to receive 
this signal. 

  

Reflect Off Weld 

Beams will reflect off the weld instead of passing through. 

  

Show Elements 

Displays the elements and element usage information on the transducer. 

  

Show Snell's Law 

Displays a visualization of Snell's Law where the beam refracts into the piece. 
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Parameters 

Start Element The number of the first element in the aperture. 

Refracted Angle The angle of the beam within the piece or part. 

Focus Length The distance from the bottom of the wedge to the focus point.  Calculated based on Display 
Beam Focus selected (see Other Tools Available below). 

Gate Start The distance from the exit point on the bottom of the wedge to the start point of the gate. 

Gate Length The length of the gate segment. 

Alpha Angle The incident angle of the beam within the wedge.  (read only) 

Line Color Color to be used to display the beam for both the preview and drawing panes. 

  

Element Utilization 

 
The Beamset Configuration dialog summarizes the element usage by displaying graphically the number of elements 
available for the selected transducer and the usage based on the aperture settings specified. 
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7.7.6 ZONAL BEAMSET 
A Zonal Beamset is used in conjunction with Weld Zones to provide targeted steering of individual beams into 
specific locations along the face of a weld bevel. 

  

NOTE:  Zonal Beamset and Weld Zones are only available to users of the BeamTool Zonal Add-On. 

  

A Zonal Beamset is a collection of Targeted Beamset beams, that are configured and manipulated through a 
list.  Beams can be added and removed from the list, either manually or through the automated Beam Solver.  Once 
added to a phased array probe, a zonal beamset can be configured using the following dialog, and related tools: 
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7.7.6.1 ZONAL BEAMSET CONFIGURATION TOOLBAR 

 

Auto 

When in Auto Solving mode, the zonal beams are automatically regenerated whenever the zones, probe or solver 
options are modified.  In this mode, beams are always kept in sync with their defining inputs.  Modifications to 
generated beams are not permitted, as any updates would be lost during the next automatic solving. 

  

Manual 

When in Manual Solving mode, the beams are not regenerated when modifications are made to zones, probe or 
solver options.  Instead, the beams can be manually regenerated by using the Solve button.  Generated beams can be 
modified through the beam parameters, because solving will not occur automatically and will not overwrite any 
edits. 

  

Zonal Solver Options  

Opens the Zonal Solver Options dialog.  Click here for more information. 

  

 Solve   

Automatically adds and configures beams for each zone in the weld bevel. 

  

 Add  

Adds a single beam.  The new beam will not be targeted at a zone.  Default parameters are used for the new beam. 

  

 Clone  

Copies the selected beam. 

  

 Delete/  Delete All 

Delete removes the selected beam and Delete All removes all of the beams from the list. 

  

Move Down 

Moves the selected beamset down one row, in the beamset list. 

  

Move Up 

Moves the selected beamset up one row, in the beamset list. 

  

Toggle Beamset Visibility 

To avoid workspace clutter the visibility of beamset graphics in the drawing can be turned on or off.  By default, 
beamset graphics are displayed.  Deselect the Toggle Beamset Visibility button to hide the beamset graphics. 
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Pitch Catch Drop Down 

PulseEcho - Transmit and receive on the same elements 

 
Pitch-CatchManual - Transmit and receive using different elements and manually steer the transmit and 
receive beams from the target to the probe. 

 
PitchCatchAuto - Transmit and receive using different elements and automatically steer the transmit beams 
from the target to the probe, with the receive beam automatically determined based on the reflection off of 
the weld bevel. 

 
  

Display Beam Spread 

Displays how the beam spreads out as it propagates through the material. 

  

Display Beam Near Field 

Displays the area in the sound beam immediately in front of the transducer and is calculated using the frequency and 
cross-sectional area of the transducer surface.  

  

Show Elements 

Displays the elements and element usage information on the transducer. 

  

Skipped 

Defines whether the beam should be skipped off of the back-wall or projected directly from the probe to the target. 

  

Use Piece Shear Velocity 

Selects the Shear velocity of the piece to be used when calculating the beam path through the piece. 
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Use Piece Compression Velocity 

Selects the Compression velocity of the piece to be used when calculating the beam path through the piece. 

  

Line Color 

 
Color(s) to be used to display the beams for both the preview and drawing panes. 

Beam Parameters 

After a beam is added to the list, it appears in the summary table on the left of the dialog.  The table summarizes the 
pertinent details that make one zonal beam differ from another.  When a beam is selected from the tab its full details 
will be displayed in the panel on the right of the dialog and its parameters can then be modified as necessary (when 
in manual mode).  The Beam Parameters is split into three sections. 

1. Transmit 
2. Receive 
3. Acquisition 

  

Transmit Parameters 

Start Element The number of the first element in the aperture. 

Aperture Elements The number of contiguous elements in the aperture. 

Inspection Angle The angle at which the beam intersects the zone face  

Refracted Angle The angle of the beam within the piece or part. 

Focus Length The distance from the bottom of the wedge to the focus point.  Calculated based on 
Display Beam Focus selected. 

Gate Offset The distance from the target to the start of the gate. 

Gate Start The distance from the exit point on the bottom of the wedge to the start point of the 
gate. 

Gate Length The length of the gate segment. 

dB Drop Specifies the amplitude drop method to be used. 

Near Field The estimated distance in front of the transducer in which the beam exhibits a change 
in wave front.  (read only) 

Used Aperture The Elements Used multiplied by the Element Pitch.  (read only) 

Beam Sweep The difference between the exit points of the first beam to the last beam.  (read only) 

Beam Spread The divergence of the sound beam as it travels through the piece.  (read only) 

Alpha Angle The incident angle of the beam within the wedge.  (read only) 
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Receive Parameters 

Start Element The first element in a group of elements assigned to receive in pitch catch 
configuration.  This is automatically configured based on the parameters of the transmitting 
beam. 

Aperture Elements The number of elements configured to receive in a pitch catch configuration.  

Inspection Angle The angle at which the beam intersects the zone face.  

Refracted Angle The angle of the beam within the piece or part. 

Focus Length The distance from the bottom of the wedge to the focus point.  Calculated based on Display 
Beam Focus selected. 

Alpha Angle The incident angle of the beam within the wedge.  (read only) 

Used Aperture The Elements Used multiplied by the Element Pitch.  (read only) 

  

Acquisition 

The Acquisition parameters are not directly utilized in BeamTool rendering, but can in downstream applications 
through export or import.  Eclipse’s TrueView girth weld scanning system, for example. 

  

Element Utilization 

 
The Beamset Configuration dialog summarizes the element usage by displaying graphically the number of elements 
available for the selected transducer and the usage based on the aperture settings specified. 

  

Beam Solver 

Using the  Solve function, beams are automatically added to the beamset list via the powerful Beam Solver 
algorithm.  The beams added by the solver will be targeted to the zones that were configured in the Weld 
Configuration dialog.  Each zone/region type defined during weld configuration is treated slightly differently by the 
solver.  The technique used to target each zone has been implemented to maximize signal strength. 

  

Using the General parameters and Instructions defined in the Zonal Solver Options dialog, the solver will create a 
beam targeted to the relevant zone.  

Zone Solving 

To solve for any given zone, BeamTool attempts to create an optimal beam using the Instructions that correspond 
to that zone type and angle. Using the instruction’s optimal inspection angle (and aperture, path, etc.), a beam is 
projected out from the zone target.  If the beam intersects the probe’s transducer, an appropriate beam path from 
probe to the zone should be possible.  If a path to the transducer cannot be found, the inspection angle is adjusted by 
Angle Increment and tested again.  The solver will increment and oscillate to either side of the optimal angle until a 
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path can be found.  If the Min Angle or Max Angle is reached, then number of Skips is increased and the process is 
repeated. 

  

If no combination of angles and skips can be found, a ‘broken’ beam at the optimal angle is added to the beams list. 

  

Because the solver starts with the optimal angle and skips then moves onto less and less optimal paths, as soon as it 
finds the first successful path it can stop, knowing it’s found its most optimal one. 

When a path has been found from the target to the transducer, the solver builds an element aperture using the 
determined refracted angle, and adds a beam to the beams list. 

Gates 

Gates are automatically applied to the solved beams.  Fusion zones and Volumetric zones are treated differently, but 
both use a new option that allows Gating Pass-Through.  Normally, gate visualization directly follows along the 
beam path, but Gating Pass-Through allows the gate visualization to pass through the weld (or other reflective 
geometry) even though the beam may be reflecting. 

Focusing 

Focusing is automatically applied to the solved beams.  “Half-path” focusing is applied directly on top of the zone 
target in all cases. 
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Display 

When configuring a zonal beamset (with the zonal beamset configuration dialog open), the individual beams are 
rendered to the main CAD surface with beam “ghosting”.  This visualization helps reduce screen noise by 
ghosting/disabling/graying-out all beams but the currently selected one.  

  

When the configuration dialog is closed, ghosting is disabled and all beams are rendered normally. 
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7.7.6.2 ZONAL SOLVER OPTIONS 

The Solver Options configure how the solver behaves and defines how each combination of zone type and angle 
should be solved.  If a zone matches multiple instructions, the solver will generate multiple beams.  When the solver 
matches a zone to an instruction, it uses that instructions parameters and the general parameters to create a beam that 
should maximize signal strength.  

Zonal Solver Options General Tab 

The Zonal Solver Options General Tab is split into three main sections. 

1. General 
2. Gating 
3. Presentations 

 
General Parameters 

Angle Increment The resolution of the angle adjustments solver.  A lower value will provide a more accurate 
solution but will increase the solver run-time. 

Target Threshold 
The maximum distance a candidate beam's intersection point can be from the zone target to 
consider the beam an acceptable solution.  A lower value will improve accuracy but may prevent 
the solver from finding solutions for some zones. 

Max Skips The maximum number of skips that the solver will attempt to use. 
  

Gating Parameters 

Fusion - Before Weld The length of the gate to be applied to fusion zone beams before the weld bevel fusion face. 
Fusion - After Weld The length of the gate to be applied to fusion zone beams after the center of the weld bevel. 
Vol. - Before Weld The length of the gate to be applied to volumetric zone beams before the weld fusion face. 

Vol. - After Weld The length of the gate to be applied to volumetric zone beams after the back of the weld 
fusion face. 
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Presentations Parameters 

The Presentations section allows you to select different types of Fills and Volumetrics.  Options include Weld Plot, 
B-Scan, Coupling and TOFD. 

  

Fills The default Presentations value to use for Fill zones  

Volumetrics The default Presentations value to use for Volumetrics zones  

  

7.7.6.2.1 ZONAL SOLVER OPTIONS INSTRUCTIONS TAB 

 

7.7.6.2.1.1 INSTRUCTIONS 
Zone Type The type of zone to attempt match  

Zone Angle From The low angle range to attempt to match  

Zone Angle To The high angle range to attempt to match  

Perpendicular Toggles perpendicular or inspection angle-specific solving  

Angle Optimal If not perpendicular, the optimal inspection angle  

Angle Min If not perpendicular, the minimum inspection angle  

Angle Max If not perpendicular, the maximum inspection angle  

Aperture The element aperture to use  

Path Type 
Direct – inspect target in OD to ID direction.   I.e.  1, 3, 5 … skips 
Skipped – inspect the target from ID to ID.  I.e.  2, 4, 6 … skips 
Skips Minimized – inspect with the fewest skips possible  

Receive Mode How the receive path should be determined (modes described elsewhere)  

Gain, Global Gain, Gate 
Threshold, Reflector Size, 
Sizing Correction  

Default values for the Acquisition parameters used in downstream 
(export/import) applications  
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7.8 CONVENTIONAL UT 

In ultrasonic testing, a transducer connected to a diagnostic machine is passed over the piece being inspected.  In 
reflection mode the transducer sends pulsed waves through a couplant on the surface of the object and receives the 
sound reflected back to the device.  Reflected ultrasound comes from an interface such as the back wall of the piece 
or from a defect.  In attenuation mode a transmitter sends ultrasound through one surface and a separate receiver 
detects the amount that has reached it on another surface after traveling through the piece.  Defects or other 
conditions in the space between the transmitter and receiver reduce the amount of sound transmitted thus indicating 
their presence. 
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7.9 TIME-OF-FLIGHT DIFFRACTION (TOFD) 

Time-of-Flight Diffraction method of ultrasonic inspection is a very sensitive and accurate method for 
nondestructive testing of welds for defects.  The use of TOFD enables weld discontinuities to be sized more 
accurately. 

  

Measuring the amplitude of reflected signal is a relatively unreliable method of sizing defects because the amplitude 
strongly depends on the orientation of the discontinuity.  Instead of amplitude, TOFD uses the time of flight of the 
diffracted ultrasonic signals from the top and bottom of the discontinuity to determine the position of a reflector. 

  

In a TOFD system, a pair of probes sits on opposite sides of a weld.  One of the probes emits an ultrasonic pulse that 
is picked up by the probe on the other side.  In undamaged material, the signals picked up by the receiver probe are 
from two waves:  one that travels along the surface and one that reflects off the backwall.  When a crack is present, 
there is a diffraction of the ultrasonic wave from the tips of the discontinuity.  Using the measured time of flight of 
the pulse, the depth of a discontinuity can be calculated automatically by simple trigonometry.  This method is even 
more reliable than radiographic testing of a weld. 

  

 



CHAPTER (8): CAD SURFACE 

The CAD Surface is a blank canvas for adding a Piece, Probes, and Geometries. 

  

To assist in the adding, editing and positioning of Probes, and Geometries, the CAD surface has a number of options 
and tools available.  Through the CAD Toolbar Tools group, options like Rulers, Grids, Crosshair, Snapping, and 
Layers can be turned on or off and configured.  Through the Main Toolbar, tools like Zooming and Positioning are 
available. 

  

Through the Main Toolbar, the CAD Surface can also be configured to display a Top View, Side View, or 3D View 
of the workspace. 

  

• Left clicking on the CAD Surface will start the geometry selection mode. 
• Right clicking on the CAD Surface will display a context menu.  If the right click is on top of a geometry 

selection, the context menu will display geometry tools and options.  If the right click is not on top of a 
geometry selection, the context menu will display CAD surface tools and options. 

• Middle clicking on the CAD Surface will temporarily activate the Pan tool.  Click and hold the middle 
mouse button, then drag the mouse around to pan the CAD Surface around the workspace. 

• Scrolling on the CAD Surface will zoom the display in and out. 
  

 



CHAPTER (9): CAD TOOLBAR 

CAD Tools for creating and manipulating custom geometries are a available through the CAD Toolbar: 

 
Through this toolbar Geometries can be Added to the workspace, Edited, Styled and Adjusted.  Other Tools are also 
available to improve the efficiency and ease of drawing. 

  

The CAD Toolbar is divided into the following groups: 

• Tools - CAD Surface configuration, access to interactive tools, and Layers 
• Snap - Quick access to the Snap settings contained in the Tools pop-up 
• Edit - Access to geometry manipulation tools 
• Add Geometry - Quick access to adding Piece and Annotative geometries 
• Style - Access to geometry styling tools 
• Construction Aids - Access to geometry positioning and sizing tools 
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9.2 TOOLS GROUP 

The CAD Tools group provides access to various drawing and CAD Surface tools. 

     

Arrow Tool The Arrow Tool allows you to select and manipulate graphics.  Once selected, a graphic 
can be moved by dragging or resized using the available handles. 

Geometry Inspector Displays the Geometry Inspector to the right of the CAD Surface.   

Command Prompt Displays the Command Prompt above the CAD Toolbar. 

Viewport Manager Opens the Viewport Manager dialog box. 

Geometry Navigator Opens the Geometry Navigator dialog box. 

  

9.2.1 INTERACTIVE TOOLS 

The   Interactive Tools pop-up provides access to the following tools: 

Interactive 
Rotate 

Activates the Interactive Rotate Tool, which provides a means of defining the center of the 
rotation point and the angle at which to rotate selected geometries. 

Interactive 
Move 

Activates the Interactive Move Tool, which provides a means of defining the direction and 
distance at which to move selected geometries. 

Trim Activates the Interactive Trim Tool, which  allows users to easily trim intersecting lines to precise 
lengths. 

  

9.2.2 DISPLAY SETTINGS 

The   Display Settings pop-up provides access to the following groups of tools: 

  

Workspace Objects 

Show Images When selected, displays images in the drawing.  

Lock Images Locks any image graphics so they cannot be moved or selected when editing 
other graphics. 

Show Annotations When Show Annotations is selected Annotation redlines are displayed in the 
drawing.  When not selected, Annotation redlines are not displayed.  Show 
Annotations does not affect the visibility of Piece geometries. 

Show Dynamic Dimensions When Show Dynamic Dimensions is selected supported Dynamic Dimensions 
are displayed in the drawing.  When not selected, supported Dynamic 
Dimensions are not displayed 
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Display Settings 

 

Show Rulers Displays a horizontal and vertical ruler around the drawing area. 

Show Ruler Markers Displays markers on the ruler relative to where the cursor is on the CAD Surface. 

Show Crosshairs Displays horizontal and vertical crosshairs on the cursor. 

Show Small Crosshairs Displays a small horizontal and vertical crosshairs on the cursor. 

Show Alignment Marker Displays an alignment marker on the handle of the selected geometry.  The marker 
corresponds to the Construction Aids Placement Grid selection. 

Command Prompt Displays the Command Prompt above the CAD Toolbar. 

  

Grid Settings 

Show Grid Toggles the visibility of the grid on and off. 

Show Grid Axis If checked, the X and Y axis are highlighted in blue. 

X, Y Specify the numerical spacing units for X and Y axis. 

  

9.2.3 SNAP SETTINGS 

The   Snap Settings pop-up provides access to the following tools: 

Snap to Points If checked, points within an annotation will snap to the nearest end point of an 
annotation, within a set tolerance. 

Snap to Mid Point If checked, points within an annotation will snap to the nearest mid point of an 
annotation, within a set tolerance. 

Snap Nearest If checked, points within an annotation will snap to the nearest point on an 
annotation within a set tolerance. 

 Snap Alignment 
If checked, points within an annotation will dynamically snap to existing 
geometry features, within a set tolerance. 

Geometric Snap Tolerance The tolerance distance to be used when snapping to an existing geometry. 

Snap to Grid If checked, points within an annotation will snap to the nearest grid intersection 
when drawn, moved or resized. 

Orthographic Snap If checked, points within an annotation are restricted to the X or Y axis relative 
to the selected start point. 

Orthographic Snap Tolerance The tolerance distance to be used when snapping to the X or Y axis. 

9.2.4 LAYERS 

The   Layers pop-up menu provides the ability to define and manipulate CAD Layers.  Geometries (both 
reflective and annotative) can be added to and moved between CAD Layers.  Individual Layers can be added or 
removed, reordered, hidden, and locked. 
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 9.2.5 CAD LAYERS 
The CAD Layers pop-up provides the ability to define multiple CAD Layers.  Geometries (both reflective and 
annotative) can be added to and moved between CAD Layers.  Individual Layers can be added or removed, 
reordered, hidden/displayed, and set as uneditable/editable. 

  

  
The row of buttons on the top of the Layers pop-up provides access to the following functions: 

Add Layer Creates a new layer. 

Delete Layer Deletes the selected layer.  All geometries on this layer will also be deleted. 

Move Layer Up Moves the selected layer's paint order up in front of other layers. 

Move Layer Down Moves the selected layer's paint order down behind other layers. 

Move Geometries Moves the selected geometries into the selected layer. 

Close Layers Pop-up Closes the Layers pop-up. 

  

Each layer is represented as a row in the pop-up window.  A layer can be renamed by double-clicking on the layer 
row.  Each layer row also provides the following functions:  

/ Visibility Toggles the visibility of the layer on the CAD surface. 

/ Locking Toggles the locking of the layer.  When locked, a layer cannot be edited. 

  

The Geometry Inspector can be used to change the view of legends created in different layers.  The example below 
has two legends that were created in separate layers.   

  

The legend on the right is selected and the Geometry Inspector field called "CalloutLayers" is set to "Current".   This 
means that only geometries in the currently selected layer are shown in the legend. 

  

The legend in the middle has the "CalloutLayers" field set to "All" and is displaying all dimensions from all layers.   
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9.2.6 VIEWPORTS 
A viewport is a region of the screen used to display a different view of the total image to be shown.  As you work 
you can split the drawing area into one or more adjacent rectangular views.  Viewports are useful for large and 
detailed drawings, and can be selected for display in reporting. 

  

The Viewport Manager can be by clicking on the icon found in the Tools section of the CAD Toolbar. 

9.2.6.1 VIEWPORT MANAGER OPTIONS 

  Add Viewport Adds a new viewport to the workspace. 

Rename Viewport Renames the selected viewport. 

Show Viewport Changes the workspace view to the selected viewport. 

/ Visibility 
Toggles available layer views on and off in the workspace for the default viewport, and 
toggles available layer views on and off in the report for all other viewports.   

/  Show In Report Determines if the viewport is included in the report or not. 

  

Click here for more information on working with viewports. 
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9.2.6.2 WORKING WITH VIEWPORTS 

A viewport provides the ability to define rectangular subset areas of the top and side views.  These can be used in 
reports and for quick navigation to areas. 

9.2.6.2.1 ADDING AND DELETING VIEWPORTS 
There is a viewport automatically created in the Viewport Manager called "Default".  This is the view of the entire 
workspace. 

  

Other Viewports can be added in one of three ways: 

1. Click on the Viewport icon found in the pop-up menu in the Add Geometry section of the CAD Toolbar. 
2. Click on the Viewport icon found in the pop-up menu in the Edit section of the CAD Toolbar. 
3. Click on the Add Viewport icon found in the Viewport Manger. 

  

Viewports can be deleted by selecting the viewport in the workspace and pressing the "Delete" key on your 
keyboard. 

  

9.2.6.2.2 LAYERS IN VIEWPORTS 
All layers created in the workspace will automatically be added to the Viewport Manager.  Viewports can be 
configured with independent layer visibility from the main workspace surface.  The Visibility icons / found in 
the Viewport Manager, toggles available layer views on and off in the workspace for the Default viewport only, 
and toggles available layer views on and off in the report for all other viewports.  This makes it possible to add 
additional context to report images that may not be necessary on the main workspace view. 
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VIEWPORTS IN REPORTS 
All viewports will show in a report as long as the Show In Report icon is turned on for each viewport in the 
Viewport Manager.  In the example below we have created two viewports but only Viewport #1 is selected to show 
in the report. 
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Below is the Viewport labeled "Weld Close-up" shown in the report. 
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9.3 EDIT TOOLS 

The Edit group on the CAD toolbar provides access to a number of geometry editing functions. 

 
   
Geometries can be added to the CAD surface from the Edit group via the  Add Geometry pop-up.  The various 
types of geometries that can be added are described in the Geometries section. 

  

Once geometries have been added to the CAD surface, they can be edited via the various editing tools available in 
the Edit group.  Selecting one or more geometries will enable the following tools in the Edit group: 

  

Delete Selected Deletes the selected graphic(s) 

Duplicate Selected Duplicates the selected graphic(s) 

Cut Deletes the current selection and places it on the clipboard. 

Copy Places the current selection on the clipboard. 

Paste Copies the current contents of the clipboard onto the workspace. 

Ordering Pop-Up - changes the stacking order of objects on a layer 

Bring to Front Brings the selection to the front of all other graphics, so that no part is hidden by 
other graphics. 

Send to Back Sends the selection behind all other graphics. 

Transform Pop-Up - transform objects by rotation or flipping. 

 Flip Vertical Flips the selection along its vertical axis. 

 Flip Horizontal Flips the selection along its horizontal axis. 

Rotate Clockwise Rotates the selection 90 degrees in a clockwise direction. 

Rotate Counter-
Clockwise 

Rotates the selection 90 degrees in a counter-clockwise direction. 

Rotate 180 Rotates the selection 180 degrees. 

Alignment Pop-Up - aligns objects horizontally or vertically relative to each other.  Objects are positioned 
relative to the first object selected. 

Left Aligns the selected geometries to the left of the first selected object.  

Center Aligns the selected geometries to the center of the first selected object.  

Right Aligns the selected geometries to the right of the first selected object.  

Top  Aligns the selected geometries to the top of the first selected object.  
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Middle  Aligns the selected geometries to the middle of the first selected object.  

Bottom Aligns the selected geometries to the bottom of the first selected object.  

Group Groups the selected graphics so that they can be treated like a single graphic. 

Un-Group Breaks a group of graphics back into individual graphics. 

  



CAD Toolbar 

 
139 

 

9.4 ADD GEOMETRY 

The Add Geometry group provides quick access to a subset of the geometry tools available through the Add 
Geometry pop-up accessible in the Edit group. 

 
The following Piece  and Annotative geometries can be added from the Add Geometry group.  Other Geometries 
must be added through the Add Geometry pop-up accessible in the Edit  group. 

  

Piece Geometries: 

Line Places a user defined line that will reflect beams projected from a probe 

Arc Places a user defined arc that will reflect beams projected from a probe. 

Circle Places a user defined circle that will reflect beams projected from a probe. 

Polygon Places a user defined polygon that will reflect beams projected from a 
probe. 

Rectangle Places a user defined rectangle that will reflect beams projected from a 
probe. 

Polyline Places a user defined polyline that will reflect beams projected from a 
probe. 

  

Annotative Geometries: 

Line Places a user defined line that will not reflect beams projected from a 
probe 

Arc Places a user defined arc that will not reflect beams projected from a 
probe. 

Dimensions Places user defined dimensions that will not reflect beams projected from 
a probe. 

Circle Places a user defined circle that will not reflect beams projected from a 
probe. 

Polygon Places a user defined polygon that will not reflect beams projected from a 
probe. 

Text Box Places a user defined text box that will not reflect beams projected from a 
probe. 

Polyline Places a user defined polyline that will not reflect beams projected from a 
probe. 

Rectangle Places a user defined rectangle that will not reflect beams projected from 
a probe. 
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9.5 STYLE 

Style tools can be accessed by selecting the appropriate tool button on the CAD toolbar Style group.  Style tools can 
also be accessed by selecting Properties from the right click menu.  These tools are only available when a Piece or 
Annotative geometry is selected. 

  

 
Below are the editing tools available: 

Line 

Line Weight Specifies the thickness of the line. 

Line Style Specifies the style (solid, dash, dotted) of the line. 

Line Color Specifies the color of the line. 

Start Cap Specifies the cap style placed at the beginning of the line. 

End Cap Specifies the cap style placed at the end of the line. 

  

Fill 

Fill Color Specifies the color and level of transparency used to fill contained geometries such as 
rectangles, ellipses and polygons. 

  

Text 

Text Color Specifies the color of the selected text. 

Text Scale Specifies the size of the selected text graphics. 
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9.6 CONSTRUCTION AIDS 

Construction Aids can be accessed through the CAD toolbar Construction Aids group.  These tools are only 
available when a Piece or Annotative geometry is selected. 

  

 
Below are the editing tools available: 

Lock Distance When selected the Lock Distance restrains the line segment being drawn to the 
distance specified. 

Lock Angle When selected the Lock Angle restrains the line segment being drawn to the angle 
specified. 

Draw Relative When selected places the next point of the geometry being drawn at a point relative 
to the last point drawn using the distance and angle specified. 

Legend ID Replaces the numerical value of the selected dimension geometry and replaces it with 
a user defined variable that will be displayed along with the numerical value in the 
Legend. 

Horizontal Displays the calculated distance of the specified start point (see Measurement Start 
Point) from 0,0 along the Y axis. 

Vertical Displays the calculated distance of the specified start point (see Measurement Start 
Point) from 0,0 along the X axis. 

Length Displays the calculated length of the selection. 

Height Displays the calculated height of the selection. 

Lock Aspect Ratio Ensures that adjustments to Length and Width are made relative to each other, so that 
geometries maintain Length to Width ratio 

Rotate 
Rotates the selection to the specified angle. 

Placement Grid 
Specifies the geometry handle to calculate measurements from.  An alignment 
marker can be displayed by selecting Show Alignment Marker in the Display 
Settings pop-up on CAD toolbar Tools group. 
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9.6.1 USING CONSTRUCTION AIDS 
The Construction Aids can be used to quickly and precisely place Piece and Annotation geometries.  When one or 
more geometries are selected, an invisible alignment rectangle is placed around the graphic(s).  This rectangle 
consists of nine geometry handles that can be used during graphic alignment.  

             

Rectangle                                                               Polyline 

  

When Show Annotation Marker is selected in the Display Settings pop-up on CAD toolbar Tools group, the 
geometry handle that is specified for use in the Construction Aids is identified with an alignment marker.  To change 
the geometry marker select one of nine geometry handles on the Placement Grid.  

  

The Construction Aids fields display measurements for From Y (red), From X (blue) as well as Horizontal and 
Vertical start to end lengths for the selected graphic. 

 
  

Values for From Y, From X and Horizontal and Vertical start to end lengths can be specified in the fields.  When 
Enter is selected the graphic is positioned using these values. 
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In the example below the rectangle that was drawn at X30,Y10 has been modified to be placed at X0,Y0 using the 
Construction Aids. 

 
Construction Aids can also be used to specify a specific length (Lock Distance) and/or angle (Lock Angle) when 
placing graphics.  Select the type of graphic that you would like to place and enter the length and/or angle and select 
Enter. 



CHAPTER (10): GEOMETRIES 

Geometries are used to provide additional information to a drawing.  There are two types of geometries in 
BeamTool:  Annotative Geometries which do not interact with projected beams and Piece Geometries which possess 
reflective and refractive properties and reflect beams projected from a probe 

  

For more information select the appropriate type below: 

 

• Piece Geometries 
• Annotative Geometries 
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The following screenshot demonstrates how geometries can be used to construct detailed workspaces: 

 

Piece Geometries are used to create the reflective outline of the bolt. 

  

Annotative Geometries are used to display a bitmap image of the 
bolt and to display dimensions. 
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10.1 PIECE GEOMETRIES 

Custom Piece Geometries allow the user to draw complex piece and weld configurations.  Types of annotation 
include lines, arcs, polylines, rectangles and polygons.  Custom Piece Geometries possess reflective properties and 
will reflect beams projected from the probe.  The reflective and refractive properties can be disabled, and at this 
point the geometry is considered to be an Annotative Geometry. 

  

Piece Geometries include: 

Line Places a user defined line that will reflect beams projected from a probe 

Arc Places a user defined arc that will reflect beams projected from a probe. 

Polyline Places a user defined polyline that will reflect beams projected from a probe. 

Circle Places a user defined circle that will reflect beams projected from a probe. 

Rectangle Places a user defined rectangle that will reflect beams projected from a probe. 

Ellipse Places a user defined ellipse that will reflect beams projected from a probe. 

Polygon Places a user defined polygon that will reflect beams projected from a probe. 

10.1.1 ADDING PIECE GEOMETRIES 
Piece Geometries can be added to a workspace from the CAD Toolbar Edit group, or through the CAD Toolbar Add 
Geometry group: 

1. Select the appropriate geometry tool from the toolbar. 
2. Place the geometry on the drawing following the placement prompts displayed in the status bar. 

  

Tools available in the CAD toolbar Tools group can be used to assist in the accurate placement of geometries: grids, 
snaps, locks, layers, etc. 

  

Once added to a workspace, geometries can be selected and then manipulated with Edit Tools, Style Tools and 
Construction Aids. 
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10.2 ANNOTATIVE GEOMETRIES 

Annotative Geometries allow annotation to be added to the drawing to indicate additional information not 
automatically displayed by BeamTool.  Types of annotation include lines, polygons, text boxes, symbols and 
dimensions.  Image annotations can be added as a backdrop.  Unlike Piece Geometries, Annotative Geometries do 
not possess reflective properties.  For some Annotative Geometries, reflective and refractive properties can be 
selected, and at this point the geometry is considered to be a Piece Geometry.  

  

Annotative Geometries include: 

Line Places a user defined line that will not reflect beams projected from a probe 

Arc Places a user defined arc that will not reflect beams projected from a probe. 

Polyline Places a user defined polyline that will not reflect beams projected from a 
probe. 

Circle Places a user defined circle that will not reflect beams projected from a probe. 

Rectangle Places a user defined rectangle that will not reflect beams projected from a 
probe. 

Ellipse Places a user defined ellipse that will not reflect beams projected from a probe. 

Polygon Places a user defined polygon that will not reflect beams projected from a 
probe. 

  

Dimensions: 

Linear Linear dimensions allow you to annotate distances on the drawing. 

Polydim Polydim dimensions allow you to annotate multi-segment distances on the 
drawing. 

Arc Arc dimensions allow you to annotate an arc distance on the drawing. 

Angle Angle dimensions allow you to annotate angles on the drawing. 

Legend The Legend is a whitespace management tool that displays a list of the 
specified dimensions annotated in the workspace. 

Viewport A viewport is a region of the screen used to display a different view of the total 
image to be shown. 

  

Text: 

Text Box Places a user defined text box that will not reflect beams projected from a 
probe. 

Call Out Places a user defined call out that will not reflect beams projected from a 
probe.  Call Outs contain a text box and an associated directional line. 

  

Misc: 

Symbol Places a user defined symbol that will not reflect beams projected from a 
probe. 

Images Allows the placement of an image on the drawing.  Beams projected from a 
probe will not be reflected. 
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10.2.1 ADDING ANNOTATIVE GEOMETRIES 
Annotative Geometries can be added to a workspace from the CAD Toolbar Edit group, or through the CAD 
Toolbar Add Geometry group: 

1. Select the appropriate geometry tool from the toolbar. 
2. Place the geometry on the drawing following the placement prompts displayed in the status bar. 

  

Tools available in the CAD toolbar Tools group can be used to assist in the accurate placement of geometries: grids, 
snaps, locks, layers, etc. 

  

Once added to a workspace, geometries can be selected and then manipulated with Edit Tools, Style Tools and 
Construction Aids. 
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10.3 SELECTING GEOMETRIES 

With the Arrow Tool active, specify the object(s) to be edited by clicking and dragging the mouse cursor over the 
CAD surface.  A selection rectangle (blue) drawn left to right will select all features totally encompassed by the 
rectangle. A selection rectangle (green) drawn right to left will select all features touching the rectangle. 

  

Left to Right selection: 

   
  

Right to Left selection: 

   
  

Holding the CTRL key while selecting geometries on the CAD surface will combine the new selections with any 
current selections.  Using this method of selection allows for the selection of a very specific subset of geometries. 
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Once selected, geometries can be: 

• repositioned, resized and rotated by adjusting the location of the visible handles 
• manipulated with Edit Tools, Style Tools and Construction Aids from the CAD toolbar 
• right-clicked to access the context menu, providing many editing tools and access to the geometry Properties 

screen (only available from the right click context menu): 
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10.4 LEGEND 

The Legend is a whitespace management tool that displays a list of the specified dimensions annotated in the 
workspace. 

  

When a dimension geometry is added to a workspace the numerical value for that dimension is displayed by 
default.  If a dimensions being displayed are small, or closely grouped together it is difficult to read. 

 
Start by assigning an ID to each dimension that will be identified in the Legend.  To assign an ID, select the 
dimension,  type an ID in the  Legend ID field and press enter.  The numerical value will be replaced with the ID 
given. 
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Once all of the dimension have been assigned Legend IDs, select the Legend tool from the Add Geometry Group, or 
type legend at the Command Prompt. 
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With all Legend IDs assigned and the Legend tool turned on, the Legend will be displayed in the workspace.   

 
  

The Geometry Inspector can be used to change the view of legends created in different layers.  The example below 
has two legends that were created in separate layers.   

  

The legend on the right is selected and the Geometry Inspector field called "LegendLayers" is set to 
"Current".   This means that only geometries in the currently selected layer are shown in the legend. 

  

The legend in the middle has the "LegendLayers" field set to "All" and is displaying all dimensions from all layers.   
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10.5  GEOMETRY INSPECTOR 

Allows advanced users to manipulate Piece and Annotation geometries at a lower level then that of the CAD Tools. 

  

The Geometry Inspector can be toggled on and off by clicking on the Geometry Inspector icon from the CAD 
Tools group, or by selecting from the Tools Menu.  The Geometry Inspector is displayed to the right of the CAD 
Surface. 
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Fields that have light text are read outs.  Fields that are read outs cannot be edited.  Click on a bold field to enter a 
new value or select from available drop-down menus and dialog boxes.   

  

When multiple geometries are selected, the Geometry Inspector will change to show the common attributes of the 
selected geometries. 
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10.6 GEOMETRY NAVIGATOR 

The Geometry Navigator allows you to visualize, highlight and select all of the geometries in a drawing. Geometries 
in the workspace are highlighted in yellow as the cursor is placed over the corresponding geometry in the Geometry 
Navigator window.  Geometries are selected in the workspace when a check mark is placed next to them in the 
Geometry Navigator.   This makes grouping, un-grouping and navigation easier than ever. 

 



CHAPTER (11): 3D VIEW 

The 3D view will display your piece, probes and beams in an interactive viewing environment.  Rotation, Panning 
and Zooming tools; Mesh, Solid and Surface modeling modes; and Perspective and Orthographic projection modes 
all provide a powerful, intuitive, highly interactive modeling tool for visualizing your techniques. 
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11.1 3D VIEW NAVIGATION 

There are different 3D views available by clicking on the quick view icons in the 3D View Toolbar.   

  

There are four navigation methods available in 3D View. 

  

1. Hold down the left mouse button and drag to move. 
2. Hold down the right mouse button and drag to rotate (vertical and horizontal rotation). 
3. Use the scroll wheel on the mouse to zoom out from cursor. 
4. Use the scroll wheel on the mouse to zoom in to cursor. 
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11.2 3D VIEW TOOLBAR 

The 3D View Toolbar provides quick and easy access to the different views available in 3D View. 

  

Display Shaded 

Displays the drawing with different shades at each surface. 

  

Display Hidden 

Displays the drawing with hidden lines.  Hidden lines represent edges and outlines that are invisible features of a 
drawing in a particular view. 

  

Display Dashed Line 

Displays the hidden lines of a drawing as dashed lines. 

  

Display 3D View 

Displays the drawing as a 3 dimensional view. 

  

Display Front View 

Displays the drawing as a front view. 

  

Display Back View 

Displays the drawing as a back view. 

  

Display Top View 

Displays the drawing as a top view. 

  

Display Bottom View 

Displays the drawing as a bottom view. 

  

Display Left View 

Displays the drawing as a left view. 

  

Display Right View 

Displays the drawing as a right view. 
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Display Grid 

Toggles the visibility of the grid on and off. 

  

Perspective View 

Displays the drawing as an approximate representation, on a flat surface (such as paper), of an image as it is seen by 
the eye. 

  

Isometric View 

Displays the drawing in a way that the angles between the projection of the x, y, and z axes are all the same. 

  



CHAPTER (12): COMMAND PROMPT 

The Command Prompt is a precision drawing tool used to quickly draw and edit geometries with specific 
dimensions.   

  

The Command Prompt can be toggled on and off by selecting  Command Prompt in the Tools Menu or in the 
Display Settings pop-up menu..   

 
When the Command Prompt is turned on, it will appear above the CAD Toolbar. 

 

12.1 EXECUTE COMMANDS 

To enter a command by using the keyboard, type the full command name on the Command Prompt and press Enter. 
The instructions in Help assume this step and do not specifically instruct you to press Enter after each entry.  You 
can specify coordinates either by entering X,Y coordinate values or by using the pointing device to click a point on 
the screen.   

  

The space in a command function is used to separate parameters.  For example the command below will draw a line 
from #0,0 to 10,0. 

Ready:  line #0,0 10,0 

  

The "<" symbol and the "@" symbol in a command function represents "at an angle of".  For example, the 
commands below will clone the selected object at a distance of 10 and at an angle of 45 degrees. 

Ready:  clone 10<45 

Ready:  clone 10@45 
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The "#" symbol in a command function represents an absolute position. 

  

Pressing the "Esc" key on the keyboard will cancel any Command Prompt functions and return the Command 
Prompt to a "Ready" status. 

12.2 SPECIFY COMMAND OPTIONS 

When you enter a command, the Command Prompt will change from "Ready" and prompt you for the next entry 
related to the command. The Status Bar will also display instructions for the next step in the command.  For 
example, when you enter circle at the Command Prompt, the following prompt and status is displayed: 

 
12.2.1 RELATIVE & ABSOLUTE 
There are three options available when entering coordinates at the prompt.  You can either enter your coordinates for 
an absolute position (example; #X,Y), coordinates relative to the current position (example: X,Y) and coordinates 
relative to the current position (example;  distance<angle).  Some commands such as Move are based on distance as 
opposed to position.  Commands based on distance can be based on either absolute or relative. 

12.2.2 PIECE GEOMETRIES & ANNOTATIVE GEOMETRIES    
The command prompt creates piece geometries by default.  In order to create annotative geometries you need to 
affix the letter "A" to the beginning of a geometry command.  For example, to create an annotative line at the 
command prompt you would type "ALINE". 

  

12.2.3 COMMAND PROMPT HELP 
Typing help or ? at the command prompt will open the help contents to the list of available commands. 
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12.3 COMMANDS 

Below is a list of available commands that can be used at the BeamTool Command Prompt to construct and modify 
geometries. 

 

12.3.1 CONSTRUCT COMMANDS 
  

ARC 

Creates a user defined arc. 

  

Command entry:  arc 

  

To create an arc, specify a start point, end point, and middle point. 

  

Ready:  arc 

Starting Point:  0,0   

End Point:  0,50   

Radius:  10   

  

CALLOUT 

Places a user defined call out that will not reflect beams projected from a probe.  Call Outs contain a text box and an 
associated directional line. 

  

Command entry:  callout 

  

To create a callout, specify the start point and end point. 

  

Ready:  callout 

Starting Point:  0,0   

Distance:  0,50  or -50@45 
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CIRCLE 

Places a user defined circle. 

  

Command entry:  circle 

  

To create a circle, specify a center point and radius. 

  

Ready:  circle 

Center Point:  0,0 

Radius: 65 

  

DIM 

Linear dimensions allow you to annotate distances on the drawing. 

  

Command entry:  dim 

  

To create a linear dimension, specify the start point and end point. 

  

Ready:  dim 

Starting Point:  0,0 

End Point:  10,0 

or 

Ready:  dim 0,0 10,0 

or 

Ready:  dim 0,0 10@45 
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ELL 

Places a user defined ellipse. 

  

Command entry:  ell 

  

Ready: ell 

Starting Point:  0,0   

End Point:  10,50 

or 

Ready:  0,0 10,50 

or 

Ready:  0,0 10@50 

 

IMAGE 

Opens the Select Image window to browse for an image to place in the workspace. 

  

Command entry:  image 

  

Ready:  image 

  

LEGEND 

Displays a legend that shows a list of the specified dimensions that are annotated in the workspace. 

  

Command entry:  legend 

  

To create a legend you must specify the starting point with your cursor. 

  

Ready:  legend 

  

  



Command Prompt 

 
166 

 

LINE 

Creates a user defined line. 

  

Command entry:  line 

  

To create a line, specify the start point and end point. 

  

Ready:  line 

Starting Point:  0,0 

End Point:  10,0 

or 

Ready:  line 0,0@10,0 

or 

Ready:  line 0,0 10@45 

  

POLYLINE (PL) 

Places a user defined polyline. 

  

Command entry:  polyline or pl 

  

To create a polyline, specify a start point and all remaining points.  Press "Enter" when polyline is drawn to exit the 
PL command function, or double click if you are selecting the points with your cursor. 

  

Ready:  pl 

Starting Point:  0,0 

Next Point: 10,0 

Next Point: 10,40 

Next Point:  62,40 

Next Point:  Press "Enter" when finished to exit. 
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POLYGON (PG) 

Creates a user defined polygon. 

  

Command entry:  polygon or pg 

  

To create a polygon, specify a start point and all remaining points.  Press "Enter" when polygon is drawn to exit the 
PG command function, or double click if you are selecting the points with your cursor. 

  

Ready:  pg 

Starting Point:  0,0 

Next Point: 10,0 

Next Point: 10,40 

Next Point:  62,40 

Next Point:  Press "Enter" when finished to exit. 

  

RECT 

Creates a user defined rectangle. 

  

Command entry:  rect 

  

To create a rectangle, specify a starting point and an end point. 

  

Ready:  rect 

Starting Point:  0,0 

End Point:  25,0 or 45@30 

  

SYMBOL 

Place a symbol on the workspace. 

  

Command entry:  symbol 

  

Ready:  symbol 

Starting Point:  0,0 

Ending Point:  10,0 
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VIEWPORT 

Creates a user defined viewport. 

  

Command entry:  viewport 

  

Ready:  viewport 

Starting Point:  0,10 

End Point:  40,-30 

or 

Ready:  viewport 0,10 40,-30 

or 

Ready:  line 0,10 40@-30 

  

  

12.3.2 MODIFY COMMANDS 
  

CLONE 

Creates a clone of the selected geometries. 

  

Command entry:  clone 

  

Ready:  clone 0,20 

or 

Ready:  clone 20@45 

  

COPY 

Creates a copy of the selected geometries. 

  

Command entry:  copy 

  

Ready:  copy 0,20 

or 

Ready:  copy 20@45 
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CUT 

Removes the selected geometries from the workspace. 

  

Command entry:  cut 

  

Ready:  cut 

  

DELETE 

Deletes the selected geometries. 

  

Command entry:  delete 

  

Ready:  delete 

  

EXTRUDE 

Changes the extrude depth on the selected geometries. 

  

Command entry:  extrude 

  

Ready:  extrude 

  

MOVE 

Provides a means of defining the absolute position at which to move selected geometries. 

  

Command entry:  move 

  

Ready:  move #0,0 

  

NUDGE 

Nudges the selected geometries. 

  

Command entry:  nudge 

  

Ready:  nudge 0,20 

or 

Ready:  nudge 20@45 
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PASTE 

Pastes the content previously Cut or Copied. 

  

Command entry:  paste 

  

Ready:  paste 

  

REDO 

Reverses the undo command or advances the buffer to a more current state. 

  

Command entry:  redo 

  

Ready:  redo 

  

ROTATE 

Rotates the selected geometries at the specified angle. 

  

Command entry:  rotate 

  

Ready:  rotate 10 

  

SCALE (SC) 

Increase or decreases the size of the selected geometries. 

  

Command entry:  scale or sc 

  

Ready:  sc 2 (scales the selected geometry to twice its original size) 

  

SELECTALL 

Selects all of the geometries in the workspace. 

  

Command entry:  selectall 
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UNDO 

Erases the last change done to the workspace. 

  

Command entry:  undo 

  

Ready:  undo 

  

Ready:  selectall 

   



CHAPTER (13): INDICATION TABLE 

The Indication Table is used to manage indications that are visualized on the workspace.  The amplitude of defects 
is visualized through a colored palettizer. 

 
  

It can be opened by clicking on the   Indication Table icon found on the Main Toolbar. 

13.1 INDICATION TABLE OPTIONS 

Open Opens a previously saved Eclipse Beam Indication file (*.ebi). 

Save Saves the currently selected indication to a Eclipse Beam Indication file (*.ebi) 

Add Indication 
Adds a new indication to the Indication Table and displays it on the 
workspace.  Click here for more information on working with indications. 

Remove Indication 
Removes an indication from the Indication Table and removes it from the 
workspace.  Click here for more information on working with indications. 

Display Indications Toggles the visibility of the indications in the workspace. 

Display Position Dimensions 
Toggles the position dimensioning from the weld center line and the top of the 
piece. 

Display Size Dimensions Toggles the size dimensions (X,Y)  for the indications.   

Display ID Annotations Toggles the ID Annotation to identify the indications in the workspace. 

Add Drawing Set 

Brings up the Drawing Properties dialog box where you can name and describe 
a drawing you want to add.  After the drawing properties have been defined, 
the selected drawing will be available from the Active Drawing drop-down 
menu found on the Main Toolbar.  See Drawings for more information on 
working with Drawings. 

Columns 
Opens the Indication Columns picker used to select the indication attributes 
available for edit. 
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13.2 HOW TO ADD & REMOVE INDICATIONS 

To add an indication to your workspace you must first open the Indication Table by clicking on the   Indication 
Table icon found on the Main Toolbar. 

 
  

Click on the  Add Indication icon to display a new set of fields. 

  

As you enter the values for your indication you will see a visual representation of the indication in the workspace. 

 

To remove an indication from your workspace you must first open the Indication Table by clicking on the   
Indication Table icon found on the Main Toolbar.   

  

Highlight any field of the indication you wish to remove and click on the  Remove Indication icon.  The 
indication will no longer be visualized in the workspace. 
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Click on the Columns icon to open the Indication Columns dialog box.  The Indications Column dialog box is used 
to select the Indication attributes made available to edit in the Indication Table. 

 
  

Place a check mark in the "Show" section for the Indication attribute to show up in the Indication Table. 



CHAPTER (14): REFERENCE 

14.1 REFERENCE 

With BeamTool's intuitive user interface it's easy to be productive immediately after installation without spending a 
lot of time learning how to use it.  Super Tooltips ensure that an explanation of each tool's function is readily 
available without having to consult the online help.  Visual picklists provide you with a preview of what a command 
does before it is executed.  
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14.2 PRINT DRAWINGS 

The Print Drawings dialog box allows the user to control the print output based on the available drawingsets in their 
workspace.  Click on Print from the File Menu to bring up the Print Drawings dialog box. 

 
14.2.1 PRINT DRAWINGS MAIN TOOLBAR 
The Print Drawing main toolbar allows you to navigate through the available drawings and setup your page and 
printer options.  

 
  

Print 

Opens the print dialog box where you can select your available printer and execute the print job. 

  

Page Setup 

Allows the user to setup the page properties when printing a workspace. 

  

First Page 

Moves to the first drawing. 
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Previous Page 

Moves to the previous drawing. 

  

  Next Page 

Moves to the next drawing. 

  

Last Page 

Moves to the last drawing. 

  

Close 

Closes the Print Drawings dialog box. 

  

14.2.2 PRINT DRAWINGS PANEL TOOLBAR 
The Print Drawing panel toolbar allows you to select the drawings, and drawing views you want to print. 

 
  

Print Drawing 

Toggles on and off the selection of the drawing to be sent to the printer. 

  

Visualize Probe  

Toggles on and off the view of the Probe in the drawing to be printed. 

  

Print Side View 

Toggles on and off the side view for the drawing to be printed. 

  

Print Top View 

Toggles on and off the side view for the drawing to be printed. 

  

14.2.3 PRINT DRAWINGS FOOTER 
The print drawings footer included on each print drawing page.  This information and logo is populated based on the 
values entered by the user in Document Info.   
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14.3 MANAGING WORKSPACES 

Below are the tools used to manage a workspace.  They can be found under the File menu as well as on the main 
toolbar. 

  

Create a New Workspace 

To create a new workspace:  
1. Press the Save Workspace button to save the currently displayed workspace. 
2. Press the New Workspace button located on the main toolbar.  A new workspace is created with default 

settings. 
  

Open an Existing Workspace 

To open an existing workspace:  
1. Press the Open Workspace button located on the main toolbar and navigate to the BeamTool directory 

(default location) containing the workspace file (*.ebwk) to be opened. 
2. Select the file and press Open.  The workspace data will now be displayed in the Piece and Probe(s) 

configurations and the drawing pane will update to display the graphics. 
  

Save a Workspace 

Once a workspace configuration is complete it can be saved (*.ebwk): 

1. Press the Save Workspace button and navigate to the BeamTool directory (default location). 
2. Enter a name for the file in the File name field and press Save.  If the workspace has been previously saved 

it will be automatically resaved using the path and filename specified during the initial save. 
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14.4 IMPORTING DRAWINGS 

DWG, DXF and KXL files created in AutoCAD as well as Probe configurations and custom geometries previously 
created in BeamTool can be imported. 

  

Import AutoDesk (DWG & DXF) Files 

To import a DWG or DXF file: 

1. Select Custom from the Piece type picklist. 
2. Select  Import  Autodesk from the File menu and navigate to the location of your file.  Select Open. 
3. Select millimeters (mm) or inches (in) for the DXF Base Units.  Select Import.  The DWG or DXF 

graphics are displayed in the workspace. 
Note:  Graphics are imported as a group.  The Un-group command on the Edit toolbar can be used to ungroup the 
graphics allowing them to be manipulated individually. 

  

Import KXL Files 

To import a KXL file: 

1. Select Custom from the Piece type picklist. 
2. Select  Import  KXL from the File menu and navigate to the location of your file.  Select Open. 
3. If solid lines are to be reflective check Make solid style lines reflective.  Select Import.  The KXL graphics 

are displayed in the workspace. 
  

Import Probe Files 

To import a Probe file: 

1. Select  Import  Probe from the File menu and navigate to the location of your file.  Select Open. 
  

Import Geometry Files 

To import a Geometry file: 

1. Select  Import  Geometry from the File menu and navigate to the location of your file.  Select Open. 
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14.5 INSTRUMENT INFO 

The Instrument Info dialog is accessible by the Instrument Info button on the Main Toolbar. 

Through this dialog, information about the acquisition Instrument can be entered.  Various fields can be populated 
by hand, or can be loaded from a pre-populated catalog of instruments.  Once populated, the Instrument Info field 
values will be displayed on various Reports.  Additional Instrument Info field values can be used by the Report 
Template Editor to include this information on a custom report. 
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Use the Catalog button to open the Import Instrument dialog.  Through this dialog, pre-populated instruments 
can be filtered, sorted, and selected for use.  Values imported from the catalog can be overwritten in the Instrument 
Info dialog if necessary. 
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14.6 DOCUMENT INFO 

The Document Info dialog is accessible by the Document Info button on the Main Toolbar. 

Through this dialog, various details about the Document, Workspace, Approval process, Instrument, 
Calibration, Scanner and Technique Details can be entered.  Once populated, the Document Info field values will 
be displayed on various Reports and Print Drawings.  Additional Document Info field values can be used by the 
Report Template Editor to include this information on a custom report. 
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The Default Logo specified in the Options dialog can be overridden here in the Document Info. 
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CHAPTER (15): XMLOCALIZE 

The XMLocalize editor is used to add missing translation and or correct translation inaccuracies in 
BeamTool.  Modifications to this file can be submitted to the BeamTool support team for inclusion in a future 
release of BeamTool. 
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15.1 XMLOCALIZE VIEWS, LAYOUT, MENUS & TOOLBAR 

The XMLocalize has two different views.  You can toggle between Tree View and Table View by clicking on their 
respective icons in the XMLocalize Toolbar. 

15.1.1 TREE VIEW 
The XMLocalize Tree View layout is divided into six major sections. 

1. XMLocalize Main Menu - access to XMLocalize File Menu and Tools Menu 
2. XMLocalize Tree View Tool Bar - a toolbar use for localization management 
3. Tree View - tree view of current strings available for modification 
4. String Fields - displays the current translations of available languages for the selected string 
5. Find View - used to search for strings based on text entered 
6. Status Bar - provides XMLocalize status updates 
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15.1.2 TABLE VIEW 
The XMLocalize Table View layout is divided into six major sections. 

1. XMLocalize Main Menu - access to XMLocalize File Menu and Tools Menu 
2. XMLocalize Table View Tool Bar - a toolbar use for localization management 
3. TableView - table view of all strings available, the default language for the string, and string value for the 

selected language 
4. Find View - used to search for strings based on text entered 
5. Status Bar - provides XMLocalize status updates 
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15.1.3 XMLOCALIZE FILE MENU 
There are a number of options located under the XMLocalize File menu . 

 
  

Open 

Allows the user to open a previously saved *.xmloc file in Windows Explorer 

  

Recent 

Displays a list of recent *.xmloc files used in XMLocalize 

  

Save 

Allows the user to save the current *.xmloc file 

  

Save as 

Allows the user to save the current *.xmloc file.  Displays the Save *.xmloc file dialog every time, allowing the user 
to specify a new  filename or overwrite the existing filename 

  

Submit Changes 

Automatically generates an Email with the *.xmloc file attached.  The Email can be sent to 
BeamTool@eclipsescientific.com to be included in a future release of BeamTool 

  

Options 

Opens the XMLocalize Options dialog box 

  

Exit 

Exits the XMLocalize editor 
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15.1.4 XMLOCALIZE TOOL MENU 
These are the tools that can be found under the Tools menu. 

  

Batch Translate Locale 

Translates all strings for the selected language using Google Translate 

  

Translate Missing Strings 

Translate all missing strings for the selected language using Google Translate 
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15.1.5 XMLOCALIZE TOOLBAR 
The toolbar provides quick and easy access to some common localization management tools. 

  

Table View Toolbar 

 
  

Tree View Toolbar 

 
  

15.1.5.1 TOOLBAR OPTIONS 

  

Open 

Opens a previously saved localization file 

  

Save 

Allows the user to save the current *.xmloc file 

  

Change Language 

Change the language 

  

Filter Missing/All 

Changes the Table View to show all strings available for the selected language or just the missing strings for the 
selected language 

  

Add String 

Adds a new string to the selected node in the XMLocalize Tree View 

  

Add Group 

Adds a new group used to logically store multiple strings 

  

Delete 

Deletes the selected string, and or group of strings 

  

Find 

Toggles on and off the Find View.  The Find View is used to search for strings that contain text entered by the user 
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 Replace 

Opens the Replace dialog box, used to find and replace text 

  

Copy LString 

Used by developers to copy new strings created with XMLocalize into code 

  

Translate 

Uses Google Translate to populate empty fields for all languages (Tree View), or selected language (Table View) of 
the selected string.  This will not overwrite an existing entry for a language. 

  

Table View 

Toggles on and off the XMLocalize Table View 

  

Tree View 

Toggles on and off the XMLocalize Tree View 
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15.1.6 HOW TO TRANSLATE IN TABLE VIEW 
To translate in Table View, you must first select the language you want to translate to.  Click on the Language 
Picker icon to select your language of choice.   

 

Use the Filter icon  to show All strings available for your selected language, or just the Missing strings. 

  

You can use the  Find icon to search for specific text in a string.  In the example below we have performed a Find 
function for all strings that contain the word "wedge".  By selecting string 1033 from the Find results at the bottom, 
the Table View automatically navigates to the selected string for editing. 
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To Translate a single string value, simply click on the empty language field next to the string. 

 

Type in your text and press <Enter>.  Click on the Save icon  to finish. 

 

Click on the Translate icon  to automatically translate the selected string using Google Translate.  This can be 
useful when translating strings with large amounts of text. 
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15.1.7 HOW TO TRANSLATE IN TREE VIEW 
To translate in Tree View you can navigate the Tree View to expand and collapse groups of strings. 

  

You can use the  Find icon to search for specific text in a string.  In the example below we have performed a Find 
function for all strings that contain the word "wedge".  By selecting string 1033 from the Find results at the bottom, 
the Table View automatically navigates to the selected string for editing. 

 
To Translate a single string, navigate to the string in the Tree View, and click in the empty field below your 
language of choice. 
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Type in your text and press <Enter>.  Click on the Save icon  to finish. 

 

Clicking on either of the Translate icons  (highlighted above) when your cursor is in an empty language field will 
automatically translate the selected string using Google Translate.  This can be useful when translating strings with 
large amounts of text. 

  



CHAPTER (16): EXTRACTING DATA 

16.1 EXTRACTING DATA 

There are a number of ways to extract the data from BeamTool to be used in other applications.  The Copy to 
Clipboard button copies the drawing to the clipboard in either bitmap or metafile format.  Drawings can also be 
exported as either BMPs, JPEGs, PNGs or GIFs.  The reporting option in BeamTool allows the user to create 
comprehensive reports that are easily incorporated into a document.   
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16.2 EXPORTING DRAWINGS 

Drawings created in BeamTool can be exported to a number of file formats. 

Export Image 

Once a workspace configuration is complete it can be exported to one of the following formats:  *.bmp, *.jpg, *.png, 
*.gif, *.wmf, *.emf, *.tdsx, *.icex, *.dwg or *.dxf. 

1. Select  Export  Image from the File menu and navigate to the location to store your file. 
2. Enter a name for the file in the File name field. 
3. Select the appropriate file format from the Save as type list and press Save. 
4. Select a size for the exported drawing and press Export. 

 

Export Drawing Options - BMP, JPG, PNG, GIF, WMF or EMF 

When exporting a drawing to any of the supported formats (excluding DXF) the size of the drawing can be specified 
using the Export Drawing window. 

1. Select the appropriate size of the exported drawing using the picklist and press Export. 
 

Exporting Drawing Options - DWG 

When exporting a DXG drawing the user is presented with a number of options. 

 

Items to Export 

Piece Geometry Exports the graphics associated to the piece and weld. 
Annotations Exports the graphics associated to the redline annotations. 
Probes Exports the graphics associated to the probe including wedge, transducer and beams. 
  

Please note that the export DXF does not support the export of text, dimensions, bitmaps and symbols. 
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16.3 REPORTING 

BeamTool provides HTML standards based reporting which allows reports to be generated and shared across the 
web or email.  Report contents can be copied into other applications and edited for final presentation.  Advanced 
users can create and save custom report templates using standard HTML editors. 

16.3.1.1 CREATING A REPORT 

Reports can be instantly generated using the default templates included with BeamTool. 

1. Follow the steps for Creating a Typical Technique. 
2. Select the Report button from the main toolbar or from the File menu.  
3. Select a default template from the list.  A summary report is automatically generated including drawings 

and attribution. 
4. Report can be saved to file or sent to a printer. 
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16.4 REPORT TEMPLATE EDITOR 

BeamTool provides HTML standards based reporting which allows reports to be generated and shared across the 
web or email.  Report templates can be edited using the built in Report Template Editor. 

16.4.1 EDITING A REPORT TEMPLATE 
To edit a report template: 

1. Press the Report button on the main toolbar or select from the File menu. 
2. Once a report has been displayed select the report template to be modified from the template list. 
3. Press the Edit Template button to display the Report Template Editor. 
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16.4.1.1 GETTING STARTED WITH THE REPORT TEMPLATE EDITOR 

 
1    Report Sections Pane 

2    Editor Toolbar (available in Design mode only) 

3    Report Work Area (available in Design and Code modes only) and Preview 

4    Available Fields Pane 
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16.4.1.2 EXAMPLE OF EDITING A REPORT TEMPLATE 

Once the Report Template Editor is displayed you can customize an existing report template by doing the following: 

1. In Design Mode, select a section from the Report Section pane.  Report Sections include Header, Piece, 
Probe, Beam and Footer sections.  The predefined section is displayed in the Report Work Area. 

2. Modify the existing report fieldname captions or type new ones in the Report Work Area. 
3. Select the appropriate field(s) from the Available Fields pane and drag and drop beside the fieldname 

captions. 
4. Use the Editor Toolbar to specify font, size, color, etc. 
5. Select the Preview tab to display the report with the additions and modifications made plus the existing 

workspace values. 
6. Press the Save button to overwrite the existing report template or save as a new template file. 

16.4.1.3 CREATING A NEW REPORT TEMPLATE 

A new report template can be created without using an existing preformatted report template.  To create a new report 
template: 

1. Display the Report Template Editor and press the New button. 
2. Select a section from the Report Section pane. 
3. All of the Available Fields are listed (with fieldname captions) in the Report Work Area. 
4. Edit and Save the new report template using the steps available in the above Example. 

 

16.4.1.4 USING CODE MODE 

Users familiar with HTML code can select the Code tab to display and modify the report template in HTML format. 



CHAPTER (17): ADD-ON MODULES 

BeamTool supports the ability to license and activate separate add-on modules that provide additional functionality 
that goes beyond typical technique development.  Add-on modules are viewed through the Add-on Manager, 
accessible through the Tools Menu. 

 
17.1.1 ADD-ON MANAGER OPTIONS 

Refresh Refreshes the Add-on Manager dialog box and activates any recently activated modules 

Add Feature Key 
Opens the Add Feature Key dialog box (Used to activate modules for SoftLock users 
without an active Internet connection) 

Support Opens the Support dialog box with contact information for purchasing add-on modules. 

Close Exits the Add-on Manager 

Help Opens the relevant Help content for the Add-on Manager 
* The HASP# (HardLock)or SERIAL# (SoftLock) displayed at the bottom of the Add-on Manager is the number 
tied to your copy of BeamTool.  Click on the number to copy it to the clipboard. 
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17.1.2 CURRENT MODULES 
The BeamTool Add-on module catalog currently consists of:  

  

BeamTool ZONAL 

The BeamTool ZONAL Add-on is a zonal discrimination package that provides the ability to define weld bevel 
Zones, which are used in conjunction with a Zonal Beamset and the Beam Solver to provide targeted steering of 
individual beams into individual locations along the face of a weld bevel. 

  

BeamTool A-Scan 

The A-Scan Add-on allows you to view a simulated A-scan representation of a phased-array single beamset or 
traditional UT probe configuration. The A-scan data is refreshed live as changes are made to the workspace and 
probe configuration. 

  

BeamTool High Temperature 

The HighTemp Add-on provides tools for simulation of inspecting high temperature subjects, including calculation 
of beam deflection due to temperature gradations effect on material velocity within the wedge.   
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17.1.3 HOW TO ACTIVATE AN ADD-ON MODULE 
Add-on modules activated on your copy of BeamTool can be viewed through the Add-on Manager, accessible 
through the Tools Menu.  The color red next to a module indicates that you are not licensed for the module.  The 
color green next to a module indicates you are licensed for the module. 

 

To activate a module you are not currently licensed for, click on the  Support icon to display the Support dialog 
box. 

 
The Support dialog box contains two links: 

1. The email link will generate a new email (addressed to beamtool@eclipsescientific.com) using your default email 
client.  Copy and paste your HASP# (HardLock) or SERIAL# (SoftLock) from the bottom of the Add-on Manger into 
the body of the email, and indicate which feature you would like to activate.  BeamTool support will provide you with 
a quote.  Once payment has been confirmed you will receive an email with a HASP Upgrade file (HardLock users 
only) or a Feature Key (SoftLock users only).   

2. The website link will take you to the software tab of Eclipse Scientific's website.  Click on the "Purchase" button to be 
taken to a secure site where you can purchase specific modules via Pay Pal.  Once payment has been confirmed you 
will receive an email with a HASP Upgrade file (HardLock users only) or a Feature Key (SoftLock users only).   
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HardLock users activate a new module by plugging in their HASP Dongle (USB Key) and executing the upgrade 
file sent from BeamTool support.  If the upgrade is successful a green icon will show next to the newly activated 
icon.  Click on  Refresh if the icon is still red after applying the upgrade. 

  

SoftLock users that have an active internet connection are automatically activated once they receive the new Feature 
Key email from BeamTool support.  Click on the  Refresh if the icon is still red after receiving the new Feature 
Key email.   

  

SoftLock users that do not have an active Internet connection, or are blocked by a firewall can click on the   Add 
Feature key and enter the Feature Key provided by BeamTool Support to activate a module.  Click on   Refresh if 
the icon is still red after adding the Feature Key. 
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17.2 BEAMTOOL ZONAL 

BeamTool ZONAL is an Add-on module that extends the capabilities of the already powerful BeamTool ray tracing 
and technique simulation application. 
 
The BeamTool ZONAL Add-on provides the ability to define Weld Zones, which are used in conjunction with a 
Zonal Beamset to provide automated targeting of individual phased array beams into specific locations along the 
face of a weld bevel. 
 
With the ZONAL add-on activated, the Weld Configuration dialog allows access to the Weld Zones functionality: 

 
  

Weld Zones are constructed from the Weld Regions defined during the weld configuration.  As a weld bevel is 
configured, Weld Regions are automatically divided into Weld Zones using the related zone configuration 
parameters. 
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The BeamTool ZONAL Add-on also provides access to the new Zonal Beamset.  With Weld Zones configured, a 
Phased Array Zonal Beamset can use the powerful new Beam Solver to automatically create individual beams that 
specifically target each zone.  The Beam Solver will determine the appropriate beam parameters (refracted angle, 
gating, focusing, etc.) to maximize signal response for each zone, all with the click of single button.  
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17.3 BEAMTOOL A-SCAN 

The A-Scan Display allows you to view a simulated A-scan representation of a phased-array single beamset or 
traditional UT probe configuration. The data is refreshed live as changes are made to the workspace and probe 
configuration. This functionality is ideal for learning and teaching. It does not have the accuracy that intense sound 
field processing would provide but it is far more performant and allows visualization of a live A-Scan while moving 
the probes on the piece geometry. 

The display is meant to look as it would on a generic instrument and controls are provided that allow the 
configuration of common A-scan parameters. It makes a great instructional tool because it can also be controlled in 
ways that cannot be done on an instrument. 

 
Reflections are detected using an array of normally invisible beams. The beams are parallel when first entering the 
piece then reflect/refract normally. This parallel ‘spread’ still simulates a wave front or beam spread to cover a wider 
area than a single line.  Any beams returning to the transducer are processed as reflections. Reflection/transmission 
coefficients are calculated based on angle of reflection/refraction, material densities, material velocities, and wave 
mode. A simple but configurable material attenuation is also applied to the reflections by default. 
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The A-Scan dialog box can be accessed  by clicking on the A-Scan icon  in the UT Probe Configuration and the 
Phased Array Single Beam Beamset Configuration menu only.    

 

Note:  Detecting reflections requires that the probe or beamset is configured with enough beam skips  to allow 
the beams to return to the transducer.   

Note:  In order to make sure a signal is coming back to the probe it is possible to use the Pitch/Catch  option for 
the probe or beamset that will display in yellow any signal coming back into the wedge. 

  

17.3.1 A-SCAN OPTIONS 
Options specific to A-Scan are described below.  To specify a value you can a) move the slider right or left, b)  click 
the right or left value spinner or c) click on the value displayed in the value spinner and type a value.  The chart will 
update on the fly as the values are modified. 

17.3.1.1 DISPLAY OPTIONS 

Controls the data that is displayed in the chart.   
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17.3.1.2 DISPLAY MODE 

Changing the Display mode will automatically update the chart and the beamset. 

Shear Wave 

 

 

Compression Wave  
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Combined  

 

 

Initial Pulse  

 

This option displays the initial pulse (main 
bang).  Parameters to modify the initial pulse 
shape are described under Pulser Options 
below. 
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Attenuation Curve  

 

This option displays the attenuation through 
distance in the material curve.   

  

17.3.1.3 WAVE MODE VELOCITIES  

These buttons control the velocity that is used to calculate distances. They are only required when the X (time) axis 
is displayed in distance units and also when both shear and compression reflections are displayed (Combined mode). 
They are only enabled in that case. As with any instrument, if the shear velocity is selected then any compression 
reflections will be inaccurate and vice versa. 

  

Show Grid 

Options to show the horizontal line and labels, vertical lines and labels or both. 
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Time Axis 

The units that are displayed on the X axis. Either time (in microseconds) or distance (in millimeters) can be 
displayed. 

  

  

Time Distance 

  

Gain 

dB gain for the signal. Increasing or decreasing this value modifies the amplitude of the entire signal. 

  

Zero Offset 

The time interval, in microseconds, that is subtracted from the start of the A-Scan. This value can be increased to 
remove the initial wave or time representing path through a wedge. 

  

17.3.1.4 PULSER OPTIONS 

  

Pulse Width 

The width of the initial pulse in nanoseconds. The pulse width value is set to a default value based on the frequency 
of the probe. 

  

Rings 

The number of rings in the initial pulse 
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17.3.1.5 SIMULATION PARAMETERS 

The Simulation Parameters menu is hidden by default but can be expanded by clicking on the group button on the 
panel title bar. 
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Spread Density 

The number of beams that are used to simulate a wave and detect reflections. A larger value will usually be more 
accurate but will be less performant. 

 

 

A spread density of 10 A spread density of 100 
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Spread Width 

The width of the spread of beams. A smaller value will produce a narrow, dense array of beams. A larger value will 
produce a wider, sparse array of beams. Using a wider beam will cover a larger area but will potentially involve 
more scatter. 

 

 

A minimum spread width of 1 mm A maximum spread value of 10 mm 

  

  

Show Spread 

The visibility of the beams used for the A-Scan. This will toggle the visibility of the beams that are used to produce 
the A-scan. The beams are displayed in fuchsia to distinguish them from the actual beam and beam-spread beams. 
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Shape Spread 

Shaping of the reflections by adjusting the amplitudes across the spread using a logarithmic curve. This can produce 
a more natural-looking reflection but can potentially produce unexpected results in cases of multiple reflections. It 
can also produce strange results depending on which part of the spread detected the reflection. 

  

A default, unshaped reflection A shaped reflection 

  

Attenuation 

Applies a material attenuation factor to reflections. The amplitude is adjusted based on the attenuation curve visible 
from the 'Attenuation Curve' display mode.  A logarithmic curve is used to calculate the factor. 

  

Percent 

The material attenuation factor at the time line maximum. This is the percent of maximum amplitude at the time line 
maximum. A larger value decreases the material attenuation applied to reflections. 
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Noise 

The level of noise in the signal. This can be reduced to 0 to provide a clearer signal or can be increased to provide a 
more realistic-looking signal. The noise is affected by gain. 

17.3.2 CHART OPTIONS 

17.3.2.1.1 NAVIGATING THE A-SCAN CHART 
The slider control at the bottom of the A-scan chart allows panning and zooming through the X (time) axis. This 
provides an easy way to find and view any area of the time line. 

 
Right click on the slider control to and select Fit Signal to automatically fit the chart to the signal. 

 

The handles on the ends of the control  can be dragged back and forth to zoom in and out. The bar itself can be 
dragged back and forth  to scroll through the time line. 

Double-clicking the bar will zoom out to max. 

The chart X-axis (time) automatically adjusts intervals to maintain an even grid. 

 
 

Zoomed out to maximum time line (80 µs) 

With 10 µs intervals 
Zoomed in to the reflection (0.5 µs range) with 0.1 µs 
intervals 
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17.3.3 A-SCAN LESSON 
In this lesson we will demonstrate the A-Scan Add-on functionality in BeamTool.  In order to proceed with this 
lesson you must have purchased the A-Scan Add-on module  Please refer to the Add-Ons section to learn how to 
purchase A-Scan. 

  

Now that you have your A-Scan license activated let's put it to work. 

  

For this lesson we will start out with the default Plate Piece geometry.  Use the Piece Polyline drawing tool to 
add some defects in the weld. 

 
  

Add a Conventional UT Probe to the worksapce. 
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Open the UT Probe Configuration menu by clicking on the Probe Config icon found in the UT Probe 
menu.  Turn off the Show Beam Spread by clicking on the  Show Beam Spread icon.  Detecting reflections 
requires that the probe/beamset is configured with enough beam skips to allow the beams to return to the 
transducer.  Change the number of beam skips to 4 by clicking on the   Beam Skips icon. 
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Click on the  A-Scan icon to open the A-Scan dialog box.   
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Use the slider control at the 
bottom of the A-Scan chart to find and view the area of the time line where the signal  occurs.  The handles on the 
ends of the control  can be dragged back and forth to zoom in and out. The bar itself can be dragged back and 
forth  to scroll through the time line. 

  

 

 
Use the display mode to visualize different scan data that is displayed in the chart.  Changing the Display mode will 
automatically update the A-scan view and the Beamset.  
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17.4 BEAMTOOL HIGHTEMP 

The HighTemp module provides tools for simulation of inspecting high temperature subjects, including calculation 
of beam deflection due to temperature gradations effect on material velocity within the wedge.   

  

These changes can be applied in BeamTool and new refracted angles and ray paths can be shown to the user as the 
actual ray path and refracted angles which will result as the effect of temperature gradient. 

 

The High Temperature Wedge dialog box can be accessed by clicking on the arrow beside the High Temp icon   
in the Wedge section of the Phased Array Probe Configuration menu only.    

 
  

HighTemp Beam Path 

Toggles on and off the view for the corrected HighTemp beam path in the workspace.  When turned on, the original 
beam path is greyed out and the Corrected HighTemp beam path is bolded. 
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Import HighTemp Wedge 

Wedge data can be imported into BeamTool from an available catalog.  To import: 

1. Press the Import Wedge button to display a list of available wedge configurations. 
2. Select the wedge record to be used and press Import.  The wedge data is now displayed in the Probe 

Configuration dialog. 

  

Visualize HighTemp 

 Used to open the High Temperature Wedge dialog box after a HighTemp Wedge has been imported. 

17.4.1 HIGH TEMPERATURE WEDGE TOOLBAR 
The HighTemp Wedge Toolbar provides quick and easy access to some common HighTemp management tools 
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Calculate Correction 

Calculates the beam path correction factors for all of the probes beamsets. 
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Single Element 

Render a single element at the angle specified. 
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Transducer Bonds 

Render beams at the first and last element and from the center of the array at the angle specified. 
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All Elements 

Render a beam for each element in the array at the angle specified. 
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Probe Beamsets 

Render a beam path for each of the probes beamsets. 

 
  

Add Drawingset 

Brings up the Drawing Properties dialog box where you can name and describe a drawing you want to add.  After 
the drawing properties have been defined, the selected drawing will be available from the Active Drawing drop-
down menu found on the Main Toolbar.  See Drawings for more information on working with Drawings. 

Pan Drawing 

Puts the cursor in panning mode allowing the user to pan around the drawing.  You can also pan by holding down 
the scroll wheel and dragging and dropping using the mouse 

Zoom Fit 

Fits and centers the drawing in the current displayable drawing area (workspace). (Ctrl+F)  
Zoom Window 

Specify an area in the drawing to be zoomed into by holding down the left mouse button and dragging the mouse to 
select the area. 

 Zoom In 

Zooms into the drawing. The user can also scroll up using their mouse wheel to zoom in. (Page Up) 
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Zoom Out 

Zooms out of the drawing. The user can also scroll down using their mouse wheel to zoom out. (Page Down) 

  

17.4.2 HIGH TEMPERATURE WEDGE OPTIONS 
Options specific to the High Temperature Wedge dialog box are described below.  The HighTemp wedge display 
will update on the fly as the values are modified. 

  

Temperature Options 

Air - temperature control for the air surrounding the wedge 

Piece - temperature control for the piece 

Pallet Picker - provides a list of predefined pallets for visualizing temperature in the HighTemp Wedge display 

Normal Beam Path - selects the color used to display the Normal Beam Path in the HighTemp Wedge display 

Corrected Beam Path - selects the color used to display the Corrected Beam Path in the HighTemp Wedge display 

  

Reference Beam Options 

Element - specifies the number of the element used when rendering a single element at the angle specified. 

Angle - specifies the angle at which the beams are projected from the elements. 

  

Summary Section 

The summary section will displays relevant High Temperature calculations, based on the rendering selection from 
the toolbar.  This information includes the Incident Angle, Deflected Angle, Deflection, Exit Delta, Average 
Deflection and Average Exit Delta. 
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17.4.3 HIGH TEMPERATURE LESSON 
In this lesson we will demonstrate the High Temperature Add-on functionality in BeamTool.  In order to proceed 
with this lesson you must have purchased the HighTemp Add-on module.  Please refer to the Add-Ons section to 
learn how to purchase High Temp. 

  

Now that you have your HighTemp license activated let's put it to work. 

  

For this lesson we will start out with the default Plate Piece geometry and add a Phased Array Probe with a Linear 
Beamset (Using 12 Aperture Elements and 5 Beams). 
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Click on the  Probe Configuration icon in the PA Probe Group to launch the PA Probe Configuration dialog.  In 
the Wedge section of the PA Probe Configuration dialog, click on the arrow next to the  High Temp icon.  Select 

 Import HighTemp Wedge from the drop down menu. 

 
  



Add-on Modules 

 
233 

 

Select one of the High Temperature Wedges from the catalog and click on the  Import button.   
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For this lesson we have selected the WA10-HT55S-IH-G, and we are using a Transducer with 16 total 
elements.  Once you have selected the HighTemp Wedge to be imported, the High Temperature Wedge dialog box 
will open. 

 
Use the HighTemp Wedge Toolbar to render various beam paths. 
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Calculate Correction 

Calculates the beam path correction factors for all of the probes beamsets. 
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Single Element 

Render a single element at the angle specified. 
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Transducer Bonds 

Render beams at the first and last element and from the center of the array at the angle specified. 
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All Elements 

Render a beam for each element in the array at the angle specified. 
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Probe Beamsets 

Render a beam path for each of the probes beamsets. 

 

To visualize the corrected HighTemp Beam Path in your workspace, click on the  HighTemp icon in the PA 
Probe Configuration dialog box.  When turned on, the original beam path is greyed out, and the HighTemp beam 
path is shown in bold. 
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17.5 ZONAL CALBLOCK DESIGNER 

ZONAL CalBlock is an Add-on module that extends the capabilities of the already powerful BeamTool ray tracing 
and technique simulation application. 

  

The ZONAL CalBlock module will provide the users with an expanded toolset for generating calibration block and 
wedge design drawings and documents. 

  

If the user also owns the Zonal module, they will have the ability to produce a set of drawings automatically from 
their zonal configuration.  The BeamTool Calibration Block Designer is a tool that is intended to automatically 
generate precise calibration block drawings.  The generated drawings can be delivered to a machine shop for 
production. 

  

The ZONAL Calibration Block Designer utilizes the Advanced Weld Editor, which provides the ability for users to 
define “regions” and “zones” within a weld bevel. 

  

Weld regions and zones are constructed via customized algorithms, and are designed to provide optimized “full 
coverage” of a weld bevels’ fusion face and volume.  The Advanced Weld Editor is a powerful tool which is 
discussed and documented elsewhere. 

  

Taking advantage of optimized weld bevel zones, the Calibration Block Designer provides the ability for users to 
customize a calibration block that will include the necessary targets and notches to validate scanning procedures and 
techniques. 
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The ZONAL CalBlock Designer can be accessed by clicking on the Tools Menu and selecting Zonal Calibration 
Block Designer from the drop down menu. 
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17.5.1 ZONAL CALBLOCK DESIGNER TOOLBAR 
The ZONAL CalBlock Designer toolbar provides quick and easy access to some common management tools, 
various information tools and dialogs. 

 
  

Show 

This will toggle the display of the Zonal CalBlock targets on the CAD workspace. 

  

Import 

Loads a Cal Block Designer export file, and overwrites the current configuration. 

  

Export 

Loads a Cal Block Designer export file, and overwrites the current configuration. 

  

Auto 

When in Auto Generation mode, the targets are automatically regenerated whenever the piece, zones or cal block 
options are modified.  In this mode, targets are always kept in sync with their defining inputs.  Modifications to 
generated targets (through the target Table) are not permitted, as any updates would be lost during the next 
automatic generation. 

  

Manual 

When in Manual Generation mode, the targets are not regenerated when modifications are made to piece, zones or 
cal block options.  Instead, the targets can be manually regenerated by using the Generate button. Generated targets 
can be modified through Table mode, because regeneration will not occur automatically and will not overwrite any 
edits. 

  

Generate 

Manually generates the CalBlock targets from the Auto target options. 

  

Add Manual 

Opens the Add Manual Target dialog for adding custom targets. 

  

Clone Manual 

Clones the selected manual target. 

  

Remove Manual 

Removes the selected manual target. 
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Report 

Generate CalBlock Reports documenting the weld regions and targets.  Use the Calibration Info to populate 
additional properties. 

  

Report Details 

Zonal Calibration Block Report Details dialog opens a database of additional fields that can be populated by the user 
and included on reports. 

  

Add Drawingset 

Brings up the Drawing Properties dialog box where you can name and describe a drawing you want to add.  After 
the drawing properties have been defined, the selected drawing will be available from the Active Drawing drop-
down menu found on the Main Toolbar.  See Drawings for more information on working with Drawings. 

  

Copy Positions 

Copies the currently configured top positions to the selected Zonal Beamsets, setting the appropriate Rotary 
Positions 
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Table View 

Displays the targets in a Table View and activates the options for adding and deleting manual targets. 
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Display Side View 

Displays the drawing as a side view. 
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Display Top View 

Displays the drawing as a top view. 
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Display 3D View 

Displays the drawing as a 3D View. 

 

Zoom Fit 

Fits and centers the drawing in the current displayable drawing area (workspace). (Ctrl+F) 

Zoom Window 

Specify an area in the drawing to be zoomed into by holding down the left mouse button and dragging the mouse to 
select the area. 

Zoom In 

Zooms into the drawing. The user can also scroll up using their mouse wheel to zoom in. (Page Up) 

Zoom Out 

Zooms out of the drawing. The user can also scroll down using their mouse wheel to zoom out. (Page Down) 
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17.5.2 ZONAL CALBLOCK SIDEBAR MENU 
The Zonal CalBlock Sidebar Menu how the automatic targets are generated and various options for modifying these 
targets and other parameters related to the calibration block.  The menu is divided into nine sections. 

1. Dimensions 
2. Positioning 
3. Display 
4. Notches 
5. Fills 
6. Volumetrics 
7. TOFD 
8. Transverse 
9. Miscellaneous 

Below are the values that can be set within the ZONAL CalBlock Sidebar Menu.  To specify a value you can a) 
move the slider right or left, b) click the right or left value spinner or c) click on the value displayed in the value 
spinner and type a value.  The active view will update on the fly as the values are modified. 

Toggles the view of the targets in Side View and Top View. 

Toggles the view of targets dimensions in Side View and Top View. 

  

Dimensions 

 
Dimensions Parameters 

Thickness The piece thickness. 
Outside Diameter The piece outside diameter 
Total Width Adjusts the overall width of the calibration block. 
Overlap Width Adjusts the overlap width of the calibration block. 

Layout Defines how the block wings should be oriented. 

Automatic Lengths Toggles the automatic length option, which determines block length based on min/max 
rotary positions. 

US Wing Length If Auto Length displays US wing length, otherwise allows adjustments. 
US Center Length If Auto Length displays US center section length, otherwise allows adjustments. 
DS Center Length If Auto Length displays DS center section length, otherwise allows adjustments. 
DS Wing Length If Auto Length displays DS wing length, otherwise allows adjustments. 
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Positioning 

Options to help define circumferential position of targets. 

 
Positioning Parameters 

Position From Defines the reference point when rotary/top positions are added.  

Automatic Positioning Toggles on and off the Automatic Positioning option. 

US/DS Positions Symmetrical When positioning targets circumferentially this option will force symmetrical 
targets (i.e. V1 Up and V1 Down) to be the same distance from the center notch. 

Overlap Notches When positioning targets circumferentially this option will cause similar cap and 
root notches (i.e. CN 1.0 and RN 1.0) to be stacked vertically. 

Overlap Fills 
When positioning targets circumferentially this option will cause overlap fill 
targets that are no closer together than the specified threshold to be stacked 
vertically. 

Overlap Volumetrics 
When positioning targets circumferentially this option will cause volumetric 
targets that are no closer together than the specified threshold to be stacked 
vertically. 

Edge Represents the front and the back of the block 
Wing Represents the dividing line between the wings and center section 
WT Represents the wall thickness strip targets 
Trans Represents the transverse targets 
Center Represents the center notch target 
FBH Represents the flat bottom  hole targets 
Notch Represents the notch type targets 
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Display 

 
Display Parameters 

Show Weld 
Toggles the display of the weld in Side View, Top View and 3D View within 
Zonal CalBlock Designer. 

Show HAZ 
Toggles the display of the HAZ in Side View, Top View and 3D View within 
Zonal CalBlock Designer. 

US OD Toggles the display of upstream position dimensions on the outside diameter. 
US ID Toggles the display of upstream position dimensions on the inside diameter. 
DS OD Toggles the display of downstream position dimensions on the outside diameter. 
DS ID Toggles the display of downstream position dimensions on the inside diameter. 

Show Notch Edge Dimensions Adds additional dimensions for positioning points to the front and back edges of 
all notch targets 

Separate Upstream/Downstream Renders the US and DS center sections as separate components. 

Separate Wings Renders the wings of the block as separate components. 

Horizontal Top View Rotates the top view to be displayed with the weld centerline horizontally. 
Upstream Label Adds custom label to upstream section in Side View 
Downstream Label Adds custom label to downstream section in Side View 
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Notches 

A notch is a machined reference target used for calibration or performance demonstration.  Notch targets are defined 
by width, length and depth. 

 
Notch Parameters 

Notch Width The dimension along the x axis of the target. 

Notch Length The dimension along the z axis of the target. 

Notch Depth The dimension from the ID or OD to the deepest point of the target. 
  

Fills 

A fill is a machined flat-bottom hole reference target that is positioned along the fusion face at a perpendicular 
angle.  Fill targets are defined by width and angle. 
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Fill Parameters 

Fill Diameter The diameter of the target. 

Fill Angle The angle as measured from the center line. 

  

Volumetrics 

A flat bottom hole that is positioned along the weld center line.  Volumetric targets are defined by width, V1 Angle, 
V2 Angle and VX Angle. 

 
Volumetric Parameters 

Volumetric Diameter The diameter of the target. 

V1 Angle The angle from the center line for the first volumetric target. 

V2 Angle The angle from the center line for the second volumetric target. 
VX Angle The angle from the center line for any additional volumetric targets. 
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TOFD 

A notch target centered along the weld center line.  TOFD targets are defined by width, depth, length and V Angle.   

 
  

TOFD Parameters 

Width The dimension of the target on the x axis. 

Depth The dimension from the ID or OD to the deepest point of the target. 
Length The dimension of the target on the y axis.  

Notch Angle The angle of the apex at the bottom of the target. 

  

Transverse 

A notch target positioned perpendicular to the center line of the weld.  Transverse targets are defined by width, 
depth and length. 
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Transverse Parameters 

Transverse Width The dimension along the x axis of the target. 
Transverse Depth The distance from the ID or OD to the deepest point of the target. 
Transverse Length The dimension along the z axis of the target. 
  

Miscellaneous 

 
Miscellaneous Parameters 

Wall Thickness Strip Section attached to the end of each wing on the block.  The wall thickness strip is 
defined by depth and length. 

Wall Thickness Strip Depth The dimension from the OD to the bottom of the strip as measured from the center of 
the length. 

Wall Thickness Strip Length  The distance along the z axis 

Side Drilled Holes A hole that is drilled into the center section of the block, between the center section 
and a wing section.  Side drilled holes are defined by diameter, depth and length. 

Side Drilled Hole Diameter  Diameter of the side drilled hole. 

Side Drilled Hole Depth  The distance from the OD to the center of the hole opening 

Side Drilled Hole Length  
The distance along the z axis from the edge of the center section to the bottom of the 
hole. 
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17.5.3 ADD VIEW & EDIT MANUAL TARGETS IN TABLE VIEW 

Clicking on the   Table button from the ZONAL CalBlock Designer toolbar will display all of the default targets 
in a table view and allow the user to Add,Clone and Remove manual targets. 
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17.5.3.1 ADDING A MANUAL TARGET 

To add a manual target you must be in Table View.  Click on the  Table button from the ZONAL CalBlock Designer 
toolbar to switch to Table View.  Once in Table View, click on the   Add Manual button from the ZONAL CalBlock 
Designer toolbar to open the Add Manual Target dialog box. 

 

Enter the details for your manual target and click   OK to save your target to the Table View.  

  

17.5.3.2 VIEWING MANUAL TARGETS 

Manually entered targets and their configurable attributes will show up with a white background in the Table View.   

 
The default targets show up with a grey background and their attributes are not configurable from the Table 
View.  Default targets can be edited from the Zonal CalBlock Options Sidebar, and will update on the fly in the 
Table View. 
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17.5.3.3 EDITING MANUAL TARGETS 

A manual target can be edited once it has been added to the Table View.  A manual targets configurable attributes 
will display with a white background.  Simply click in the field of the attribute you want to edit and make your 
changes.  Press <Enter> when you are finished making your edits. 

  

17.5.3.4 DELETING MANUAL TARGETS 

To delete a manual target from the Table View, select the target in the Table View by clicking on it and click on the 
Remove Manual button from the ZONAL CalBlock Designer Toolbar. 

  

  



CHAPTER (18): THIRD-PARTY INTEGRATION 

Eclipse has partnered with other companies in the NDT industry to allow for easy integration of BeamTool 
workspaces into other acquisition and analysis software systems. 

  

18.1.1 TD FOCUS-SCAN & TD HANDY-SCAN 
As of January 2010 all  TD Focus-Scan and TD Handy-Scan systems are shipped with BeamTool pre-installed and 
older systems may be upgraded by TD to include this functionality. The integration brings together two of the most 
powerful and widely known computerized ultrasonic applications. It provides a comprehensive planning and data 
acquisition capability in a convenient package. 

18.1.2 ZETEC ULTRAVISION 
The BeamTool install includes a custom UltraVision library that can be used to integrate with Zetec 
UltraVision.  With this library installed and configured, the UltraVision file menu is extended with the option to 
"Import BeamTool Workspace".  This will automatically configure UltraVision with the probes, wedges, and beam 
sets you've configured in your BeamTool workspace. 
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18.2  ULTRAVISION LIBRARY 

The BeamTool install includes a custom UltraVision library that can be used to integrate with Zetec UltraVision. 

  

With this library installed and configured, the UltraVision file menu is extended with the option to "Import 
BeamTool Workspace".  This feature will automatically configure UltraVision with the probes, wedges, and beam 
sets you've configured in your BeamTool workspace. 

  

18.2.1 INSTALLATION 
The BeamTool installer will automatically install and configure the UltraVision library as long as UltraVision is 
already installed on the computer.  If installing UltraVision AFTER installing BeamTool, you will need to reinstall 
BeamTool to ensure the UltraVision library is configured properly 

  

18.2.2  IMPORT BEAMTOOL WORKSPACE INTO ULTRAVISION 
The Import BeamTool Workspace component for Zetec UltraVision allows you to quickly and easily set up a 
configuration in UltraVision based on an BeamTool configuration. Saved BeamTool workspaces can be imported 
into UltraVision saving time and reducing potential errors that might occur reconfiguring the setup in UltraVision. 
Pieces, wedges, transducers, and beamsets are all imported. Parameters for the UltraVision setup can be tweaked or 
you can transition directly to acquiring data. 

18.2.2.1 TERMINOLOGY 

BeamTool and UltraVision use similar terminology but there are a few important differences. The following terms 
map directly: 

  

BeamTool UltraVision 

Piece Specimen 

Beamset Channel 

Beam Focal Law 

18.2.2.2 WORKFLOW 

Importing a workspace involves only selecting the Import BeamTool Workspace “command” and then selecting a 
workspace file. The Import BeamTool Workspace component will be available from the UltraVision File menu and 
the Eclipse Scientific toolbar: 

 



Third-Party Integration 

 
260 

 

  

 
 When the Import BeamTool Workspace command is initiated, the following dialog is presented: 
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This Open File dialog allows you to select an BeamTool workspace for import. The folder is defaulted to the 
BeamTool workspaces folder. The default view presents the workspace files as thumbnails to make locating a file 
easier. After a workspace file is selected and the Open button is pressed, there is no further user interaction required. 
It will take a few moments to process the workspace file and calculate the focal laws. 
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18.2.2.3 CURRENT LIMITATIONS: 

The following areas of functionality are not yet supported with the current version. 

• Pitch-catch configurations 
• TOFD configurations 
• Conventional UT configurations 
• Custom pieces cannot be imported. An attempt is made to import the basic dimensions of the piece. 
• Only very simple weld profiles are supported. The basic size and shape of the weld can be imported but 

UltraVision does not support the complex weld profiles used by BeamTool. 

  



CHAPTER (19): LESSONS 

   

19.1 LESSON 1 GETTING STARTED 

  

In this demonstration we are going to be working with a Simple Plate.  When you select a new workspace this is the 
default setting. 

  

Open the Piece Configuration  to choose your material and the measurements of your plate. 

  

 

Open the Weld Configuration  to specify the data values to be used to generate the weld geometry.  
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Open the  Add Probe drop down menu to add a Phased Array Probe to the workspace. 

  

 

To change the default probe settings click on the  Probe Configuration icon from the Probe Group. 
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The Probe Configuration dialog box has many attributes that can be set for that type of probe.  To specify a value 
you can a) move the slider right or left, b) click the right or left value spinner or c) click on the value displayed in 
the value spinner and type a value. The preview and drawing panes will update on the fly as the values are modified. 

We will change the default transducer by clicking on the  Import Transducer icon from the Probe Configuration 
dialog box. 
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Limit the list of available transducers in the catalog by selecting criteria on the left, and a limiting factor on the right 
in the Import Transducer dialog box. 

  

 
  

You can also change the default wedge by clicking on the  Import Wedge icon from the Probe Configuration 
dialog box. 

  

Now that we have our probe configured, we will add a beamset by clicking on the  Add Beamset icon from the 
Probe Group. 
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For this demonstration we will select a Sectorial Beamset. 
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The Beamset Configuration dialog box will open when a Beamset is selected.  It can be used to specify the data 
values to be used.  To specify a value you can a) move the slider right or left, b) click the right or left value spinner 
or c) click on the value displayed in the value spinner and type a value. The preview and drawing panes will update 
on the fly as the values are modified. 
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For this demonstration we are going to change the number of skips to from 1 to 2, by clicking on the  Number of 
Beam Skips icon and selecting 3 from the pick list. 

 
For this demonstration we will change the display of our beamset from Solid Beams to Color List.  This will 
represent each skip as a different colour.  The color palette can be customized in the BeamTool Options. 

Solid Beams 
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Color List 

 

We can change the default side view to top view by clicking on the  Display Top View icon found in the Main 
Toolbar.  Change back to side view by clicking on the  Display Side View icon. 

Top View 

 

We can produce a report based on our current workspace by clicking on the  Report icon in theMain Toolbar. 
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Sample Report 
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19.2 LESSON 2 IMAGES 

In this demonstration we will import and scale a bitmap, and show how to work with layers. 

  

We will start with a new workspace.  Change the default  Plate workspace to  Custom by clicking on the 
Piece Geometry pick list found in the Piece Group. 

 

With our workspace changed to custom its time to import the bitmap.  Click on the  Add Geometry icon found in 
the Edit Tools section of the CAD Toolbar Select Image from the Add Geometry Group dialog box.  
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The Select Image browser will open and allow you to select the image that you would like to import.  Highlight the 
image and click on Open. 

 
  

Click and drag your cursor over the workspace to place the image.  The aspect ratio of the image is not 
maintained.  To scale the image to its proper dimensions, we will use a rectangle for reference.  

Click on the   Add Geometry icon found in the Edit Tools section of the CAD Toolbar. Select Rectangle from the 
Add Geometry Group dialog box. 
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Click and drag your cursor over the workspace to draw the rectangle.  With the rectangle selected we will use the 
Construction Aids found in the CAD Toolbar to enter the exact dimensions of Cal Block that we are working with. 

 
  

Before we overlay the bitmap onto the part we will separate them into different layers to help organize the 
workspace.  

  

With the rectangle selected we will click on the  Layers icon found in the Tools section of the CAD Toolbar.  
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From the Layers dialog box we will select   Move Geometries to add the selected rectangle to Layer 1.  Double 
click on Layer 1 to give it a meaningful name and press enter. 

  

We will add a second layer by clicking on the   Add Layer icon in the Layers dialog box.  Name the layer 
accordingly.  Go back to the workspace and select your bitmap.  Return to the Layers  dialog box and highlight the 
second layer you created.  Select the  Move Geometries icon to assign the bitmap to the second layer. 

  

 

With our layers in place we can now toggle the view of the bitmap and piece by clicking on the /  Visibility 
icons, and lock each layer from editing by clicking on the  /  Locking icons. 

  

Now we will drag the bitmap over the piece and stretch it to scale.  Once we have the bitmap where we want it, we 
will lock it in place to keep it from accidently being moved.  Click on the  Display Settings icon found in the 
Tools section of the CAD Toolbar.  Select the  Lock Images icon from the Display Settings dialog box. 

  

We are ready to trace the outline of the calibration block.  To do this we will open the   Add Geometry and select 
 Polyline from the Piece Geometry section.  When we reach the area where the bitmap curves we will press ESC 

to stop the Polyline. 

 
  

Click on the  Snap Settings icon found in the Tools section of the CAD Toolbar.  Click on the   Snap to 
Nearest icon to avoid gaps while tracing.  

  

Click on the  Draw Piece Arc icon to trace the arc.  This is found in the Add Geometry section of the CAD 
Toolbar. 
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With all the outside edges of the bitmap in place we will select the rectangle and right click on it.  Select Convert 
Selected to Lines from the dialog box.  This will allow us to manipulate each line of the rectangle. 

 
We will delete the right hand side of the rectangle and drag the bottom line to match the outline of our bitmap.  If we 
turn off the view of the bitmap layer we now have the outline of our piece. 
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Now we will trace in the internal targets from the bitmap onto our piece.  We will use the  Draw Piece Circle tool 
found in the Add Geometry section of the CAD Toolbar to trace our targets. 

  

 
  

 Now we will trace the 50mm radius using the  Draw Piece Arc and the  Draw Piece Line. These can found in 
the Add Geometry section of the CAD Toolbar. 
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 With our bitmap fully traced we will add a probe and beamset to see how it looks.  (See Lesson 1 Getting Started) 
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If we don't want the beamset to interact with the 50mm radius we can right click on each of the lines we used to 
create it and turn Reflective off by removing the check mark. 
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You can flip the probe horizontally on the piece by clicking on the  Flip Probe icon from the Probe Group. 

 
Turn the bitmap layer back on to see how the probe and beamset interact. 
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19.3 LESSON 3 DEACTIVATE AND TRANSFER LICENSE 

  

In this lesson, we will go through the steps involved to deactivate and transfer a license.  BeamTool makes it very 
easy to transfer your SoftLock license from one computer to another.  

  

The first step is to deactivate the license on the computer you no longer want to use with BeamTool. 

  

Click on the Help Menu and select Deactivate License... from the drop down menu. 

  

 
The Software Deactivation dialog box will bring up your serial number for BeamTool.  If you do not have this 
number in your records, you have the option to Copy Serial Number to clipboard for future reference.   

  

Click on Deactivate to finish the process.  
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You should get the dialog box below upon successful deactivation.  

 
You are now ready to install your licensed version of BeamTool on another computer. 
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19.4  LESSON 4 ZONAL ADD-ON 

  

In this lesson we will demonstrate the ZONAL functionality in BeamTool.  In order to proceed with this lesson you 
must have purchased the ZONAL Add-on module  Please refer to the Add-Ons section to learn how to purchase 
ZONAL. 

  

Now that you have your ZONAL license activated lets put it to work. 

  

Configure your piece to match your requirements (see Lesson 1).  

Click on the  Weld Configuration icon from the Piece Group.  Once your weld is configured click on the 
 Show Zones icon.  These Weld Zones are created following the zone parameters and are based on the defined 

maximum length of the zone base along the fusion line.  By default zones are created at the top of the upper fill and 
at the bottom of the root.  The rest of these regions are divided into zones based on the parameters  entered for your 
weld.  

 

 
There is an option to overlap the default zones.  They will still remain but they will not be considered when dividing 
the regions into zones as per the defined parameters of your weld. 
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With your piece and weld configured add a Phased Array Probe and select Zonal Beamset Configuration from the 

 Add a Beamset drop down menu.  The Zonal Beamset Configuration dialog box will open. 

 

Click on the  Solve icon to automatically add and configure beams for each zone in the weld bevel. 
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If you receive the message below, the Zonal Solver could not solve according to the rules for that zone.  The beams 
may have to be manually added or modified. 

 
After the Zonal Solver is finished you will have a list of beams displayed in the Zonal Beamset Configuration dialog 
box.  With the Zonal Beamset Configuration dialog box open, each beam in the workspace is grayed out except for 
the one highlighted in the Zonal Beamset Configuration dialog box. 

 
When the Zonal Beamset Configuration dialog box is closed, all of the beams become visible in the workspace. 
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19.5 LESSON 5 ADVANCED 3D WORKSPACES 

In this demonstration an IIW Type 2 Block will be used to see how workspaces can be created for 3D View. 

  

Import an image that can be traced (See Lesson 2 or watch the Bitmap Tracing video on the web) 

 
For this example, the block will be traced twice, once for the first 0-12.7mm that includes the 50mm radius, and 
again for 12.7mm-25.4 including the 100mm radius 

http://www.eclipsescientific.com/Software/BeamTool/video.html
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Use the Layers feature to separate the different components of the drawing 

 
Click on the Tools menu, open the Geometry Inspector 
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Select the 50mm radius outline, and in the Geometry Inspector set ExtrudeZ to 0  (this is the starting point of the 
geometry in the Z axis) , and ExtrudeDepth to 12.7  (This is the depth the Geometry is Extruded) 

 
Select the outline with the 100mm radius, and In the Geometry Inspector Set ExtrudeZ to 12.7 and ExtrudeDepth to 
12.7 
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Add the Side Drilled Holes and Lucite Insert into the drawing.  Set their ExtrudeZ to 0 and the ExtrudeDepth to 25.4 

 
When we change to 3D View, the different Z starting points and extrusion depths can be seen. 
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19.6   LESSON 6 HIGH TEMP ADD-ON 

  

In this lesson we will demonstrate the High Temperature Add-on functionality in BeamTool.  In order to proceed 
with this lesson you must have purchased the HighTemp Add-on module  Please refer to the Add-Ons section to 
learn how to purchase High Temp. 

  

Now that you have your HighTemp license activated let's put it to work. 

  

For this lesson we will start out with the default Plate Piece geometry and add a Phased Array Probe with a Linear 
Beamset (Using 12 Aperture Elements and 5 Beams). 
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Click on the  Probe Configuration icon in the PA Probe Group to launch the PA Probe Configuration dialog.  In 
the Wedge section of the PA Probe Configuration dialog, click on the arrow next to the  High Temp icon.  Select 

 Import HighTemp Wedge from the drop down menu. 
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Select one of the High Temperature Wedges from the catalog and click on the  Import button.   
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For this lesson we have selected the WA10-HT55S-IH-G, and we are using a Transducer with 16 total 
elements.  Once you have selected the HighTemp Wedge to be imported, the High Temperature Wedge dialog box 
will open. 

 
  

Use the HighTemp Wedge Toolbar and options to render various beam paths. 
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19.6.1.1 CALCULATE CORRECTION 

Calculates the beam path correction factors for all of the probes beamsets. 
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19.6.1.2 SINGLE ELEMENT 

Render a single element at the angle specified. 
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19.6.1.3 TRANSDUCER BONDS 

Render beams at the first and last element and from the center of the array at the angle specified. 
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19.6.1.4 ALL ELEMENTS 

Render a beam for each element in the array at the angle specified. 
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19.6.1.5 PROBE BEAMSETS 

Render a beam path for each of the probes beamsets. 

 

To visualize the corrected HighTemp Beam Path in your workspace, click on the  HighTemp icon in the PA 
Probe Configuration dialog box.  When turned on, the original beam path is greyed out, and the HighTemp beam 
path is shown in bold. 
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19.7 LESSON 7 A-SCAN ADD-ON 

In this lesson we will demonstrate the A-Scan Add-on functionality in BeamTool.  In order to proceed with this 
lesson you must have purchased the A-Scan Add-on module  Please refer to the Add-Ons section to learn how to 
purchase A-Scan. 

  

Now that you have your A-Scan license activated let's put it to work. 

  

For this lesson we will start out with the default Plate Piece geometry.  Use the Piece Polyline drawing tool to 
add some defects in the weld. 
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Add a Conventional UT Probe to the workspace. 
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Open the UT Probe Configuration menu by clicking on the Probe Config icon found in the UT Probe 
menu.  Turn off the Show Beam Spread by clicking on the  Show Beam Spread icon.  Detecting reflections 
requires that the probe/beamset is configured with enough beam skips to allow the beams to return to the 
transducer.  Change the number of beam skips to 4 by clicking on the   Beam Skips icon. 
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Click on the  A-Scan icon to open the A-Scan dialog box.   

Use the slider control at the 
bottom of the A-Scan chart to find and view the area of the timeline where the signal  occurs.  The handles on the 
ends of the control  can be dragged back and forth to zoom in and out. The bar itself can be dragged back and 
forth  to scroll through the time line. 

  

 

 
Use the display mode to visualize different scan data that is displayed in the chart.  Changing the Display mode will 
automatically update the A-scan view and the Beamset. 
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19.8 TRAINING VIDEOS 

Please follow the links below for BeamTool training videos. 

Getting Started Video 

This video illustrates the creation of a very simple phased array technique. The 
technique ensures complete coverage of the weld by using two phased array sectorial 
beamsets to inspect the top and bottom of the weld. 

Bitmap Tracing 

This video shows how to import a bitmap image and use it to trace a complex piece 
geometry. 

ZONAL Add-on 

This video demonstrates how to use the BeamTool ZONAL Add-on. The BeamTool 
ZONAL Add-on provides the ability to define weld zones, which are used in 
conjunction with a Zonal Beamset to provide automated targeting of individual 
phased array beams into specific locations along the face of a weld bevel. 

Editing Report Templates This video demonstrates how to edit report templates in BeamTool. 
  

http://www.eclipsescientific.com/Software/ESBeamTool/video.html
http://www.eclipsescientific.com/Software/ESBeamTool/video.html
http://www.eclipsescientific.com/Software/ESBeamTool/video.html
http://www.eclipsescientific.com/Software/ESBeamTool/video.html
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CHAPTER (20): SUPPORT 

Eclipse Scientific values your business and your feedback is very important to us.  If you are experiencing problems 
please use the Check For Update option under the Help menu to ensure you have the most recent version of the 
software. 

If you are still experiencing problems we can be reached: 

  

On the Web 

Select Support from the Help menu in BeamTool to submit an inquiry directly from our website. 

  

Email 

Email us at support@eclipsescientific.com and provide us with the following information: 

• Full Name 
• Company 
• Serial Number or HardLock ID (displayed in About screen) 
• Version of BeamTool 
• Description of Problem or Question 

  

Phone 

Contact Eclipse Scientific BeamTool Support directly:  Phone (519) 372-1831 or Fax (519) 372-2039 

 

http://www.eclipsescientific.com/Software/softwaresupport.asp
mailto:support@eclipsescientific.com?subject=BeamTool
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